What’s New

Overview

The SAS Intelligence Platform: Application Server Administration Guide explains how to administer a SAS Application Server. This document contains new material about the following enhancements and changes to the SAS Intelligence Platform:

- server-based pooling mechanism
- change to OBJECTSERVERPARMS system option
- new configuration tools
- security enhancements
- load-balancing changes
- grid algorithm for load balancing
- new SAS logging facility
- automated SAS server tier configuration
- port changes
- documentation enhancements to the SAS Intelligence Platform: Application Server Administration Guide

Server-based Pooling Mechanism

The SAS Pooled Workspace Server is a new SAS server type that exploits server-based pooling.

Change to OBJECTSERVERPARMS System Option

You no longer need to specify the OBJECTSERVERPARMS option, METAUTOINIT, because it is on by default in SAS 9.2. (You can turn this option off by using the NOMETAUTOINIT option.)
New Configuration Tools

These are the new SAS configuration tools:
- SAS Deployment Wizard that is used to add new software and configurations
- SAS Deployment Manager that is used to remove configurations

Security Enhancements

SAS contains these security changes:
- server access security in which (primarily) the object spawner and the stored process server use metadata to verify that a user has permission to use a particular server
- Integrated Windows Authentication (IWA) for single sign-on functionality for Windows desktop users
- fewer operating system accounts are required to run SAS 9.2
- internal accounts that SAS uses by default for some of the required user accounts (such as sastrust and sasadm)

Load-Balancing Changes

SAS contains these changes to server load balancing:
- The stored process server and new pooled workspace server have load balancing enabled by default.
- The object spawner uses its operator connection for load balancing out-of-the-box. Administrators no longer have to create a separate load-balancing connection.

Grid Algorithm for Load Balancing

SAS has a new load-balancing algorithm that supports Workspace servers running in a grid.

New SAS Logging Facility

SAS has a new logging facility controlled by the LOGCONFIGLOC system option that replaces the functionality of LOG and LOGPARM. (These traditional SAS log options still work, but SAS does not configure these by default anymore.) For more information, see “The SAS Logging Facility” in *SAS Logging: Configuration and Programming Reference*.

Automated SAS Server Tier Configuration

SAS has eliminated most post-install manual configuration scripts for the SAS server tier initial configuration through its new deployment tool, the SAS Deployment Wizard.
Port Changes

The following SAS default ports have changed:

- The object spawner’s managed ports can now share the same port.
- The new SAS Pooled Workspace Server uses port 8701.
- The new SAS Object Spawner port banks use ports 8801, 8811, and 8821.
- The object spawner load balancing port, 8571, is no longer used.

Documentation Enhancements

The SAS Intelligence Platform: Application Server Administration Guide has been reorganized to reflect the new SAS features.
PART 1

Getting Started

Chapter 1 . . . . . . . Before You Begin  3

Chapter 2 . . . . . . . Understanding the SAS Application Server  5
Introduction to This Guide

This guide covers the administration of the SAS Application Server, which is a logical entity that represents the SAS server tier in the SAS Intelligence Platform. This application server contains a set of actual servers. For example, a SAS Application Server usually contains the following servers:

- **Workspace Server**: Enables client applications to submit SAS code to a SAS session by using an application programming interface (API). For example, when you use SAS Data Integration Studio to submit an extract, transform, and load (ETL) job for processing, the application generates the SAS code necessary to perform the processing and submits it to a workspace server. You can run as many instances of workspace servers as are needed to support your workload.

- **Pooled Workspace Server**: Enables client applications to submit SAS code to a SAS session by using an application programming interface (API). Pooled workspace servers are workspace servers in every respect except that these servers automatically use pooling and load balancing.

- **Stored Process Server**: Interacts with SAS by submitting stored processes, which are SAS programs that are stored and can be executed by client applications. You can use stored processes to perform complex tasks such as analyzing data and creating reports, and then return the results to the client or publish the results to a channel or repository.

- **OLAP server**: Delivers pre-summarized, multidimensional data (cubes) to business intelligence applications. The data is queried using the multidimensional expressions language (MDX).

In addition, a SAS Application Server might contain one or more of the following servers:

- **SAS/CONNECT Server**: Enables clients to execute code on a remote host, or to move data between client and server machines.

- **SAS batch server**: Stores information in metadata about how to execute a SAS command in batch mode. A batch server is a required if you are using the SAS scheduling system. There are three batch servers:
  - DATA Step Batch Server
Chapter 1

Java Batch Server
Generic Batch Server

SAS Grid Server enables Platform LSF to start SAS/CONNECT servers on a SAS compute grid in order to execute grid-enabled SAS programs or grid-enabled jobs that are created in SAS Data Integration Studio and SAS Enterprise Miner.

This guide explains how to administer all of these server components and the SAS Application Server as a whole.


This guide assumes that you are familiar with the concepts and terminology that are introduced in the SAS Intelligence Platform: Overview document. For a list of all of the documents that SAS publishes to support administration of the SAS Intelligence Platform, see http://support.sas.com/92administration.

Accessibility Features in the SAS Intelligence Platform Products

For information about accessibility for any of the products mentioned in this book, see the documentation for that product. If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.
Overview of SAS Application Servers

What are SAS Application Servers?

When the SAS Intelligence Platform was installed at your site, a metadata object that represents the SAS server tier in your environment was defined. In the SAS Management Console interface, this type of object is called a SAS Application Server. By default, the application server object is named SASApp.

Note: In SAS deployments before SAS 9.2, the default SAS application server is named SASMain.

You can view the properties of this object by using the Server Manager plug-in to SAS Management Console. Expand the Server Manager tree node. Then right-click the SASApp node, and select Properties from the pop-up menu. You can also see the server components that make up the application server by completely expanding the SASApp node in the Server Manager tree.

In addition to this metadata object, a SASApp directory was created on each machine that hosts a SAS server (under the SAS configuration directory). This directory contains important files that you will use in the management of your SAS Application Server. In particular, it contains a file called sasv9.cfg, a configuration file that is used in the start-up of most SAS servers.

A Collection of Server Components

A SAS Application Server is not an actual server that can execute SAS code submitted by clients. Rather, it is a logical container for a set of application server components, which do execute code. Typically, these components execute SAS code,
A Server Context

A SAS Application Server knows its server context (the context in which it is being used) and makes decisions based on that knowledge. For example, a client such as SAS Data Integration Studio is assigned a default SAS Application Server, and when the client generates code, it submits the code to that application server. The application server determines what type of code is being submitted and directs it to the correct server. That is, if the code is typical SAS code that could be run in the SAS Display Manager, the code is executed by the application server’s workspace server.

In addition, data-related objects such as SAS libraries, database libraries, and OLAP schemas can be assigned to a SAS application server. Once this assignment is made, if a client needs to access data in a particular library or OLAP schema, it uses a server component belonging to the application server to which the library or schema has been assigned.

The Structure of a SAS Application Server

The SAS Application Server’s Server Components

As mentioned in “A Collection of Server Components” on page 5, a SAS Application Server is a logical entity that encompasses a set of actual servers. Several types of servers might belong to a SAS Application Server, as shown in the following list:

- **SAS Workspace and SAS Pooled Workspace Servers** - These servers are provided with SAS Integration Technologies and are accessed through the Integrated Object Model (IOM) workspace interface. This interface provides access to Foundation SAS features such as the SAS language, SAS libraries, the server file system, results content, and formatting services. A SAS workspace represents a session with the SAS system and is functionally equivalent to the execution of the SAS System as a batch job. A pooled workspace server is a workspace server in every respect except that it automatically uses mechanisms—server-side pooling and load-balancing—to improve performance on larger SAS deployments. (For standard workspace servers, you must set up load balancing or client-side pooling manually.)

- **Stored Process Server** - The Stored Process Server is also part of SAS Integration Technologies. It retrieves SAS Stored Processes from a repository and executes them.

A stored process is a SAS program that is stored on a server and can be executed as required by requesting applications. You can use stored processes for...
Web reporting, analytics, building Web applications, delivering packages to clients or to the middle tier, and publishing results to channels or repositories. Stored processes can also access any SAS data source or external file and create new data sets, files, or other data targets that are supported by SAS.

- SAS OLAP Server - Similar to the way in which a database management system (DBMS) can read an SQL query and return data from a database, the SAS OLAP Server processes MDX queries and returns data from OLAP cubes.

  An OLAP server has a close relationship with a workspace server, and the two generally run on the same machine. The workspace server is used to build OLAP cubes, and the OLAP server is used to query the cubes.

- SAS/CONNECT Server - The SAS/CONNECT server has several general capabilities:
  - SAS/CONNECT provides compute services. A SAS/CONNECT client running on one machine can submit code to one or more remote SAS/CONNECT servers, which execute the code.
  - SAS/CONNECT provides Remote Library Services (RLS). These services enable SAS code to read, write, and update remote data as if it were resident on the client host. RLS can be used to access SAS data sets across machines that have different architectures.
  - SAS/CONNECT provides a set of Data Transfer Services (DTS). A SAS/CONNECT client can download data from a remote host where a SAS/CONNECT server is running, or the client can upload data to the server host. The client and server host do not need to be running the same operating system.

In addition, the SAS/CONNECT server has an important role in several features that are unique to the SAS Intelligence Platform:

- SAS/CONNECT servers run on all of the nodes in the compute grid. Together, the servers execute SAS Data Integration Studio and SAS Enterprise Miner jobs that use parallel algorithms.
- SAS Data Integration Studio can also use a SAS/CONNECT server for regular jobs. The application can generate code that uses the SAS/CONNECT server to upload data to a remote machine, download data from a remote machine, or execute the code for one or more transformations.
- A SAS/CONNECT server is also required in order to use the SAS Promotion Wizard and the SAS Replication Wizard to promote or replicate metadata.
- batch servers - A batch server is actually a metadata object that stores a SAS command that is run in batch mode to execute SAS or Java code. The batch server contains an association between the stored command and the host on which it runs and possibly a log file. These SAS commands are actually scheduled jobs that are created with programs such as SAS Data Integration Studio and SAS Web Report Studio.

  Different types of batch servers are available for different types of code: a SAS DATA Step Batch Server, a SAS Java Batch Server, and a SAS Generic Batch Server. For more information about these subtypes of the batch server, see Chapter 5, “Understanding the Batch Servers,” on page 23.
- SAS Grid Server - The SAS Grid Server is similar to the batch server in that it stores a command. In this case, the server stores the command that Platform LSF will use to start SAS/CONNECT sessions on the nodes in the grid. For more information about the architecture of a system that supports grid computing, see Grid Computing in SAS.
The SASMeta Application Server

The SAS Deployment Wizard creates a second SAS application server called SASMeta by default. The SASMeta application server is used for certain metadata functions such as replication, backup, and restore that depend on a SAS Workspace Server and (for some functions) a SAS/CONNECT Server. For more information about these metadata utilities, see “About the Metadata Server Backup and Restore Utilities” and “Using the Replication Wizard to Copy an Entire Metadata Repository” in the SAS Intelligence Platform: System Administration Guide.

In addition, the SASMeta server context also contains the SAS Metadata Server, although the metadata server is technically not an application server component.

The Hierarchy of Metadata Objects Used to Define a SAS Application Server

When your system was first installed, an application server was created when the first server—perhaps a workspace server—was defined. Defining the application server involved creating three objects:

- an application server
- a logical server (for example, a logical workspace server)
- a server (for example, a workspace server)

The Server Manager plug-in to SAS Management Console has a tree structure similar to the one shown in the following display:

![Tree Structure](image)

The SASApp tree node represents the SAS Application Server. You assign resources such as libraries and OLAP schemas to this object. The result is that when an application such as SAS Web Report Studio needs to access a particular resource, it will use a server, such as a workspace server, that belongs to this application server.

The object named **SASApp - Logical Workspace Server** is a logical server. An application server such as SASApp can contain at most one logical server for each type of server that is listed in the section “The SAS Application Server's Server Components” on page 6. Generally, each logical server can contain one or more servers of the appropriate type. However logical Grid Servers can contain only a single server.

The logical server level in the hierarchy enables you not only to group related servers together, but to control the behavior of the set of servers that belongs to the logical server. For example, if you have two workspace servers in a logical workspace server, you use the logical workspace server to indicate that you want to balance the workload that goes to these two servers. A logical server also gives you a place at which to use metadata access controls to secure all servers of a particular type in the same way.

The object named **SASApp - Workspace Server** represents the server that executes SAS code. In the case of a workspace server, this object contains information about the machine that the server runs on, the command that is used to start it, and the port on which it listens for requests.
PART 2

Server Concepts

Chapter 3 . . . . . . . Understanding Workspace Servers and Stored Process Servers  11

Chapter 4 . . . . . . . Understanding SAS/CONNECT Servers  15

Chapter 5 . . . . . . . Understanding the Batch Servers  23

Chapter 6 . . . . . . . Understanding SAS Grid Servers  27
Overview of Workspace Servers and Stored Process Servers

What are Stored Process Servers and the Workspace Servers?

Stored process servers and the workspace servers are crucial elements of the SAS Intelligence Platform that enable clients to perform SAS processing and to access Foundation SAS resources.

SAS Stored Process Servers

SAS Stored Process Servers interact with SAS by submitting stored processes, which are SAS programs that are stored and can be submitted by SAS client applications. You can use stored processes to perform complex tasks such as analyzing data and creating reports, and then returning the results to the client or publishing the results to a channel or repository.

Each stored process server process handles multiple users, and by default each server uses multiple server processes or instances. A load-balancing algorithm distributes client requests between the server processes. For more information about load balancing, see “Overview of Load Balancing” on page 34.

If the job load for your stored process server is high, you might want to add additional server processes to your server definition. Each server process is defined as a MultiBridge connection in SAS Management Console.

SAS Workspace Servers

SAS Workspace Servers interact with SAS by creating a server process for each client connection. The workspace server process is owned by the client user who made the
server request. Each workspace server process enables client programs to access SAS libraries, perform tasks by using the SAS language, and retrieve the results.

In the default configuration, SAS presents you with a workspace server that is not pooled (standard workspace server) and a workspace server that is pooled (pooled workspace server).

For the standard, non-pooled workspace server, SAS creates a new server process each time that a client requests a connection. For simple configurations and for sites that do not place heavy loads on a workspace server, a non-pooled server might be adequate. In situations where the demands on the workspace server are greater, you should (depending on the SAS application that you are using) consider configuring the workspace server for either pooling (Web applications) or load balancing (desktop applications).

In a pooling configuration, a set of server processes are reused to avoid the processing time that is associated with starting a new process for each connection. SAS offers two types of pooling: client-based and server-based. A pooling configuration can also be shared across multiple machines. Pooling is recommended if your server supports SAS Web Report Studio and other Web applications. For more information, see “Overview of Pooling” on page 53.

In a load-balancing configuration, your workspace server processes are distributed between multiple machines. Load balancing is recommended if your server supports applications that submit large jobs, such as SAS Data Integration Studio. For more information, see “Overview of Load Balancing” on page 34.

**SAS Pooled Workspace Servers**

SAS Pooled Workspace Servers are workspace servers in every respect except that these servers automatically use pooling and load balancing. Like a standard workspace server, each pooled workspace server enables client programs to access SAS libraries, perform tasks by using the SAS language, and retrieve the results. For more information, see “How Server-side Pooling Works” on page 53.

**The Default Stored Process Server and the Workspace Servers**

When the installer at your site runs the SAS Deployment Wizard, that person defines metadata for a SAS application server.
Understanding Workspace Servers and Stored Process Servers

Usually, your application server contains a stored process server, a workspace server, and a pooled workspace server.

The initial stored process server is configured as a load-balancing server named by default SASApp - Stored Process Server. By default, the stored process server definition includes three MultiBridge connections.

The initial workspace server is configured as a standard workspace server named SASApp - Workspace Server.

The initial pooled workspace server is configured as a load-balanced, server-based pooled workspace server named by default SASApp - Pooled Workspace Server.

SAS Object Spawners

Overview of SAS Object Spawners

Workspace servers and stored process servers are initialized by the SAS Object Spawner. An object spawner runs on each machine where you want to run a workspace server or stored process server, listens for requests, and launches the servers as necessary.

The object spawner uses a configuration file that contains information for accessing the metadata server. When you invoke the spawner, the spawner works as shown in the following figure.

Figure 3.1  How the Spawner Obtains Metadata

1. The object spawner accesses a configuration file that contains information for accessing the SAS Metadata Server.
2. The object spawner connects to the SAS Metadata Server for configuration information.
   (The spawner uses a proprietary SAS bridge protocol to communicate with the metadata server, and uses TCP for communication.)

The spawner can then listen for requests for various spawner tasks. See “Spawner Tasks” on page 14.

Configuration File for Metadata Connection

A metadata configuration file contains information for accessing a metadata server. The spawner uses the information that is contained in the configuration file to connect to a metadata server and read the appropriate server definitions.
The default metadata configuration file is `metadataConfig.xml`. This file is located in the ObjectSpawner subdirectory of your SAS configuration directory.

**Spawner Tasks**

When a request is received, the spawner accepts the connection and performs the action that is associated with the port or service on which the connection was made. A connection to a spawner can do the following:

- **request a server**
  
  When a connection is made on a port or service that is associated with a Server object, the spawner authenticates the client connection against either the metadata server (default for stored process and pooled workspace servers) or the host authentication provider for the server’s machine (default for the standard workspace server). The spawner then launches a server for use by the connecting client.

  When you define a server in SAS Management Console, you must specify a command that the spawner uses to start the server. When the object spawner starts, it reads all server definitions for which it is associated. Therefore, if you change or add a server startup command, you must refresh (or restart) the object spawner for any modified commands to be used to launch a server. For details about the server command, see “Add System Options to the Workspace Server Launch Command” on page 97. For SAS Stored Process Servers and SAS Pooled Workspace Servers, on the server definition, you must also configure credentials for the spawner to use to start a multi-user server. Every connection to the server is authenticated. Here are the authentication methods used for each type of spawned server:

  - **standard workspace servers**
    
    These servers start under the client user’s credentials when set up for host authentication. (This is the default.) If metadata authentication is used (SAS Token Authentication), then standard workspace servers run under a configured user ID, referred to as launch credentials.

  - **stored process servers and pooled workspace servers**
    
    These servers start under a configured user ID, referred to as launch credentials. Typically, this user ID is the SAS Spawned Servers user (sassrv, by default).

- **initiate the operator interface**
  
  When a connection is made on the port or service that is identified as the operator port or operator service in the spawner definition, the spawner initiates the administration interface. Only one administrator can be active at a given time.

- **balance the server workload between server processes by using load balancing**
  
  See “Overview of Load Balancing” on page 34.
Overview of SAS/CONNECT and the SAS Intelligence Platform

SAS/CONNECT software provides the essential tools for sharing data and processing power across multiple computing environments. SAS code uses these tools to perform tasks such as the following:

- dividing time-consuming tasks into multiple units of work and executing these units in parallel
- moving data from a client machine to a server machine, or vice versa, so that the data is on the same machine as the code processing it

Any code that your company writes for use with the SAS Intelligence Platform, such as stored processes, can use these SAS/CONNECT features. For more information about the general capabilities of SAS/CONNECT, see “Introduction to SAS/CONNECT” on page 16 or the SAS/CONNECT User’s Guide.

In addition, SAS/CONNECT plays some special roles in the SAS Intelligence Platform. For example, in a properly configured environment, some of the platform clients, such as SAS Data Integration Studio and SAS Enterprise Miner, can generate code that includes SAS/CONNECT statements. These statements enable the generated code to perform tasks such as those mentioned in the previous paragraph.

SAS/CONNECT also plays an important role in the replication of metadata repositories because the replication is accomplished by uploading data sets from a client machine to a server machine. For more information about these special roles, see “Overview of the Uses of SAS/CONNECT in the SAS Intelligence Platform” on page 17.
If your environment contains SAS/CONNECT, the SAS Deployment Wizard might have configured the product when your system was installed. If this configuration did take place, it is important for you to know what metadata objects and files were created during installation so that you can manage your environment effectively. For more information about how the wizard configures SAS/CONNECT, see “Initial Configuration of the SAS/CONNECT Server” on page 19.

Introduction to SAS/CONNECT

Overview of Services

SAS/CONNECT provides applications with three types of services:

- **Compute Services.** Use the Compute Services to synchronously or asynchronously direct the execution of SAS programs to one or more server sessions.

- **Data Transfer Servers.** Use the Data Transfer Services to move a copy of your data from one machine to another in order to translate data between machine architectures and SAS versions, as necessary.

- **Remote Library Services.** Use the Remote Library Services to transparently access SAS data that resides in server libraries on machines across the network.

The following sections describe these services briefly. For detailed information, see “SAS/CONNECT: Definitions and Services” in the *SAS/CONNECT User’s Guide*.

Compute Services

The compute services of SAS/CONNECT enable the use of multiple local processors and remote computing resources—including hardware, software, and data—to most efficiently execute an application.

You can move any or all portions of an application’s processing to other processors (either local or remote) in order to use hardware resources, use software in remote environments, interface with legacy systems, and execute code against a remote copy of the data. The results of the remote processing can be returned to the local machine. This is useful when the remote machine has hardware or software that can perform a particular task most efficiently.

Compute services are also helpful if the amount of data to be processed is too large to move to the local machine or if the data is updated too frequently for a local static copy of to be useful.

Data Transfer Services

The data transfer services of SAS/CONNECT provide a method for moving a copy of data from one machine to another where a physical copy is then created. Subsequent local processing takes place against the local copy of the data without generating further network traffic until you decide to update the original copy with another transfer. Data transfer services automatically perform any conversion or translation necessary to move data, such as from one SAS release to another or from one machine representation to another. These services can move data stored in SAS data sets, external databases, and external files.
Remote Library Services

The remote library services of SAS/CONNECT provide access to remote data libraries as if they were stored locally. The data moves through the network only as the local program requests it. A copy of the data is not written to the local file system, and the data must pass through the network on subsequent use by the local processor. This enables you to maintain a single copy of your data and build applications that provide seemingly identical access to local and remote data without requiring the user to know where the data resides.

The Uses of SAS/CONNECT in the SAS Intelligence Platform

Overview of the Uses of SAS/CONNECT in the SAS Intelligence Platform

“Introduction to SAS/CONNECT” on page 16 explains the general capabilities that SAS/CONNECT gives SAS programmers. This section explains how some of the SAS Intelligence Platform clients and some of the SAS macros that are provided with the platform use SAS/CONNECT. You must install SAS/CONNECT on the correct machines (and possibly configure a SAS/CONNECT spawner and server) to use the following features:

- the ability of SAS Data Integration Studio and SAS Enterprise Miner to generate SAS/CONNECT code
- the ability of SAS Data Integration Studio and SAS Enterprise Miner to use grid computing
- the ability to promote the contents of a metadata repository from one environment to another (for example, from a development environment to a test environment)

For more information about providing the infrastructure for these features, see the following sections.

SAS/CONNECT, SAS Data Integration Studio, and SAS Enterprise Miner

If you have installed and configured SAS/CONNECT, then both SAS Data Integration Studio and SAS Enterprise Miner can generate SAS/CONNECT code as part of a job. For example, suppose that you are creating a SAS Data Integration Studio job that processes a large amount of remote data. Instead of sending requests for data across the network and results being returned across the network to you, the job can use SAS/CONNECT compute services to submit the code that does the processing to a SAS/CONNECT server that is running on the remote machine, as shown in the following figure.
Because the code is now executing on the machine where the data resides, the job can execute much faster.

Alternatively, the job can use the data transfer service in SAS/CONNECT to download the data from the remote host so that the job can run on the local processor. If necessary, the job can also upload revised data.

For complete details about how to set up your environment in order to enable this functionality, see “Setting Up Multi-Tier Environments” in SAS Intelligence Platform: Desktop Application Administration Guide. For information about creating data integration and data mining jobs, see the user’s guides and online Help for SAS Data Integration Studio and SAS Enterprise Miner.

**SAS/CONNECT and Grid Computing**

If you have invested in the SAS Grid Manager software application, then users of SAS Data Integration Studio and SAS Enterprise Miner can use SAS/CONNECT not only to submit code to a remote host, but to submit code to a grid of processors. The following figure illustrates the role that SAS/CONNECT plays in grid computing.
The illustration is designed to give you an idea of how this type of system is set up. For more information, see “What is SAS Grid Computing?” in *Grid Computing in SAS*.

**SAS/CONNECT and Metadata Replication**

SAS/CONNECT plays an important role in the area of metadata replication. The Metadata Manager plug-in to SAS Management Console provides a Replication Wizard to copy an entire metadata repository from one environment to another. The wizard produces jobs that use SAS macros, and the SAS macros use SAS/CONNECT code to copy the repository data sets between environments.

The job that is submitted to the workspace server in the source environment (the development environment in this case) uses PROC UPLOAD in SAS/CONNECT to copy the source repository data sets to the target environment. For more information, see “Using the Replication Wizard to Copy an Entire Metadata Repository” in *SAS Intelligence Platform: System Administration Guide*.

**Initial Configuration of the SAS/CONNECT Server**

**Overview of the Initial Configuration of the SAS/CONNECT Server**

“Overview of the Uses of SAS/CONNECT in the SAS Intelligence Platform” on page 17 looks at several scenarios in which SAS/CONNECT plays an important role in the
SAS Intelligence Platform. In the first two scenarios, SAS/CONNECT must be configured on at least one machine in the system. This means that not only was SAS/CONNECT installed on the machine, but the SAS Deployment Wizard configured a SAS/CONNECT spawner and a SAS/CONNECT server on that machine.

If SAS/CONNECT was configured, then the SAS Deployment Wizard will have created metadata objects and files that are used in the management of the spawner and server. The next two sections explain what metadata objects and files were created so that you can understand how things are currently set up and where you might need to make changes.

**SAS/CONNECT Metadata Objects**

When the SAS Deployment Wizard configures SAS/CONNECT, it creates at least three metadata objects:

- one representing a SAS/CONNECT spawner
- one representing a SAS/CONNECT server
- one representing a connection to the SAS/CONNECT server

You can see all of these objects in SAS Management Console. (In order to see the connection, you must select the server.)

You can view the properties of each object by right-clicking its icon and selecting Properties from the pop-up menu. A properties dialog box will be displayed.

The metadata definition for the SAS/CONNECT spawner is very simple. The main pieces of information that it contains are the following items:

- name of the machine on which the spawner will run.
- name of the metadata definition for the SAS/CONNECT server that the spawner can start. This will be set to `SAS-application-server - Connect Server`.

This metadata definition also specifies whether sign-on scripts are allowed. By default, this value is set to **Yes**.

The SAS Deployment Wizard creates the metadata for the SAS/CONNECT server (and the associated connection) and sets values for the following items:

- name of the CONNECT server, logical server, and spawner
- name of the CONNECT spawner log file
- name, display name, and description of the CONNECT spawner Windows service

The following table lists the SAS/CONNECT properties and their default values as set by the SAS Deployment Wizard:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS invocation options</td>
<td>-dmr -noterminal -nosyntaxcheck</td>
</tr>
<tr>
<td>Authentication domain</td>
<td>DefaultAuth</td>
</tr>
<tr>
<td>Host name</td>
<td>localhost</td>
</tr>
</tbody>
</table>
Setting | Default
---|---
Port | 7551
SASCMD options | SAS-configuration-directory\Lev\SASApp\ConnectServer\ConnectServer.bat
Requires encryption | No
Encryption algorithm names | (none)
Encryption algorithm key size | 0
Communication protocol | TCP
SIGNON type | Scriptless
Prompt for user ID and password | No
Execute remote submits synchronously | Yes
Display signon window | Yes
Signon wait | Yes

For more information about these settings, see the SAS/CONNECT User’s Guide.

### SAS/CONNECT Configuration Files

The SAS Deployment Wizard creates several directories and files in support of SAS/CONNECT.

The wizard creates two directories under `SAS-config-dir\Lev\ConnectSpawner` and `ConnectSpawner\Logs`. The `Logs` directory holds the SAS/CONNECT spawner log. The `ConnectSpawner` directory contains configuration files and scripts related to the operation of the SAS/CONNECT spawner. One of those files, `metadataConfig.xml`, contains the information that the SAS/CONNECT spawner needs in order to connect to the metadata server so that it can read the information it needs to start a SAS/CONNECT server. The file contains the following types of information:

- name of the machine on which the metadata server is running
- TCP/IP port on which the metadata server is listening
- authentication domain to which the metadata server belongs
- credentials that can be authenticated by the metadata server (those of the SAS Trusted User)
- name of the metadata repository that contains the definition of the SAS/CONNECT server

The wizard also creates a `ConnectServer` and a `ConnectServer\Logs` directory under: `SAS-config-dir\Lev\SASApp`. These directories contain various configuration files for the SAS/CONNECT server, the SAS/CONNECT server log, and a script that the SAS/CONNECT spawner uses to start a SAS/CONNECT server process.

### Changing the Logging Level of the SAS/CONNECT Spawner

By default, the SAS/CONNECT spawner does not write much information to its log file. To debug SIGNON problems, you might need to change the logging mode to verbose. For information about how to perform this task, see “Administering Logging for SAS Servers” in the SAS Intelligence Platform: System Administration Guide.
Overview of SAS Batch Servers

Batch servers are a required part of the SAS Intelligence Platform’s scheduling system. They are metadata objects that store information about how to execute a SAS command in batch mode. For example, when a SAS Data Integration Studio job is scheduled, the following things happen:

- The name of the SAS program that represents the job is read from a deployment directory.
- Information about the program that will execute the job is read from a SAS DATA Step Batch Server.

This information is passed to the scheduling server, which can then run the job at the appropriate time.

There are three types of batch servers:
- SAS DATA Step Batch Server
- SAS Java Batch Server
- SAS Generic Batch Server

A SAS DATA Step Batch Server is used to locate a script that executes SAS programs in batch mode. Generally, these programs are jobs that are created in and deployed from SAS Data Integration Studio. If your deployment plan contained a scheduling component, then a SAS DATA Step Batch Server object will have been defined during the initial installation and configuration of your system. For more information about SAS DATA Step Batch Servers, see “The SAS DATA Step Batch Server” on page 24.

A SAS Java Batch Server points to a Java application that SAS supplies. Each Java Batch server has a subtype that refers to a particular application. If your deployment plan contains a product that uses reporting, such as SAS Web Report Studio, then the SAS Deployment Wizard automatically creates a SAS Java Batch Server for you. For more information about SAS Java Batch Servers, see “The SAS Java Batch Server” on page 25.

A SAS Generic Batch Server is not used frequently. It enables you to store the path to a stand-alone command or executable that is supplied by SAS, for use cases that do not pertain to the DATA step or Java batch servers.

Note: For a complete discussion of scheduling, see Scheduling in SAS. ▲
The SAS DATA Step Batch Server

If your environment includes a SAS scheduling component, such as Platform Process Manager, then the SAS Deployment Wizard will have defined a Logical SAS DATA Step Batch Server and a SAS DATA Step Batch Server as part of your SAS Application Server.

The properties of the SAS DATA Step Batch Server are shown in the following display:

These properties are explained in the following list:

**Associated Machine** specifies the machine on which the SAS DATA Step Batch Server was configured. This is also the machine on which the deployed job is presumed to reside. It is not necessarily the machine on which the scheduled job will actually execute. The job will execute on the machine where the scheduling server is running. Ensure that any commands that you store in the batch server are capable of running on the scheduling server.

**SubType** specifies the operating system of the machine on which the job will execute.
Understanding the Batch Servers

The SAS Java Batch Server 25

Command Line specifies the script that will start SAS in batch mode so that it can execute the job. This script must be able to execute on the scheduling server host.

Logs Directory specifies the log directory to which SAS can write a log file. This field is required when defining a DATA step batch server. To specify the current directory, enter ./ or an equivalent specification for your host environment.

Rolling Log Options specifies the format for the name of the log file and indicates when a new log file should be started.

The server is configured to start a new log file automatically when the value of any directive in the name changes. By default, the log file will roll over every second (%s). For information about the directives used in the log filename, see the documentation for the SAS system option LOG=.

Note: If you want to use the new SAS 9.2 logging facility instead of the traditional SAS logging feature, enter a hyphen in this field, and append this option to the sas command: -logconfigloc script-path/logconfig.xml, where script-path is the absolute path to the sasbatch script. For more information, see “Enabling Server Logging” in the SAS Intelligence Platform: System Administration Guide.

The SAS Java Batch Server

If your environment includes a SAS product that relies on reporting, such as SAS Web Report Studio, then the SAS Deployment Wizard will have defined a Logical SAS Java Batch Server and a SAS Java Batch Server as part of your SAS Application Server. The type of Java Batch Server that the wizard creates depends on the product configuration and the subtype that it requires. For example, SAS Web Report Studio requires a Reporting subtype that will execute the outputgen command.

The SAS Java Batch Server has the properties that are shown in the following display.
The properties are explained in the following list:

**Associated Machine** specifies the machine on which the SAS Java Batch Server is configured. This is also the machine on which the reports that are being scheduled must reside. It is not necessarily the machine on which the scheduled job actually executes. The job executes on the machine where the scheduling server is running. Ensure that any commands that you store in the batch server are capable of running on the scheduling server.

**SubType** specifies the type of Java batch server that is being started (such as Marketing Automation or Reporting)

**Command Line** specifies the command to start a SAS program or the command to run the batch job.

---

**Additional Information**

The batch servers are just one part of the SAS Intelligence Platform scheduling system. For information about the larger picture, see *Scheduling in SAS*. 
Overview of SAS Grid Servers

The SAS Grid Server serves as a bridge between SAS applications and the grid environment. It enables an application to recognize the grid and submit jobs to it. The grid server is actually a logical server, which is a component under a SAS application server. A grid consists of the following nodes:

- a grid control server
  - a machine that distributes jobs to machines on the grid. A grid control server can also do work allocated to the grid.
- one or more grid nodes
  - a machine or machines that run a portion of the work allocated to the grid.

A logical grid server is required on both types of nodes.

The grid control server and the grid node include the following components:

- grid middleware provider
- workspace server and spawner (grid control server only)
- DATA step batch server
- Base SAS
- SAS/CONNECT server and spawner

The logical grid server definition specifies the command that is used by the middleware provider to start a SAS/CONNECT session.

To configure grid nodes, you first design the grid and designate a machine to be the grid control server. Next, you set up the logical grid server definitions on all of the grid nodes.

After a grid is configured, you can add grid nodes to increase grid capacity, create the required logical server definitions on a machine, and install the required software on each machine. Specific information about setting up and configuring a grid is on the SAS Scalability and Performance focus area: http://support.sas.com/rnd/scalability/grid/griddocs.html. If you are setting up a grid using middleware
other than Platform Suite for SAS (such as United Devices GridMP or DataSynapse GridServer), specific values for the fields in a grid server definition are also on the SAS Scalability and Performance focus area.

Overview of Grid Monitoring Servers

A Grid Monitoring Server is also required in order to use grid computing. It is not a component of a SAS application server nor a SAS Management Console plug-in. The grid monitoring server obtains grid usage information from the grid middleware provider (Platform LSF or other). The information is then available for use by the Grid Manager plug-in that is available through the SAS Management Console. During configuration, the user has to specify the middleware provider and the program module that is used to provide the usage information.

Specific configuration information (especially for non-LSF middleware providers) is available on the SAS Scalability and Performance focus area: http://support.sas.com/rnd/scalability/grid/gridinstall.html.

The Role of the SAS Grid Server in the SAS Intelligence Platform

You will use the SAS Grid Server only if your company has purchased the SAS Grid Manager software application. This software enables you to build a compute grid that can execute grid-enabled jobs that are created in SAS Data Integration Studio or to execute SAS Enterprise Miner or grid-enabled programs.

Either SAS Data Integration Studio or SAS Enterprise Miner submits a grid-enabled job to a workspace server (through its object spawner) that is running on a grid-control machine. SAS/CONNECT and Platform LSF (or another middleware provider) are also installed on this grid-control machine. Platform LSF starts SAS/CONNECT servers on the appropriate grid nodes. Then SAS/CONNECT statements in the job cause portions of the job to be submitted to the remote SAS/CONNECT servers for execution.

The SAS Grid Server enables Platform LSF to start SAS/CONNECT servers on the grid node. It provides Platform LSF with the command to start the servers, and it provides the script that the command submits.

The Initial Configuration of the SAS Grid Server

Overview of the Initial Configuration of the SAS Grid Server

When you build a SAS compute grid, you configure a logical grid server on the grid-control machine and on each grid node. When you configure a logical grid server on the grid-control machine, two actions occur:

- A metadata object is created to represent the logical grid server. It is a server component that belongs to your SAS Application Server. For more information about this object, see “The Logical Grid Server Metadata Object” on page 29.

- A GridServer directory is created in the configuration directory on that machine. This directory contains files and directories that are used in the operation and
management of the grid. For more information about the GridServer directory, see “Logical Grid Server Configuration Files” on page 29.

When you configure a logical grid server on a grid node, only the GridServer directory and its contents are created. Only one metadata object is needed per environment. However, the files in the GridServer directory are needed on each grid node.

For more detailed information about how to set up a grid, see “Planning and Configuring a Grid Environment” in Grid Computing in SAS.

The Logical Grid Server Metadata Object

When you configure a logical grid server on a grid node, metadata objects are created that represent the grid server and the associated connection. The grid server belongs to a logical grid server, which in turn belongs to your application server. To display the icon for the grid server in SAS Management Console navigation tree, expand the Server Manager icon. Then, expand the application server icon, and expand the Logical Grid Server icon.

You can display the properties of the grid server by right-clicking its icon and selecting Properties from the pop-up menu. To see the connection object (in the right pane), select the grid server icon. You can view the properties of the connection by opening its properties dialog box.

The SAS Deployment Wizard populates the logical grid server properties with user input that is supplied during the SAS 9.2 installation. For more information about these properties, see Grid Computing in SAS.

Logical Grid Server Configuration Files

When you configure a logical grid server on a grid node, a GridServer directory is created on the machine. This directory contains the following two items:

- the script sasgrid.extension. This is the script that Platform LSF calls to start a SAS/CONNECT server on that machine.
- a logs directory. By default, no program writes a log file to this directory. However, you can change the command that is used to start the SAS/CONNECT server so that the server writes a log file to this directory.
PART 3

Load Balancing and Pooling

Chapter 7. . . . . . Understanding Server Load Balancing 33
Chapter 8. . . . . . Understanding Server Pooling 53
Chapter 9. . . . . . Configuring Client-side Pooling 59
CHAPTER 7

Understanding Server Load Balancing

Overview of Load Balancing 34
What Is Load Balancing? 34
Overview of Planning, Installation, and Configuration 36
MultiBridge Connections (SAS Stored Process Servers Only) 37
Overview of the Initial Load Balancing Setup for Stored Process Servers 37
Security 38
Load-Balancing Algorithms 38
Log Files 39
Planning a Load-Balancing Cluster 39
Overview 39
Select Hosts and Port Numbers 39
Choose a Load-Balancing Algorithm 40
Select and Configure Logical Server Login Credentials 40
Creating Metadata for Load-Balancing Clusters 41
Overview 41
Convert the Logical Server to Load Balancing 41
Edit Metadata and Convert the Server Instance to Load Balancing 41
Create Metadata for the Other Load-Balancing Servers 42
Installing and Configuring Software for Load-Balancing Servers 42
Overview 42
Install Server and Spawner Software 42
Edit sasv9_usermods.cfg 43
Edit logconfig.xml 43
Edit the .bat File 43
Edit shortcuts.ini 44
Edit OLAPServerSSCU.ini and Install the Service 44
Edits for the UNIX and z/OS Operating Environments 44
Start or Refresh the Object Spawners or OLAP Servers 44
Stopping and Restarting Load-Balancing Servers 44
Adding or Deleting Load-Balancing Servers 45
Understanding the Load-Balancing Algorithms 45
Overview 45
Cost Algorithm: Overview 46
Cost Algorithm: Parameters 46
Cost Algorithm: SAS Workspace Server Example 47
Cost Algorithm: SAS Stored Process Server Example 48
Response Time Algorithm (SAS Stored Process Server Only) 50
Grid Algorithm (SAS Workspace Server Only) 50
Most Recently Used Algorithm (SAS Pooled Workspace Server Only) 50
Least Recently Used Algorithm (SAS Pooled Workspace Server Only) 51
What Is Load Balancing?

Load balancing distributes SAS sessions across a cluster of servers. You can add or subtract servers to accommodate changes in peak demand.

You can create load-balancing clusters of SAS Workspace Servers, SAS Stored Process Servers, SAS Pooled Workspace Servers, and SAS OLAP Servers. For all clusters except OLAP, load balancing is handled by the object spawners that are associated with each server. SAS OLAP Servers do not use object spawners, so OLAP servers handle load balancing directly.

Pooled workspace servers are deployed in load-balancing clusters when you install them with the SAS Deployment Wizard. You can create clusters of the other server types at initial deployment, or at any time thereafter, without having to restart your SAS Metadata Server.

Load-balancing clusters use a peer-to-peer connection. One of the peers in the cluster acts as the parent for the cluster.

The following diagram depicts how peers read cluster metadata at initialization.

---

**Figure 7.1  Cluster Initialization**

1. Peers connect to and read configuration from the metadata server.
2. Peers attempt to connect to each other. One peer is designated to accept connections only from the other peers. This peer is known as the parent peer. Other peers are known as child peers. (Peers can be either object spawners or OLAP servers.)

The parent peer runs a load-balancing algorithm to determine the server that is best suited to accept another client. When the parent receives a client request, the parent either begins the session itself or redirects the client to a specific child peer.

If a child peer receives a connection request directly from a client, the child peer routes the request to the parent peer for assignment to the server with the least load.

The following diagram depicts how clients are assigned to a server in the cluster for workspace servers and stored process servers.
The parent receives a client request, applies it to its load-balancing algorithm, and redirects the client to connect to a specific peer.

In the case of a workspace server or a stored process server, the object spawner creates a new server instance.

The client connects to that peer server.

The following diagram depicts how clients are assigned to a server in the cluster for OLAP servers.

During operation, if the parent peer terminates, one of the child peers assumes the role of parent peer with no interruption of service. When you restart the former parent peer, it restarts as a child peer instead of the parent peer. The new parent peer remains the parent until that peer is restarted.
If a child peer terminates, load balancing continues across the remaining peers. When a child peer is restarted, the parent peer includes that peer in its routing of client requests with no interruption of service.

When you add or remove servers from a cluster, restart all of the servers in the cluster to ensure that all servers read the latest metadata.

The following display shows how load balancing clusters are defined under a single application server and logical server in SAS Management Console.

**Display 7.1  Clustered Workspace Servers in SAS Management Console**

---

### Overview of Planning, Installation, and Configuration

To create a load-balancing cluster, you need to plan the configuration, create server metadata, install server and spawner software, configure the server software, and start the servers on their respective hosts.

In the planning stage, you select an application server, a logical server, separate server hosts, unique port numbers, a load-balancing algorithm, and server login credentials.

In the metadata creation stage, you use SAS Management Console to create metadata objects for each server and spawner in the cluster. You then convert the servers and spawners to load balancing.

In the server installation and configuration stage, you use the SAS Deployment Wizard in Install Only mode to install server software (without configuration files) on host computers. For clusters of workspace servers, stored process servers, and pooled workspace servers, you then use the SAS Deployment Wizard to install a spawner on each host. (SAS OLAP Servers do not use spawners.)

After software installation you copy server configuration files from the cluster's logical server to the new servers that reside on different hosts. You then edit the configuration files and refresh the spawners or servers.
MultiBridge Connections (SAS Stored Process Servers Only)

When you configure load balancing for SAS Stored Process Servers, you must define at least one MultiBridge connection for each server in the cluster. A MultiBridge connection is a specialized bridge connection that is used for stored process servers. Each MultiBridge connection represents a separate server process and runs on a specific port.

The bridge connection for a stored process server is used only for the initial server request. After the spawner determines which server process has the least load, the client is redirected to the appropriate MultiBridge connection. That is, a client requests the bridge connection for a stored process server, and then the spawner redirects the client to the appropriate MultiBridge connection.

Overview of the Initial Load Balancing Setup for Stored Process Servers

In the initial load balancing SAS Stored Process Server configuration, three MultiBridge connections are set up for the stored process server so that the object spawner can start up to three stored process server processes. The object spawner balances the work load across these processes. The object spawner runs on the server host, listens for client requests, and redirects clients to the appropriate server process.

The metadata server's foundation repository contains the spawner, server, and security metadata for the load balancing stored process server configuration. The object spawner must connect to the metadata server, and the metadata must be configured appropriately, in order for the spawner to start the load balancing stored process server processes.

Note: On Windows, all user IDs are host or domain qualified, for example (domain-name\sastrust).

The object spawner obtains the metadata that it needs to start a load balancing stored process server as follows:

1. When the spawner is started, it reads a metadata configuration file named metadataConfig.xml that contains information that is required to access the metadata server. This metadata configuration file specifies the following information:
   - the location of the metadata server
   - the user ID that the spawner will use to connect to the metadata server

   By default, the metadataConfig.xml file contains the user ID sastrust, which is owned by the SAS Trusted User (in the metadata).

2. The object spawner connects to the metadata server with the user ID that is specified in metadataConfig.xml. This user’s credentials are authenticated by the metadata server's authentication provider.

3. On the metadata server, the connection from the object spawner is associated with the user that owns the sastrust user ID, SAS Trusted User. The spawner, as the SAS Trusted User, reads the metadata for the server and spawner configuration.

   Note: The SAS Trusted User can view the stored process server's multi-user login credentials (sasrv) because the SAS Trusted User is a member of the SAS General Servers group. The SAS General Servers group owns the server’s multi-user login credentials.

At this point, the object spawner has the necessary metadata to launch a stored process server.
When a client requests a server, the client connects to the spawner and is authenticated using the token that the client received when it connected to the metadata server.

If the object spawner needs to launch a new stored process server, then the object spawner uses the server’s multi-user login credentials (sassrv) to launch the load-balancing stored process server.

Note: Because the stored process server runs under the multi-user login credentials that are specified in the stored process server definition, each client can access information that only sassrv has permission to access. △

In your initial load balancing stored process server configuration, you must ensure that the following security is set up properly:

- Ensure that the SAS Trusted User’s credentials are specified in the metadata configuration file metadataConfig.xml.
- Using the Authentication Manager in SAS Management Console, ensure that, in the foundation metadata repository, the SAS Trusted User is a member of the SAS General Servers group.
- Ensure that the SAS Trusted User has access to the metadata definitions for the object spawner and any servers it manages.
- Ensure that, in the foundation metadata repository, the group login that is owned by the SAS General Servers group is specified in the stored process server definition. The server login credentials are provided on the Options tab of the server’s Properties window.
- Ensure that the user ID and password of the group login for the SAS General Servers group match the credentials in a user account that is defined in the stored process server’s host authentication provider.

---

**Security**

With load balancing, every connection to the server is authenticated with the credentials of the client. Also, every client must have ReadMetadata permission on the server.

The credentials that the server runs under depend on the type of the server:

- SAS Workspace Servers run under the credentials of the client.
- SAS Stored Process Servers and SAS Pooled Workspace Servers run under the multi-user login credentials that are specified in the stored process server definition.

Note: Because the load-balancing stored process server runs under the multi-user login credentials, the operating system account for these credentials must have access to any operating system resources used by stored processes that are hosted on the stored process server. △

- SAS OLAP Servers run under credentials of whoever launches it. If it is launched as a service on Windows, this is the local system account by default.

Note: For OLAP clusters, make sure that you assign credentials to the logical OLAP server. If credentials have not been assigned, the peers will not attempt to connect to each other. If credentials were not assigned, assign them and restart the servers in the cluster. △

---

**Load-Balancing Algorithms**

The parent peer in a load-balancing cluster runs a load-balancing algorithm to evaluate server load and select child peers for new SAS sessions. Five algorithms are...
available: Cost, Response Time, Grid, Most Recently Used, and Least Recently Used. SAS OLAP Servers are required to use the Least Recently Used algorithm. Other types of load-balancing clusters enable you to select between two or more available algorithms.

---

**Log Files**

At installation, clustered servers are configured to generate the same error log files that are generated by default on servers that are not clustered, as described in the chapter “Administering Logging for SAS Servers” in the *SAS Intelligence Platform: System Administration Guide*.

Clusters of SAS OLAP Servers, SAS DATA Step Batch Servers, and SAS/CONNECT Servers generate separate ARM log files in addition to their error log files. You should enable ARM logs only when you are tuning and testing your clusters.

**CAUTION:**

To ensure the accuracy of your ARM log files, be sure to configure your cluster so that each server writes to a separate ARM log file.

Log files are configured as described in “Edit logconfig.xml” on page 43.

---

**Planning a Load-Balancing Cluster**

---

**Overview**

To plan for a new load-balancing cluster, you choose hosts, port numbers, a load-balancing algorithm, and logical server login credentials (for OLAP clusters).

**Select Hosts and Port Numbers**

To select the hosts that will make up your load-balancing cluster, follow these steps:

1. Determine the number of hosts that you will need in your cluster based on your average number of concurrent users and your maximum number of concurrent users.

2. Decide on the logical server that will contain your cluster of servers. You can use an existing logical server or create a new one using the SAS Deployment Wizard. In either case, you will have one configured server available under that logical server, as shown in SAS Management Console. Note that the additional processing load on the parent peer is not significant, so the parent peer does not have to be the highest performing host in your cluster.

3. Select and configure the hosts that will comprise your cluster.

4. Select and write down unique server names and unique port numbers for each host. (Unique ports are required when configuring load balancing on a single machine.) You will enter the server names when you copy and update the server configuration files between hosts. In the server names, you might want to identify the servers as load balancing and include the port number for quick reference.
Choose a Load-Balancing Algorithm

Select a load-balancing algorithm based on the choices that are available for your server type. Clusters of SAS OLAP Servers are required to use the Least Recently Used algorithm. The Cost algorithm is recommended for clusters of SAS Workspace Servers and SAS Stored Process Servers.

The following table depicts the algorithms that are available for each server type.

Table 7.1 Available Load-Balancing Algorithms

<table>
<thead>
<tr>
<th>SAS Server Cluster</th>
<th>Load Balancing Algorithms</th>
<th>Cost</th>
<th>Response Time</th>
<th>Grid</th>
<th>Most Recently Used</th>
<th>Least Recently Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace Server</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stored Process Server</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pooled Workspace Server</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OLAP Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

For more information about the load-balancing algorithms, see “Understanding the Load-Balancing Algorithms” on page 45.

Select and Configure Logical Server Login Credentials

Load-balancing clusters use individual login credentials to establish connections between the parent peer and the child peers. During this planning phase you establish the login credentials and then assign the credentials trusted user permissions. Later, in the metadata creation stage, you will enter the credentials for each server in the cluster.

Use a network domain account for server credentials. Create the credentials in your operating environment as needed, then assign those credentials trusted user permissions in SAS.

You must do this because the spawner connects with an account that is the SAS Trusted User, and that account must be able to fetch this login to connect to other servers. This SAS Trusted User login must be accessible by the SAS Trusted User identity. Therefore, you must add the login to this Person object.

To assign trusted user permissions to your server login credentials, follow these steps:

1. Open SAS Management Console.
2. In SAS Management Console, open the **User Manager**.
3. In the right pane double-click to open **SAS Trusted User**.
4. In the SAS Trusted User properties window, click the **Accounts** tab.
5. On the **Accounts** tab, enter the login credentials and click **OK**.

*Note:* Do not associate your server login credentials with the SAS Unrestricted User. △

You have now completed the planning stage. Move to the metadata creation stage.
Creating Metadata for Load-Balancing Clusters

Overview

At this stage in the process of creating a load-balancing cluster, you have identified hosts, chosen server names and port numbers, and selected server login credentials. In the metadata creation stage you will establish metadata identities for the servers in your cluster and set load-balancing parameters. After this stage you will install and configure the server software on your hosts.

If you need to install a new SAS Application Server and SAS Logical Server on a new host, do so now using the SAS Deployment Wizard in Configuration Mode. Return to this section afterwards. For information about creating new servers, see “Add an Additional SAS Application Server” on page 77.

Convert the Logical Server to Load Balancing

To convert your logical server to load balancing (workspace and OLAP servers only), follow these steps:

1. Open SAS Management Console and click Server Manager to display the available servers.
2. To display the SAS Logical Server that will contain your cluster, double-click the appropriate SAS Application Server.
3. Right-click the logical server and select Convert To Load Balancing.
4. In the Load Balancing Options window, choose a load-balancing algorithm and choose values for the other available options. For information about the load-balancing algorithms, see “Understanding the Load-Balancing Algorithms” on page 45. Click Help to learn about the load-balancing options.
5. Provide data for the remaining fields in the wizard. For the logical server credentials, refer to “Select and Configure Logical Server Login Credentials” on page 40.

CAUTION:
Credentials are required on logical servers to enable peer-to-peer communication.

Edit Metadata and Convert the Server Instance to Load Balancing

At this point, your logical server should contain one server instance and one associated spawner process (for all cluster types except OLAP). To edit metadata for the first server and convert the server to load balancing, follow these steps:

1. Open the properties window of the initial server instance beneath the load-balancing logical server.
2. On the General tab, rename the server according to the naming convention of your cluster. In the Description field, mention the purpose of your load-balancing cluster. Then click OK to close the properties window.

Note: This step is optional. Renaming the server helps to identify that it is configured as load balanced in the SAS Management Console Server Manager and in log files.
3 For an OLAP server only, move to the **Connections** tab and open the properties window of the server connection. On the **Options** tab, change the port number if necessary, and then click **OK** to close the properties window.

---

### Create Metadata for the Other Load-Balancing Servers

To create metadata for the new servers in your cluster, follow these steps:

- Right-click the logical server that has been converted to load balancing and select **Add Server**.
- In the New Server Wizard, select the server type that you want to add to your cluster and fill out the rest of the information that is requested. Be sure to enter the appropriate host name, server name, and port number.
- Repeat these steps for the rest of the new servers in your cluster.

Move to the server software installation and configuration stage.

---

### Installing and Configuring Software for Load-Balancing Servers

#### Overview

At this point you have planned your cluster and created metadata for your servers and spawners. In this last stage, you will install and configure the server and spawner software on the hosts of your cluster, copy and edit server configuration files, and then start or refresh your spawners or OLAP servers.

#### Install Server and Spawner Software

The last stage in the process of creating a load-balancing cluster involves the installation of server and spawner software on the hosts of your cluster, and the copying and editing of server configuration files onto your hosts.

To install server software and configuration files on your hosts, follow these steps:

1. Use the SAS Deployment Wizard in Install Only mode to install the server software on the first new host in your cluster. Use Install Only mode so that you do not install server configuration, start-up, or log files. Instead of installing those files automatically, you will add and edit the configuration files manually, later in this procedure. For now, to install server software, see “Adding a New Server in an Existing Application Server” in the chapter “Managing SAS Application Servers.”

2. For the same host, and for all server types other than OLAP (workspace, pooled workspace, or stored process), use the SAS Deployment Wizard to install an object spawner on the same host. Use Configuration Mode to automatically install spawner configuration files.

3. Copy all of the server start-up files from the logical server to the host that received the new server. Be sure to include the subdirectories named logs and sasuser, along with all of their contents. The path to the source files on the logical server should be of the form: `SAS-config-dir/Levn/SASAppl/OLAPServerLb1/*.*`. The path to the target on the new host should be of the form: `SAS-config-dir/Levn/`
Understanding Server Load Balancing

Edit the .bat File

Edit the .bat File

SASApp1/OLAPServerLB1/OLAPLB1_2249, where OLAPServerLB1_2249 is the name of the new server on the new host.

4 Edit the server files as described in the remainder of this section, according to the operating environment of each host, so that the files reflect the name and port of the new server.

5 Repeat these steps for the other hosts, servers, and spawners in your cluster.

Edit sasv9_usermods.cfg

SAS asks that you not edit sasv9.cfg. Instead, edit sasv9_usermods.cfg. The user modifications file serves the same purpose as sasv9.cfg, because the contents of the .cfg files are hierarchical and inherited.

To edit the file that was originally copied from the cluster’s logical server, on each new host in your cluster, follow these steps:

1 In the –OBJECTSERVERPARMS option, change SERVER= to point to the new server.

2 Add the PORT= option to specify the unique port number for the new server.

3 In the Windows operating environment, add the PROTOCOL=BRIDGE option.

4 Change the –LOGCONFIGLOC option to point to the logconfig.xml file on the new server.

5 Change the –SASUSER option to point to the subdirectory of the same name on the new server.

6 Change the –CONFIG and –AUTOEXEC search paths. Give thought to the configuration settings and AUTOEXEC actions that you will share among the servers in your cluster. Add your settings and actions to the appropriate level of the search paths.

Edit logconfig.xml

To edit the log configuration file logconfig.xml, follow these steps:

1 For the Rolling File Appender, change the value of the fileNamePattern parameter to specify the location of the .log file on the new host.

2 For the ARM File Appender, change the value of fileNamePattern parameter to specify the location of the .arm file on the new host.

All logging behavior can be configured, as described in the SAS Intelligence Platform: System Administration Guide.

CAUTION:
For clusters of SAS OLAP Servers, SAS DATA Step Batch Servers, and SAS/CONNECT Servers, make sure that each server in your cluster writes to a separate ARM log file. Sharing log files results in inaccurate log information.

Edit the .bat File

On Windows, to edit the .bat file for your new server, follow these steps:
1 Change the value of CONFIGDIR= to include the name of the new server. Be sure not to change the application server context, which is commonly specified by %APPSERVER_ROOT%. The new server needs to point to the application server of the first server in the cluster, which runs on a different host.

2 Change the start command to include the name of the new server.

---

**Edit shortcuts.ini**

Files with names such as OLAPServer_shortcuts.ini might contain user-defined shortcuts. Update the server name in the paths that appear in this file.

---

**Edit OLAPServerSSCU.ini and Install the Service**

In the Windows operating environment, edit the server name that appears in various option values in this file. When the edits are complete, run the .bat file in install mode. For example, you might execute the following command:

```
C:\SAS\Config\Lev1\SASApp1\OLAP_LB1_2249\OLAPServer.bat install
```

---

**Edits for the UNIX and z/OS Operating Environments**

Edit the following configuration files in the UNIX operating environment, or in UNIX System Services for the z/OS operating environment: rexx.cfg, tkmvse alters the server shell file (with a name such as OLAPserver.sh). In all of these files you need to change the name of the server.

---

**Start or Refresh the Object Spawners or OLAP Servers**

You should now start or refresh the object spawners or OLAP servers in the load-balancing cluster. Refreshing a spawner reinitializes it. The spawners or OLAP servers reread their configuration out of the metadata. As part of this refresh, the spawner shuts down any servers that it currently has started. If changes are made to the server or spawner configurations, the spawner can be refreshed in order to pick up and apply these new changes. For more information, see “Refresh the Object Spawner” in the chapter “Managing SAS Application Servers”.

At this point, your load balancing cluster should be operational. Check the log files as needed to confirm operation.

---

**Stopping and Restarting Load-Balancing Servers**

To start the load-balancing servers in your cluster, you can use SAS Management Console or you can restart your hosts, depending on your server configuration.

Be sure to restart all of the servers in a cluster after you add or delete servers.

When you stop a child peer, or if it fails, the parent peer continues to distribute SAS sessions to the remaining servers in the cluster, with no loss of service. You can restart the child peer at any time. In that case the parent peer simply adds the new child peer into its distribution of SAS sessions.

If the parent peer stops, the next server in the list becomes the parent peer. The new parent peer continues the distribution of SAS sessions without interruption.
When you restart the former parent peer, it restarts as a child peer. The new parent peer remains in that role until you restart that server.

### Adding or Deleting Load-Balancing Servers

After you create a load-balancing cluster, you might need to add or delete servers in response to accommodate changes in peak demand.

To add or delete servers from a cluster, follow these steps:

1. To add a server, follow the instructions in “Creating Metadata for Load-Balancing Clusters” on page 41 and “Installing and Configuring Software for Load-Balancing Servers” on page 42.

2. To delete a server, open the Server Manager in SAS Management Console, right-click the server, and select **Delete**. Remove server software as necessary.

3. Restart all of the servers in the cluster to ensure that all servers are reading the latest cluster metadata.

### Understanding the Load-Balancing Algorithms

**Overview**

The following algorithms support load balancing on SAS workspace server, stored process servers, pooled workspace servers, and OLAP servers:

<table>
<thead>
<tr>
<th>Algorithm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>(SAS Workspace Servers and SAS Stored Process Servers only) The cost algorithm assigns a cost value (determined by the administrator) to each client that connects to the server. The algorithm can also assign cost values to servers that have not started yet. When a new client requests a connection, load balancing redirects the client to the connection with the lowest cost on the machine with the lowest total cost. This is the default algorithm for stored process and standard workspace servers.</td>
</tr>
<tr>
<td>Response Time</td>
<td>(SAS Stored Process Servers only) Each spawner’s load balancer maintains an ordered list of machines and their response times. Load balancing updates this list periodically at an interval that is specified by the administrator. When a new client requests a connection, load balancing redirects the client request to the machine at the top of the list.</td>
</tr>
<tr>
<td>Grid</td>
<td>(SAS Workspace Servers only) The Grid algorithm communicates with a SAS Grid Server to allow load balancing access to grid-related load information. This information is used by the object spawner to find the least loaded server machine that will accept the client request. (This algorithm is available only when the SAS Grid Server has been deployed.)</td>
</tr>
<tr>
<td>Most Recently Used</td>
<td>(SAS Pooled Workspace Servers only) The Most Recently Used algorithm emphasizes reusing workspace servers. This algorithm attempts to send clients into running servers before starting new servers.</td>
</tr>
</tbody>
</table>
servers. The goal of this algorithm is to reduce the overhead of starting new servers by using servers that are already running. This is the default algorithm for pooled workspace servers.

Least Recently Used (SAS OLAP Servers and SAS Pooled Workspace Servers only) The Least Recently Used algorithm attempts to use the least recently used server. This algorithm provides more of a breadth-first approach to balancing the client load.

Cost Algorithm: Overview

The Cost algorithm uses a cost value to represent the work load that is assigned to each server (or server process) in the load-balancing cluster. Each time a client connects or a stored process is executed, the spawner updates the cost value for the appropriate server. When a client requests a connection to the load-balancing cluster, the spawner examines the cost values for all of the servers in the cluster, and then redirects the client to the server that has the lowest cost value.

The Cost algorithm works differently for SAS Workspace Servers and SAS Stored Process Servers:

- **SAS Workspace Servers.** When a new client requests a connection, the load-balancing spawner redirects the client to the server that has the lowest cost value. When the client connects to the designated server, the spawner increments that server’s cost by a specified value (cost per client). When that client disconnects, the spawner decrements that server’s cost by the same value (cost per client).

- **SAS 9.2 Stored Process Servers.** When a new client requests a connection, the load-balancing spawner redirects the client to the server process that has the lowest cost value on the machine with the lowest total cost. When the client connects to the designated server process, the spawner increments the cost for that process by the same value (cost per client).

The stored process server cost is determined by two values, Session Cost and Context Cost. The default values are 1 and 100 respectively. To change the default values, use the Options tab in the properties window of the logical stored process server.

Cost Algorithm: Parameters

The Cost algorithm uses the following cost parameters, which are treated as weighted values:

- **Cost per client** (field on the load-balancing logical server definition) specifies the default amount of weight (cost) that each client adds (when it connects) or subtracts (when it disconnects) to the total cost of the server.

- **Startup cost** (field on the server definition) specifies the start-up cost of the server. When a request is made to the load-balancing spawner, the spawner assigns this start-up cost value to inactive servers. A new server is not started unless it is determined that its cost (the start-up cost) is less than that of the rest of the servers in the cluster. This field enables the administrator to control the order in which servers are started. After a server is started, the cost value is 0. When a client connects to the server, the server’s cost value is increased.
Maximum cost (field on the load-balancing logical server definition) specifies the maximum cost value that each server can have. After a server reaches maximum cost, the load-balancing spawner will not redirect any more clients to the server until its cost value decreases.

Cost Algorithm: SAS Workspace Server Example

A load balancing cluster contains two workspace servers on two different machines, Machine A and Machine B. The following table displays the initial status of the cluster:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Workspace Server A</th>
<th>Workspace Server B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clients</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Maximum Cost</td>
<td>500</td>
<td>200</td>
</tr>
<tr>
<td>Cost Per Client</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Cost to Connect</td>
<td>300</td>
<td>200</td>
</tr>
</tbody>
</table>

At the start of the example, five clients have connected to the cluster and the client connections are balanced between the two servers. Workspace Server A has three clients and Workspace Server B has two clients. The following figure illustrates what happens when an additional client requests a connection:

Figure 7.4 New Client Connection

The client requests a connection to Workspace Server B. The spawner on Machine B examines the cost values of all of the servers in the cluster. Workspace Server B has the least cost, but it has
reached its Maximum Cost value and cannot accept any more clients. The spawner redirects the client to Workspace Server A. The client requests a connection to Workspace Server A. The spawner on Machine A creates a server connection for the client, and then increments the cost value for Workspace Server A by the cluster’s Cost Per Client value (100).

The following table displays the final status of the cluster:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Workspace Server A</th>
<th>Workspace Server B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clients</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Maximum Cost</td>
<td>500</td>
<td>200</td>
</tr>
<tr>
<td>Cost Per Client</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Cost to Connect</td>
<td>400</td>
<td>200</td>
</tr>
</tbody>
</table>

At the end of the example, the cost to connect to Workspace Server A is 400, because there are four clients and the Cost Per Client value is 100.

**Cost Algorithm: SAS Stored Process Server Example**

A load-balancing cluster contains one stored process server with two server processes (MultiBridge connections), Server Process A and Server Process B. The following table displays the initial status of the cluster:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Server Process A</th>
<th>Server Process B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Running</td>
<td>Not Running</td>
</tr>
<tr>
<td>Clients</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Stored Processes</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Startup Cost</td>
<td>300</td>
<td>300</td>
</tr>
<tr>
<td>Cost to Connect</td>
<td>402</td>
<td>300</td>
</tr>
<tr>
<td>Cost Per Client</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

At the start of the example, Server Process A is running and has two clients. Each client on Server Process A is running one stored process, so the cost to connect for Server A is 402 (2 clients * 100 + 2 processes running * 101). Server Process B has not started yet, so the cost to connect to Server Process B is the Startup Cost (300). The following figure illustrates what happens when an additional client connects:
The client requests a connection to the stored process server. The load-balancing spawner examines the cost values of all of the servers in the cluster and determines that Server Process B has the lowest cost. The spawner redirects the client to Server Process B.

The client requests a connection to Server Process B. The spawner starts the server process and then provides a connection to the client. The spawner increments the cost value for Server Process B by the cluster's Cost Per Client value (100).

The following table displays the final status of the cluster:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Server Process A</th>
<th>Server Process B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Running</td>
<td>Running</td>
</tr>
<tr>
<td>Clients</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Stored Processes</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Startup Cost</td>
<td>300</td>
<td>300</td>
</tr>
<tr>
<td>Cost to Connect</td>
<td>402</td>
<td>100</td>
</tr>
<tr>
<td>Cost Per Client</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

At the end of the example, the cost for Server Process B is 100, because there is one client and the Cost Per Client value is 100. There are no stored processes running, and the Startup Cost value does not apply because the server process has been started. If the client submits a stored process, the cost will increase by 101 (the standard cost per stored process).
Response Time Algorithm (SAS Stored Process Server Only)

The Response Time algorithm uses a list of server response times in order to determine which server process has the least load. For each server process in the load-balancing cluster, the load-balancing spawner maintains an ordered list of servers and their average response times. Each time the spawner receives a client request, it redirects the client to the server process at the top of the list. The spawner updates the server response times periodically. You can specify the update frequency for the response time (response refresh time) in the metadata for the load-balancing cluster.

The Response Time algorithm uses the following parameters:

- **Refresh rate**
  (field on the load-balancing logical server definition) specifies the length of the period in milliseconds that the load-balancing spawner will use the current response times. At the end of this period the spawner updates the response times for all of the servers in the cluster and then reorders the list of servers.

  Note: If this field is set to 0, the load-balancing spawner does not use the response time list to redirect clients to servers. Instead, the spawner redirects clients to servers sequentially, in the order in which the servers are defined in the metadata.

- **Maximum clients**
  (field on the server definition) specifies the maximum number of clients that a server can have. After a server reaches its maximum number of clients, the spawner will not redirect any more clients to the server until a client disconnects.

Grid Algorithm (SAS Workspace Server Only)

If you have a SAS grid installed and configured, then you can leverage the functionality of the SAS Grid Manager to identify the SAS Workspace Server best suited to handle a SAS client’s request in your cluster of workspace servers. The Grid algorithm communicates with a SAS Grid Server to allow load-balancing access to grid-related load information. This information is used by the object spawner to find the least loaded server machine that will accept the client request.

The Grid algorithm uses the following parameters:

- **Grid server**
  (field on the load-balancing logical server definition) specifies the name of the SAS Grid Server with which the object spawner gathers grid-related load information.

- **Grid server credentials**
  (field on the load-balancing logical server definition) specifies valid credentials that the object spawner uses to authenticate with the grid server.

- **Grid server connect timeouts**
  (field on the load-balancing logical server definition) specifies the amount of time (in seconds) to wait for a connection to the grid server.

Most Recently Used Algorithm (SAS Pooled Workspace Server Only)

The Most Recently Used algorithm emphasizes reusing workspace servers. This algorithm attempts to send clients into running servers before starting new servers. The goal of this algorithm is to reduce the overhead of starting new servers by using servers that are already running.
The Most Recently Used algorithm uses the following parameters:

Server process maximum
(field on the server definition) specifies the maximum number of server processes that can be created for this server definition.

Server process minimum
(field on the server definition) specifies the minimum number of server processes that are available at any time for this server definition.

---

**Least Recently Used Algorithm (SAS Pooled Workspace Server Only)**

The Least Recently Used algorithm attempts to use the least recently used server. This algorithm balances provides more of a breadth-first approach to balancing the client load.

The Least Recently Used algorithm uses the following parameters:

Server process maximum
(field on the server definition) specifies the maximum number of server processes that can be created for this server definition.

Server process minimum
(field on the server definition) specifies the minimum number of server processes that are available at any time for this server definition.
Overview of Pooling

A collection of reusable workspace server and stored process server processes is referred to as a pool. By reusing server processes, pooling avoids the cost that is associated with creating a new process for each connection. If your client application uses frequent, short-duration connections to SAS, pooling might greatly improve your server performance.

SAS 9.2 supports the following two types of pooling:

- Server-side pooling
  
  Server-side pooling is new to SAS 9.2 and is the process by which the SAS Object Spawner maintains a collection of workspace servers that are available for clients. The usage of servers in this pool is governed by the authorization rules that are set on the servers in the SAS metadata. For more information, see “How Server-side Pooling Works” on page 53.

- Client-side pooling
  
  Client-side pooling is the only type of pooling that is available in SAS 9.1.3 (and earlier) and is the process by which the client application maintains a collection of reusable workspace server processes. For more information, see “How Client-side Pooling Works” on page 55.

For a discussion on the strengths, weaknesses, and scope for each type of pooling, see “Choices in Workspace Server Pooling” in SAS Intelligence Platform: Security Administration Guide.

How Server-side Pooling Works

The usage of the servers in a server-side pool is governed by the authorization rules that are set on the servers in the SAS metadata. Server-side pools use the ReadMetadata permission on the server component metadata objects in the pool to control access. Server-side pooling allows more flexibility than client-side pooling, which limits access to a single group.
Another benefit of server-side pooling is that workspace server load balancing functionality is automatically built in. When a user connects to a pool, the spawner determines the server to send the user to based on the user's access rights and on current server loads.

By using access controls on servers in metadata, the server that actually runs a user's job can be controlled by the user's identity in metadata. (A server defined in metadata, can be one or more processes that are running on one or more machines.) Because different servers can have different command lines, you can use server-side pooling to ensure that a user is assigned to a server process that was launched with a specific command line. One useful implementation of this feature is to launch server-side pooled workspace servers that use an operating system's run priority level.

For example, on UNIX, an administrator might manage server performance by creating the server with the UNIX `nice` command. Lower priority users might use a server that was launched with a higher system value such as 5. Higher priority users might use a server that was launched with a lower system value such as -2. On Windows, the administrator might manage server performance using the `/<priority class>` option on the `start` command. (A user with a lower priority might run on a pooled workspace server started with a start-up command that is similar to: `start/low sas.exe`. Higher priority users might run on a pooled workspace server with a start-up command that is similar to: `start/high sas.exe`.) For more information, refer to your documentation for the appropriate operating system.

---

**Understanding the Server-side Pooling Connection Process**

Server-side pooling is the process by which the object spawner maintains a pool of servers available for a client. (The object spawner maintains a port bank to facilitate client connections to this server pool.) The usage of servers in this pool is governed by the authorization rules that are set on the servers in the metadata. The following process describes how an application retrieves and uses a pooled workspace server to handle a user request:

1 A user accesses a SAS client application, and the application requests a connection to a workspace server.

2 The spawner receives the application connection request (on behalf of the user) and decides which server to send the request to based on two criteria:

   - the application user's identity (On which servers does the user have authorization?)
   - the load-balancing algorithm

3 The spawner receives the user connection request and passes the user's credentials to the SAS Metadata Server to determine what servers in the pool the user is authorized to access.

4 The spawner decides which server to send the user to based on the selected load-balancing algorithm, the user's identity, and which servers that the user is authorized to use.

5 The spawner performs one of the following actions based on server availability:

   - If there are servers available, then the spawner redirects the user to an available server.
   - If there are no servers available in the pool and one can be started, then the spawner starts a new server under the launch credentials, adds this new server to the pool, and redirects the user to this server.
□ If the pool has reached its maximum size, then the spawner cannot add any more servers to the pool. The user must wait until there is an available server in the pool or fail after an amount of time. (The maximum size of the pool is determined by the Server Process maximum property for each server. The application wait time is determined by the Availability timeout property that is found on the Logical Pooled Workspace server.)

6 The workspace server is available to the application to run SAS code. Because the pooled workspace server runs under an administrator-defined host identity, any physical file access that is done by the workspace server process is done under that host identity. This includes access to SAS data sets.

7 When the user has finished using the pooled workspace server, the server is returned to the pool, and it can be reused by other users.

---

**How Client-side Pooling Works**

The server processes within a pool are divided into one or more puddles. A puddle is a group of server processes that are accessible to a specific user group and that connect to SAS by using a single set of credentials called the puddle login.

The metadata administrator might choose to create several puddles to control the data that users are authorized to access. Because the SAS server uses the puddle login both to connect to the metadata and to run the server process, this authorization (access control) can be applied in the metadata or on the physical data (by using file system authorization). For example, the metadata administrator might give one puddle read and write access to a table on an IOM server, while giving another puddle only read access.

Another reason for using multiple puddles is to control how available the server processes are for different users. If you are a member of only one puddle access group, then you can access only those connections. If you are a member of multiple puddle access groups, then you have access to more connections.

*Note:* By default, the SAS Deployment Wizard deploys a server-side pooled workspace server. To completely eliminate use of server-side pooling, delete this logical pooled workspace server. For more information, see “Remove Logical Servers” on page 84.

---

**Understanding the Client-side Pooling Connection Process**

The following figure shows a connection to a pooled workspace server:
Consider an example of a client-side pool configuration that consists of:
- two puddles: Puddle1 and Puddle2
- two groups: Puddle1Access and Puddle2Access
- two SAS server machines with an object spawner on each

The following process describes how a user retrieves and uses a client-side pooled connection:

1. A user, User B, accesses a SAS client application, and the client requests a connection to SAS for the user.

2. The client application uses a special account called the pool administrator to connect to the SAS Metadata Server and to read the pool metadata. The pool administrator must be able to view the metadata for all the logins (puddle logins) that are used to make connections for the pool. The pool administrator also needs to be able to view the membership of the puddle access groups. The SAS Trusted User is the default pool administrator.

   Note: The pool administrator does not need to be able to view the login definition for the requesting user ID.

3. For each puddle, if the minimum number of servers and minimum available servers are not met, the client application uses the appropriate puddle login credentials to launch new server processes.

   The pool determines which puddle the requesting user ID can access. The pool selects a puddle where one of the following is true:
   - The requesting user ID is a member of the group that is granted access to the puddle.
   - The requesting user ID matches the puddle login’s user ID, or is owned by the same user or group that owns the puddle login’s user ID. (An example for this usage is rare: a single-user application wants to set up a personal connection pool for benefits such as reconnecting after an abnormal disconnect.)
In this example, User B is a member of the Puddle2Access group. The Puddle2Access group has access to the Puddle2 puddle, therefore, User B will access Puddle2.

The pool manager returns a server connection from the selected puddle as follows:

- If a server process is available, then the pool returns a connection to the requesting user.
- If there are no available server processes, and the maximum number of server processes has not been met, then the pool uses the puddle login to create a new server process and returns a connection to the requesting user.
- If there are no available server processes and the maximum number of server processes has been met, then the requesting user must wait for a server process to become available. When a process becomes available, the pool returns a connection to the requesting user.

Note: For Java client applications, the pool balances the number of connections for each puddle among the server machines. For Windows client applications, all of the connections are assigned to the first server machine, until the maximum number of connections for that machine is met.

The user accesses resources and services on the SAS server. Authorization for content on the SAS server is performed by using the puddle login.

When the user has finished using the server connection, the server process is returned to the pool, and it can be reused by other users.
Is Client-side Pooling Right for My Site?

Before SAS 9.2, client-side pooling was the only option for configuring SAS Workspace servers in a pool. SAS 9.2 continues to support client-side pooling but now introduces server-side pooling. For more information about the relative strengths of each method, see these topics:

- “Overview of Pooling” on page 53
Understanding Client-side Pooling Concepts

Before performing this configuration, it is important that you understand a couple of concepts. For example, what does it mean to set up a client-side pooling workspace server? If a workspace server has not been converted to pooling, then each time a SAS Web Report Studio or SAS Information Delivery Portal user starts a session, a workspace server process must be created and the user must establish a connection to this process. This can be a time-consuming sequence of events. When you set up a client-side pooling workspace server, a pool (or set) of connections to workspace servers are opened when SAS Web Report Studio or SAS Information Delivery Portal makes its first request for a workspace server. A user can then obtain a preexisting connection from the pool instead of having to establish the connection.

Another important concept is that of a puddle. A puddle is a subset of the connections in a client-side pool. Setting up puddles enables you to associate a different set of users with different puddles. The Pool Administrator is the user who reads metadata regarding the entire pool. This ID defaults to sastrust@saspw. It is not used for the actual workspace server, just to process the pool. Each puddle has a login that is specific to the puddle. Typically, the reason for setting up different groups of users is to give the different groups different levels of access.

For more information, see “Administering Logging for SAS Servers” in the SAS Intelligence Platform: Security Administration Guide.

Overview of Configuring Client-side Pooling

This topic summarizes the steps required for setting up client-side pooling for your workspace server for use with SAS Web Report Studio and SAS Information Delivery Portal. To contrast client-side pooling with server-side pooling, see “Overview of Pooling” on page 53. The result of this configuration has better performance than connecting to a standard workspace server.

To set up a client-side pool, you must do the following:

1. Plan the metadata identities and logins for puddle access.
2. Plan the puddles for the client-side pooled logical server.
3. Convert a logical server to a client-side pooled logical server.
4. Configure pooling properties for each server.
5. Verify that client-side pooling is working.

Note: By default, the SAS Deployment Wizard deploys a server-side pooled workspace server. To completely eliminate use of server-side pooling, delete this logical pooled workspace server. For more information, see “Remove Logical Servers” on page 84.

If your deployment requires more than one host for client-side pooled workspace servers, then you can configure client-side pooling across multiple machines. For more information, see “Configure Client-side Pooling across Multiple Machines” on page 67.

Configuring Client-side Pooling
Plan the Metadata Identities and Logins for Puddle Access

To plan the client-side pooling security, you must determine the user metadata identities, and the logins for the group metadata identities, that can access the puddles in the pool. Your user, group, and login definitions for the users and groups that will access the pool should already be set up when SAS was installed. However, before you determine which identities and logins to use, do the following:

1. Review the access controls on the server. For more information, see “Permissions on Servers” in the SAS Intelligence Platform: Security Administration Guide.

2. Review access control for data on the server. The puddle login requires operating system access to any data sets that the server will retrieve.

For puddle access to the pool, there are two types of logins that you can define:

- a login that is used to launch the workspace server for the puddle users. All users of the puddle use this login when connecting to the SAS server. This login must be accessible to client-side pool administrators. (Pool users are not required to have access to this login).

- logins for the client-side pool administrator in the metadata configuration file that is used with the Windows Object Manager. Important Note: Do not specify an unrestricted user for the user ID of the client-side pool administrator.

Plan the Puddles for the Client-side Logical Pooled Server

To plan a client-side pooled logical server, you need to determine how many puddles you want to use and which groups will be used to access each of the puddles. When you convert the logical server to a client-side pooled logical server, you can then divide the pool into one or more puddles that associate the appropriate login definition and group metadata identity to use for access to the puddle. The login for each puddle is used to launch the server.

Note: Multiple puddles are not required. It is very common to have only a single puddle.

Determine the following parameters for each puddle that is associated with the client-side pooled logical server definition. Retain this information because you will need it later in “Convert a Logical Workspace Server to Client-side Pooling” on page 62.

Table 9.1 New Puddle Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of the puddle (for example, Puddle1).</td>
</tr>
<tr>
<td>Minimum available servers</td>
<td>Specifies the minimum number of servers that should be idle and available in the pool at any time. The number of running servers never exceeds the Maximum Clients value specified on the server. If the number of available servers falls below the value specified in this field, additional server connections are created.</td>
</tr>
<tr>
<td>Minimum number of servers</td>
<td>Specifies the minimum number of servers (both idle and active) that should be present in the pool at any time. This value also specifies how many servers should be started when the pool is first created.</td>
</tr>
</tbody>
</table>
Convert a Logical Workspace Server to Client-side Pooling

To convert your workspace server to client-side pooling and to define a puddle, follow these steps:

Note: You are setting up client-side pooling for a specified client and certain types of requests. This logical workspace server also supports standard workspace servers for other clients.

1. Log on to SAS Management Console as the SAS Administrator (sasadm@saspw).
2. In SAS Management Console, expand the Server Manager tree node and the node for the SASApp application server. One of the tree nodes under SASApp is SASApp - Logical Workspace Server.
3. Right-click the icon for the logical workspace server, and select Convert To Pooling. The Information dialog box asks if you want to continue with the conversion. Click Yes. The Pooling Options dialog box appears.
4. In the Pooling Options dialog box, click New to indicate that you want to define a puddle.

The New Puddle dialog box appears.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Specifies the user ID under which connections to the server are made. The SAS server only sees this login when a connection is made, rather than the user ID of the user who is actually using the pool. The menu on this field lets you select from the three most recently used logins or the More Logins option. Selecting More Logins displays the Login Search window, which you can use to search for a defined login.</td>
</tr>
<tr>
<td>Grant access to group</td>
<td>Specifies the logon group whose members are allowed to access the puddle. Users who are not members of the group are not allowed access. When a user requests a connection to a server pool, the software searches for a puddle whose access group contains that user. If you want to allow all users to access the system, you should change this value to PUBLIC. Note: If you do not want members of PUBLIC to be able to use SAS Web Report Studio and you want to present such users with a clear and user-friendly error message, follow these directions. First, set the value of the Grant Access To Group field to SASUSERS (to control access to the pool). Then, edit the properties file WEB-INF\WebReportStudioProperties.xml, and change the value of the wrs.pfs.allowPublicUsers element to false (to provide useful application-level feedback to members of PUBLIC).</td>
</tr>
</tbody>
</table>

Convert a Logical Workspace Server to Client-side Pooling

To convert your workspace server to client-side pooling and to define a puddle, follow these steps:

Note: You are setting up client-side pooling for a specified client and certain types of requests. This logical workspace server also supports standard workspace servers for other clients.

1. Log on to SAS Management Console as the SAS Administrator (sasadm@saspw).
2. In SAS Management Console, expand the Server Manager tree node and the node for the SASApp application server. One of the tree nodes under SASApp is SASApp - Logical Workspace Server.
3. Right-click the icon for the logical workspace server, and select Convert To Pooling. The Information dialog box asks if you want to continue with the conversion. Click Yes. The Pooling Options dialog box appears.
4. In the Pooling Options dialog box, click New to indicate that you want to define a puddle.

The New Puddle dialog box appears.
Configure Client-side Pooling

Configure Client-side Pooling Properties for Each Server

To set the configuration options for the client-side pool, follow these steps:

1. In SAS Management Console, expand the SASApp - Logical Workspace Server to reveal the icon for the workspace server.

2. Right-click the workspace server icon, and select Properties from the pop-up menu. A Workspace Server Properties dialog box appears.

3. In the Workspace Server Properties dialog box, select the Options tab.

   Note: If the workspace server is converted to use client-side pooling, information about this tab might not accurately reflect behavior for connections that use this server as a standard workspace server. For a logical workspace server that offers client-side pooling, the Options tab is disabled and always indicates that credential-based host authentication is configured. However, if you selected some other setting before configuring client-side pooling, that selection is persisted in metadata and is honored when the server is used as a standard workspace server. To avoid confusion, don't use a workspace server for both client-side pooling and standard use. Instead, if you choose to use client-side pooling, create a dedicated workspace server for that purpose, in a separate server context.

4. On the Options tab, click Advanced Options. The Advanced Options dialog box appears.

5. In the Advanced Options dialog box, select the Performance tab.
6 Fill the fields in the dialog box as shown in the preceding display. The following table explains the meaning of each value.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum clients</td>
<td>Each client requires a workspace server process on the workspace server host. These processes constitute the pool that will be available to SAS Web Report Studio and SAS Information Delivery Portal. Each process requires approximately 150 MB for efficient operation. As a guide, we recommend two processes per CPU. If the server is not also acting as the metadata server, you can add one or two to this maximum. If you have long-running queries, you can add one or two servers. This will make the system seem more responsive to short-running queries, at the expense of total throughput. A typical setting is between 8 and 10. Applications should not share the same pooled workspace configuration as this creates duplicate pools, one for each application, and an unexpectedly high workload for the server host.</td>
</tr>
<tr>
<td>Recycle activation limit</td>
<td>Places a limit on how often workspace server processes are reused to satisfy puddle connections.</td>
</tr>
<tr>
<td>Inactivity timeout</td>
<td>A workspace server process can have an inactivity timeout. Having a short timeout reduces the workload on the server host, but might reduce response time for client connection requests.</td>
</tr>
</tbody>
</table>

7 Click **OK** in the Advanced Options dialog box.

8 Click **OK** in the Workspace Server Properties dialog box.

---

**Setting Client-side Pooling Application Properties**

To turn on client-side pooling properties for SAS applications such as SAS Web Report Studio, the SAS Information Delivery Portal, and SAS BI Dashboard, follow these steps:

1 Using SAS Management Console, access the SAS Configuration Manager plug-in (Plug-ins ➤ Application Management ➤ Configuration Manager).

2 Make sure that client-side pooling is not locked at the application infrastructure level, by following these steps:

   a Expand the Configuration Manager icon, right-click on Application Infrastructure, and in the pop-up menu choose Properties.

   b In the Properties dialog box, choose the Settings tab.

   c In the right pane of the Settings tab, under Application ➤ Pooling, click the lock icon. It should toggle to an unlocked state, and then click **OK**.
3 In the left pane of the SAS Management Console under Configuration Manager, right-click on Web Report Studio 4.2, and in the pop-up menu choose Properties.

4 In the Properties dialog box, choose the Settings tab.

5 In the right pane of the Settings tab, under Application > Pooling, choose true from the drop-down list box.
Verify That Client-side Connection Pooling Is Working for SAS Web Report Studio

If you have not configured client-side connection pooling correctly, SAS Web Report Studio will continue to work. However, it will not be able to take advantage of a connection pool. Therefore, it is important that you verify that your system is configured correctly. You can verify this by temporarily changing the logging level for connections, viewing a SAS Web Report Studio report, and then checking the contents of the SAS Web Report Studio log file.

To verify that your system is configured correctly, follow these steps:

1. Using SAS Management Console, add a new logging context (com.sas.services.connections) and set its logging level to DEBUG.

   For more information, see “Configuring Logging for SAS Web Report Studio” in SAS Intelligence Platform: Web Application Administration Guide.


3. View a report that accesses relational data (for example, a SAS table).
4 View the SAS Web Report Studio log file (path-to-config-dir\Web\Logs\WebReportStudio.log). If pooling is working, you will see information that is similar to this message about the connection to the workspace server:

privileged user name: D9588\sastrust@saspw
pd#0: putting cx#8 on the available queue
rq#0 routed to pd#0

If pooling is not working correctly, you will see a message similar to this message:

request served by unshared connection #9

After you have confirmed that connection pooling is working, you can undo the changes that you made in step 1.

---

**Configure Client-side Pooling across Multiple Machines**

If your deployment requires more than one host for client-side pooled workspace servers, then you can configure client-side pooling across multiple machines.

An important aspect of multi-machine workspace client-side pooling involves the puddle login ID that you supplied in the topic “Convert a Logical Workspace Server to Client-side Pooling” on page 62. In order to implement multi-machine, client-side pooling, this login must be valid for all machines in the cluster.

This topic describes a basic configuration where the client-side pool has only one puddle. For this basic implementation, the account that you use for the login ID must be able to authenticate on every machine in the cluster. This means that the login ID must be a network account, and it must be associated with a single authentication domain in metadata (for example, NTDomain).

If you require a workspace client-side pool that consists of host servers in different authentication domains (for example, Windows and UNIX), then you can configure a pool with a separate puddle for each host. Each puddle has its own login ID as appropriate for the host’s authentication domain (for example, NTDomain or UnixAuth). Each login ID must be able to authenticate on every machine in its respective cluster. With this configuration, the pool manager software can identify which machine is used for a given process, based on the puddles that are defined for the pool, and it uses the appropriate login to make a connection.

The following instructions explain how to configure workspace client-side pooling across two machines in the same authentication domain, both supporting the same puddle. Repeat these instructions as appropriate for each additional machine that you want to configure for that same puddle.

*Note:* These instructions assume that you have already set up and verified client-side pooling on a single machine, as explained in the previous sections.

1. Log on to SAS Management Console as the SAS Administrator (sasadm@saspw).
2. If the puddle login ID is not accessible to all machines in the client-side pooling cluster, then you must create a new user. Follow these steps:
   a. On the host, identify or create a network account. For example, on Windows the user name might be NTDomain\myaccount. The user must authenticate against each machine in this cluster.
   
   If creating the account on Windows, grant the "Log on as a batch job" user right for the account on each Windows machine in the cluster.
b In the SAS Metadata Console User Manager plug-in, add a login to the SAS General Servers group with the user ID and password of the user that you just created.

This login should be associated with the server’s authentication domain (for example, DefaultAuth or ServerAuth), even if you are using middle-tier trusted authentication. The login is used to start processes on the server machine rather than to authenticate against the metadata server.

c Change the login ID that is used for the puddle to this newly established login ID. Make this change in the Edit puddle dialog box, which is accessed from the Logical Workspace Server Properties dialog box under the Server Manager plug-in. For details, see “Convert a Logical Workspace Server to Client-side Pooling” on page 62.

3 In the SAS Metadata Console Server Manager plug-in, add a pooled workspace server definition for the machine that you are adding to the client-side pool. Follow these steps:

a Expand the SASApp application server, then right-click Logical Workspace Server and select Add Server from the pop-up menu. The New Server Wizard appears.

b Specify the name for the new server that is being added to the client-side pool and click Next.

c Click New. In the Add New Machine dialog box, enter the name of the new machine where the server resides, and click OK.

d In the Available list, select the new machine.

e Click Advanced Options, and then select the Performance tab.

f On the Performance tab, set the client-side pooling options for this machine and then click OK. The maximum number of clients can vary for each server that is included in the pool, and should be configured based on the capacity of each physical server that is being used. For details, see “Configure Client-side Pooling Properties for Each Server” on page 63.

4 Click Next.

5 Click Next to accept the default authentication domain and port.

6 Review the information in the summary dialog box. If no changes are required, click Finish.

7 To define a new object spawner, in the Server Manager plug-in, follow these steps:

a Right-click the Server Manager and select New Server from the pop-up menu. The New Server Wizard appears.

b In the wizard, choose Object Spawner as the type of server, and then click Next.

c Provide information in the wizard as appropriate, by using these guidelines:

□ Select the host name that you are adding to the pool.

□ Select the newly created pooled workspace server as the server to be spawned by this object spawner.

□ Accept defaults for operator connection, ports, and authentication, unless you have implemented these differently.

8 Under SASApp, expand the logical pooled workspace server, and verify that both physical workspace servers appear under the logical client-side pooled workspace server.

9 Install the necessary SAS software on the machine that is being added to the pool. At a minimum, you should install Base SAS, the SAS Workspace Server, and the SAS Object Spawner. When configuring the object spawner, make sure that the object spawner can connect to the metadata server (running on another machine).
If the spawner cannot access the metadata server, then the object spawner cannot be started.

10 Verify that pooling works for SAS Web Report Studio.
   a Start the metadata server.
   b Start the object spawner on the machine that is being added to the pool.
   c Start or restart the middle-tier components.

   Note: Because the client-side pool administrator did not change, there is no need to change the middle-tier configuration. Recall that the pool administrator (typically sastrust@saspw) is used by the middle-tier application to process client-side pooling requests.

Depending on the puddle configuration and the maximum number of clients that are allowed for each server under the logical client-side pooled workspace server, the number of pooled workspace server processes that show up on each machine will vary.

For more information, see “Verify That Client-side Connection Pooling Is Working for SAS Web Report Studio” on page 66.

As mentioned earlier in this section, if you require a workspace client-side pool that consists of host servers in different authentication domains, then you can add more puddles to the pool. For each puddle, provide a login ID that is able to authenticate against all machines in the cluster.

The data sets that are accessed by the client-side pooled workspace server processes must either be replicated on each machine that will execute the pooled workspace server processes or accessed via a shared location that uses a common shared path—for example, a UNC or NFS path. For more information about putting the data in a shared location, see “Overview of Managing Data and Catalogs for Servers on Multiple Machines” on page 87. Alternatively, the workspace server processes can access data by using some other sharing mechanism, such as a SAS/CONNECT server. All LIBNAME assignments use the same path information, regardless of which physical machine the process runs on.

The object spawner process on the machine that has been added to the client-side pool cannot be started until the metadata server is running. If the object spawner is configured to run as a service that starts automatically, then this dependency cannot be enforced via the Windows services configuration.

---

### Configuring a Client-side Pooling Workspace Server to Enforce Row-Level Security

---

### About Row-Level Permissions Configuration

After the initial installation and configuration of the SAS Intelligence Platform, most sites have a single workspace server, which is part of the default SAS Application Server, SASApp. By default, this workspace server is a standard workspace server, which means that workspace server processes are spawned on an as-needed basis. If you need comprehensive security, set up the high-security configuration of SAS Web Report Studio. This configuration prevents regular users from circumventing row-level filters by accessing the target tables directly (without going through the information map that enforces the filters).
This section explains how to create a second client-side pooling workspace server that you can use as part of an environment in which row-level permissions are enforced. For more information about this environment, see “About BI Row-Level Permissions” in the SAS Intelligence Platform: Security Administration Guide.

---

### Defining the Necessary Users and Groups

The first step in setting up the new client-side pooling workspace server is to define two accounts for users who must be authenticated by the operating system on the workspace server host, and several user and group metadata objects.

#### User Accounts

Create user accounts that will enable the operating system on the workspace server host to authenticate the following users. On Windows systems, these accounts can be domain accounts or local accounts:

- **rpooladm** - This account is for the client-side pool administrator, the user who handles requests for processes in the workspace server client-side pool. The password for this account should be unique.
- **rpoolsrv** - This is the puddle login account. Each SAS Web Report Studio user who has access to the client-side pool must belong to a group that has a login that contains this user ID and the associated password.

On Windows systems, grant both of these users the **Log on as a batch job** right. If you created a SAS Server Users group when you first installed the SAS Intelligence Platform, you can give these users this right by adding them to that group.

Once you have created these user accounts, you should create the metadata objects described in the next section.

#### User and Group Objects

In SAS Management Console, use the User Manager to create one user and two groups:

- **User**: Restricted Client-side Pool Administrator
- **Group**: Restricted Client-side Pool Puddle Login
- **Group**: Restricted Client-side Pool Puddle Access

#### Define the Restricted Client-side Pool Administrator

To define the Restricted Client-side Pool Administrator, follow these steps:

1. Right-click **User Manager**, and select **New ➤ User** from the pop-up menu.
2. In the New User Properties dialog box, on the **General** tab, enter the name **Restricted Client-side Pool Administrator** in the **Name** box.
3. In the same dialog box, select the **Accounts** tab.
4. Add a login to the user object by selecting **New** and entering the appropriate information in the New Login Properties dialog box. In the **User ID** box, enter the name **rpooladm**. If the operating system account for this user is a Windows account, qualify the name with a domain or machine name and a backslash. Then select the authentication domain for your workspace server from the **Authentication Domain** drop-down list. It is preferable, for security reasons, not to put the password in the metadata. Click **OK** at the bottom of the dialog box.
5. Click **OK** in the New User Properties dialog box.
Define the Restricted Pool Puddle Login Group

To define the Restricted Pool Puddle Login group, follow these steps:

1. Right-click User Manager, and select New ▶ Group from the pop-up menu. A New Group Properties dialog box appears.

2. On the General tab, enter the name Restricted Client-side Pool Puddle Login in the Name box.

3. On the Members tab, select the Restricted Client-side Pool Administrator, and click the right-arrow button to move the user to the Current Members list.

4. On the Accounts tab, create a new login that contains the credentials for rpoolsrv and the authentication domain of the workspace server. (See step 4 in the “Define the Restricted Client-side Pool Administrator” on page 70 for details about how to create this login.)

5. Click OK in the New Group Properties dialog box.

Create a second group named Restricted Client-side Pool Puddle Access. Add any users or groups that you want to be able to use the restricted client-side pool as members of this group. No logins are necessary.

Create a Restricted Workspace Server Client-side Pool

To create the restricted client-side pooling workspace server, follow these steps:

1. In the directory SAS-configuration-directory\SASApp—or SASMain—create a directory called RestrictedPool. Then, in the RestrictedPool directory, create a logs directory.

2. In the directory SAS-configuration-directory\SASApp\RestrictedPool, create a configuration file that will be used when the restricted workspace server is started. The way in which you perform this step depends on whether the workspace server will run on a Windows host or a UNIX host.

   Windows
   
   In the directory SAS-configuration-directory\SASApp\RestrictedPool, create a file named sasv9.cfg, and enter the following lines in the file:

   \-config "SAS-configuration-directory\SASApp\sasv9.cfg"

   UNIX
   
   In the directory, SAS-configuration-directory/SASApp/RestrictedPool, create a file named workspaceServer.cfg, and enter the following lines in the file:

   \-config !SASROOT/sasv9.cfg
   \-config sasv9.cfg

   Later in the procedure, you will test the connection to the workspace server. If the test fails, you can remove the comments from the lines that relate to logging in order to enable logging. You can then repeat the test and check the workspace server log file for error messages.

3. Choose one of the following authentication methods for the workspace servers to use in connecting to the metadata server. Also, perform any tasks associated with the method that you choose.

   □ If you use the TRUSTSASPEER object server parameter in your metadata server’s configuration file (the default), then you can rely on that mechanism for workspace server authentication. The restricted pool workspace servers connect to the metadata server under the rpoolsrv identity when launched by SAS Web
Report Studio and connect under the end user's identity when launched by a
desktop application. In this mode, if you are working with an external DBMS,
you must ensure that both the Restricted Client-side Pool Puddle Login group
and any allowed individuals have database credentials.

You can also use the METAUSER and METAPASS options in the restricted
client-side pool workspace server's configuration file. With this approach, the
TRUSTRASPEER option is not required, and only the Restricted Client-side
Pool Puddle Login group needs database credentials. For this approach, edit the
configuration file that you created in step 2 to add these lines:

- metauser "rpoolsrv"
- metapass "encrypted-rpoolsrv-password"

On Windows systems, be sure to prepend a domain or host-name qualifier to the
user ID. You can encrypt the password using PROC PWENCOD.

Note: The configuration file for the restricted workspace server must be locked
down at the operating system level. The client-side pool administrator launches
workspace servers under an operating system user ID of rpoolsrv. Workspace
servers executed against this pool (such as those that are run by the SAS
Information Map Studio test dialog box) run under the end-user ID.

Remember to change this configuration file if site policy requires periodic
changes on service accounts.

4 In SAS Management Console, define a new SAS Application Server, named
RestrictedPool, that contains a workspace server.

a Right-click Server Manager, and select New Server from the pop-up menu.
The New Server Wizard starts.

b On the wizard's first page, select SAS Application Server and click Next.

c On the wizard's second page, enter the name RestrictedPool in the Name box
and click Next.

d On the wizard's third page, accept the default values and click Next.

e On the wizard's fourth page, select Workspace Server and click Next.

f On the wizard's fifth page, select the Custom radio button and click Next.

g On the wizard's sixth page, enter the following values in the Command and
Object server parameters boxes. The first command is appropriate for a
workspace server that is running on a Windows host, and the second is
appropriate for a UNIX host. The value that you enter in the Object server
parameters field is not dependent on the operating system.

Command (Windows) sas -config "SAS-configuration-directory\SASApp\RestrictedPool\sasv9.cfg"

Command (UNIX) SAS-configuration-directory/SASApp/sas.sh -config RestrictedPool/workspaceServer.cfg

Then click Next.

h On the wizard's seventh page, specify the following values.

Authentication domain Specify the same authentication domain that you used when
you defined your first workspace server. By default, this will be DefaultAuth.

Bridge port Change the default value, 8591, to the number of an unassigned port, such as 9591.

i On the wizard's eighth page, click Finish.

5 Update the metadata definition of your object spawner to indicate that the
spawner should start processes for the new workspace server.
Configuring Client-side Pooling

Assign Libraries to the New Server

You must assign each library that you plan to access from the locked-down instance of SAS Web Report Studio to the server RestrictedPool. To assign each library, follow these steps:

1. Right-click the icon that represents the spawner, and select Properties from the pop-up menu. A Spawner Properties dialog box appears.
2. Select the Servers tab.
3. Move RestrictedPool - Workspace Server from the list of Available servers to the list of Selected servers.
4. Click OK.
5. Restart your object spawner.
6. Test the connection to your new workspace server.
   a. In the left pane of SAS Management Console, select RestrictedPool - Workspace Server. Information about a connection displays in the right pane.
   b. Right-click the icon representing the connection, and select Test Connection from the pop-up menu.
   c. If you are logged in to SAS Management Console as an unrestricted user, such as sasadm@saspw, you will be prompted for the credentials of a user who can start a workspace server. Enter the credentials for a user such as sasdemo. You should see a message indicating that the test was successful.

   Note: If you happen to enter invalid credentials for a login, clear the credentials cache and the SAS Management Console will prompt you again to re-enter the credentials (File ▶ Clear Credentials Cache.)

   If the connection test fails, look at the log files for the object spawner and the new workspace server. The most likely cause of the problem is that you made a mistake in editing the configuration file for the new workspace server—the configuration file in the RestrictedPool directory.
7. Convert the new workspace server to client-side pooling.
   a. Right-click RestrictedPool - Logical Workspace Server, and select Convert To Pooling from the pop-up menu.
   b. You are asked whether you want to continue. Click Yes. The Pooling Options dialog box appears.
   c. In this dialog box, click New to bring up the New Puddle dialog box.
   d. In the New Puddle dialog box, supply the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>restrictedPoolPuddle</td>
</tr>
<tr>
<td>Minimum available server</td>
<td>0</td>
</tr>
<tr>
<td>Minimum number of servers</td>
<td>0</td>
</tr>
<tr>
<td>Login</td>
<td>rpoolsv</td>
</tr>
<tr>
<td>Grant access to group</td>
<td>Restricted Pool Puddle Access</td>
</tr>
</tbody>
</table>

   Then click OK.
   e. Click OK in the Pooling Options dialog box.

Assign Libraries to the New Server

You must assign each library that you plan to access from the locked-down instance of SAS Web Report Studio to the server RestrictedPool. To assign each library, follow these steps:

1. Right-click the icon that represents the spawner, and select Properties from the pop-up menu. A Spawner Properties dialog box appears.
2. Select the Servers tab.
3. Move RestrictedPool - Workspace Server from the list of Available servers to the list of Selected servers.
4. Click OK.
5. Restart your object spawner.
6. Test the connection to your new workspace server.
   a. In the left pane of SAS Management Console, select RestrictedPool - Workspace Server. Information about a connection displays in the right pane.
   b. Right-click the icon representing the connection, and select Test Connection from the pop-up menu.
   c. If you are logged in to SAS Management Console as an unrestricted user, such as sasadm@saspw, you will be prompted for the credentials of a user who can start a workspace server. Enter the credentials for a user such as sasdemo. You should see a message indicating that the test was successful.

   Note: If you happen to enter invalid credentials for a login, clear the credentials cache and the SAS Management Console will prompt you again to re-enter the credentials (File ▶ Clear Credentials Cache.)

   If the connection test fails, look at the log files for the object spawner and the new workspace server. The most likely cause of the problem is that you made a mistake in editing the configuration file for the new workspace server—the configuration file in the RestrictedPool directory.
7. Convert the new workspace server to client-side pooling.
   a. Right-click RestrictedPool - Logical Workspace Server, and select Convert To Pooling from the pop-up menu.
   b. You are asked whether you want to continue. Click Yes. The Pooling Options dialog box appears.
   c. In this dialog box, click New to bring up the New Puddle dialog box.
   d. In the New Puddle dialog box, supply the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>restrictedPoolPuddle</td>
</tr>
<tr>
<td>Minimum available server</td>
<td>0</td>
</tr>
<tr>
<td>Minimum number of servers</td>
<td>0</td>
</tr>
<tr>
<td>Login</td>
<td>rpoolsv</td>
</tr>
<tr>
<td>Grant access to group</td>
<td>Restricted Pool Puddle Access</td>
</tr>
</tbody>
</table>

   Then click OK.
   e. Click OK in the Pooling Options dialog box.

Assign Libraries to the New Server

You must assign each library that you plan to access from the locked-down instance of SAS Web Report Studio to the server RestrictedPool. To assign each library, follow these steps:

1. Right-click the icon that represents the spawner, and select Properties from the pop-up menu. A Spawner Properties dialog box appears.
2. Select the Servers tab.
3. Move RestrictedPool - Workspace Server from the list of Available servers to the list of Selected servers.
4. Click OK.
5. Restart your object spawner.
6. Test the connection to your new workspace server.
   a. In the left pane of SAS Management Console, select RestrictedPool - Workspace Server. Information about a connection displays in the right pane.
   b. Right-click the icon representing the connection, and select Test Connection from the pop-up menu.
   c. If you are logged in to SAS Management Console as an unrestricted user, such as sasadm@saspw, you will be prompted for the credentials of a user who can start a workspace server. Enter the credentials for a user such as sasdemo. You should see a message indicating that the test was successful.

   Note: If you happen to enter invalid credentials for a login, clear the credentials cache and the SAS Management Console will prompt you again to re-enter the credentials (File ▶ Clear Credentials Cache.)

   If the connection test fails, look at the log files for the object spawner and the new workspace server. The most likely cause of the problem is that you made a mistake in editing the configuration file for the new workspace server—the configuration file in the RestrictedPool directory.
7. Convert the new workspace server to client-side pooling.
   a. Right-click RestrictedPool - Logical Workspace Server, and select Convert To Pooling from the pop-up menu.
   b. You are asked whether you want to continue. Click Yes. The Pooling Options dialog box appears.
   c. In this dialog box, click New to bring up the New Puddle dialog box.
   d. In the New Puddle dialog box, supply the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>restrictedPoolPuddle</td>
</tr>
<tr>
<td>Minimum available server</td>
<td>0</td>
</tr>
<tr>
<td>Minimum number of servers</td>
<td>0</td>
</tr>
<tr>
<td>Login</td>
<td>rpoolsv</td>
</tr>
<tr>
<td>Grant access to group</td>
<td>Restricted Pool Puddle Access</td>
</tr>
</tbody>
</table>

   Then click OK.
   e. Click OK in the Pooling Options dialog box.

Assign Libraries to the New Server

You must assign each library that you plan to access from the locked-down instance of SAS Web Report Studio to the server RestrictedPool. To assign each library, follow these steps:

1. Right-click the icon that represents the spawner, and select Properties from the pop-up menu. A Spawner Properties dialog box appears.
2. Select the Servers tab.
3. Move RestrictedPool - Workspace Server from the list of Available servers to the list of Selected servers.
4. Click OK.
5. Restart your object spawner.
6. Test the connection to your new workspace server.
   a. In the left pane of SAS Management Console, select RestrictedPool - Workspace Server. Information about a connection displays in the right pane.
   b. Right-click the icon representing the connection, and select Test Connection from the pop-up menu.
   c. If you are logged in to SAS Management Console as an unrestricted user, such as sasadm@saspw, you will be prompted for the credentials of a user who can start a workspace server. Enter the credentials for a user such as sasdemo. You should see a message indicating that the test was successful.

   Note: If you happen to enter invalid credentials for a login, clear the credentials cache and the SAS Management Console will prompt you again to re-enter the credentials (File ▶ Clear Credentials Cache.)

   If the connection test fails, look at the log files for the object spawner and the new workspace server. The most likely cause of the problem is that you made a mistake in editing the configuration file for the new workspace server—the configuration file in the RestrictedPool directory.
7. Convert the new workspace server to client-side pooling.
   a. Right-click RestrictedPool - Logical Workspace Server, and select Convert To Pooling from the pop-up menu.
   b. You are asked whether you want to continue. Click Yes. The Pooling Options dialog box appears.
   c. In this dialog box, click New to bring up the New Puddle dialog box.
   d. In the New Puddle dialog box, supply the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>restrictedPoolPuddle</td>
</tr>
<tr>
<td>Minimum available server</td>
<td>0</td>
</tr>
<tr>
<td>Minimum number of servers</td>
<td>0</td>
</tr>
<tr>
<td>Login</td>
<td>rpoolsv</td>
</tr>
<tr>
<td>Grant access to group</td>
<td>Restricted Pool Puddle Access</td>
</tr>
</tbody>
</table>

   Then click OK.
   e. Click OK in the Pooling Options dialog box.
Right-click the icon for the library, and select Edit Assignments from the pop-up menu. The Edit Assignments dialog box appears.

2 Hold down the CTRL key and click the list entry for RestrictedPool. (This action selects RestrictedPool and leaves items that are already selected in a selected state.) Then click OK.

3 Right-click the library again, and select Properties from the pop-up menu. The Library-name Properties dialog box appears.

4 Select the Options tab.

5 Click the Advanced Options button. The Advanced Options dialog box appears.

6 Select the Library is pre-assigned option, and click OK.

7 Click OK in the properties dialog box.

In the future, when you create information maps that you want to access from the locked-down instance of SAS Web Report Studio, make sure that you locate relational data sources by using the RestrictedPool server. Also, save these maps in a separate folder: /BIP Tree/ReportStudio/RestrictedData/Maps.

Create a Second SAS Web Report Studio Deployment

When you deploy SAS, the SAS Deployment Wizard creates an initial SAS Web Report Studio deployment using the inputs that you supply. Later, you can re-run the SAS Deployment Wizard to create additional deployments. For more information, see “Install and Configure SAS Interactively” in the SAS Intelligence Platform: Installation and Configuration Guide.

Follow these guidelines when running the SAS Deployment Wizard to add another SAS Web Report Studio deployment:

- Use a deployment plan that contains the SAS middle tier.
- Choose the Custom configuration prompting level. You want to be able to access the configuration dialog box where you can set the SAS Metadata Server and the SAS Web Report Studio deployment instance name. The Express prompt level does not allow you to access these configuration settings.
- Define the SAS Metadata Server connection information for the metadata server that you are currently using.
- Use the correct machine name on which you are adding the SAS Web Report Studio deployment.
- Name the second SAS Web Report Studio deployment instance, RestrictedDataReporting.

Secure Sensitive Data Resources

Ensure that sensitive data resources are readable only by rpoolsrv (not sassrv) and the IT staff.

For target data that is in third-party databases, set up credentials in the metadata to enable the puddle account to access those servers. You can make credentials for a database server available to the puddle account by storing those credentials in a login as part of the Restricted Puddle Access group definition.

For example, to enable the puddle account to access a DB2 server, you would give the Restricted Puddle Access group a login that includes a DB2 user ID and password and that is associated with the DB2 server's authentication domain.

Note: Some members of your IT staff will also need to be able to authenticate to the database server.
PART 4

Server Administration

Chapter 10. Managing SAS Application Servers 77
Chapter 11. Managing Workspace Servers and Stored Process Servers 87
Chapter 12. Managing the Object Spawner 99
Chapter 13. Administering SAS OLAP Servers 117
Chapter 14. System Options for SAS Application Server Components 131
CHAPTER

10

Managing SAS Application Servers

Defining Multiple Application Servers 77
Add an Additional SAS Application Server 77
Scenario 1: Using SAS Data Integration Studio to Access Remote Data 78
Scenario 2: Using Multiple Application Servers with SAS Web Report Studio 79
Add a New Logical Server in an Existing SAS Application Server 80
Adding a New Server in an Existing Logical Server 81
Overview of Adding a New Server in an Existing Logical Server 81
Add a New Server in an Existing Logical Server 81
Modify a Server Definition 84
Remove Logical Servers 84

Defining Multiple Application Servers

Add an Additional SAS Application Server

When you deploy SAS, the SAS Deployment Wizard creates an initial SAS Application Server using the inputs that you supply. Later, you can re-run the SAS Deployment Wizard to create additional application servers on new machines. For more information, see “Adding SAS Products” in SAS Intelligence Platform: Installation and Configuration Guide.

Follow these guidelines when running the SAS Deployment Wizard to add a new SAS application server:

- The machine on which you want to add the new logical server should have a network connection to your site’s SAS Software Depot. If it does not, then you must find a way to get the depot to the machine on which you want to create the new SAS application server.

  For more information, see “Overview: SAS Software Depots” in SAS Intelligence Platform: Installation and Configuration Guide.

- Use your deployment plan that contains the SAS application server.

  Note: There are standard deployment plans that contain a SAS application server machine. For more information, see “About Deployment Plans” in SAS Intelligence Platform: Installation and Configuration Guide.

- If you are adding logical servers that require an object spawner (one of the workspace servers and the stored process server), then when you deploy your SAS application server, the wizard will also deploy an object spawner to start the servers. If the machine on which you are adding the SAS application server
already contains an object spawner, then the wizard will update the pre-existing spawner definition for you to include the new servers that you want your spawner to manage.

- Specify a new server context (for example, SASApp2).
- Obtain the SAS Metadata Server connection information for the metadata server that you are currently using. The wizard will prompt you for this information.
- Specify the correct machine name on which you are adding the SAS application server.

There are several reasons why you might want to create a second application server. A couple of these reasons are discussed in the following sections.

---

**Scenario 1: Using SAS Data Integration Studio to Access Remote Data**

Imagine that you are using SAS Data Integration Studio to process a large amount of data that resides on a machine different from the workspace server to which the application submits its code, as shown in the following figure.

![Figure 10.1 Application Server and Data on Different Machines](image)

One way to execute such a job efficiently is to define two application servers. One is the default application server for SAS Data Integration Studio and contains the workspace server to which the application will submit its generated code. The other application server contains a SAS/CONNECT server (which is collocated with the data), and the library of data to be processed is assigned to this application server. See the following figure.
If you choose for the transformations in the job to be executed on the remote host, then SAS Data Integration Studio generates the code that is necessary for the transformations to be executed by the SAS/CONNECT server. The overall job is submitted to the workspace server. However, the workspace server then submits the code for each transformation to the remote server.

The generation of this type of code is made possible by the definitions of the two application servers, one of which is the default application server for SAS Data Integration Studio and the other the application server to which the data library is assigned.

*Note:* For more information, see “Setting Up Multi-Tier Environments” in SAS Intelligence Platform: Desktop Application Administration Guide.

### Scenario 2: Using Multiple Application Servers with SAS Web Report Studio

Suppose that you want to create an environment in which row-level security can be strictly enforced for a set of SAS Web Report Studio users. (For a detailed description of this feature, see “BI Row-Level Permissions” in SAS Intelligence Platform: Security Administration Guide.)

Part of the setup is to create a special workspace server for use by the report creators who need the secure environment. This special workspace server is a component of a new SAS Application Server. See the following figure.
Add a New Logical Server in an Existing SAS Application Server

A SAS Application Server can contain one of each of the following logical servers: workspace, stored process, OLAP, grid, CONNECT, batch, or metadata. Each logical server type must have at least one server defined.

Using the SAS Deployment Wizard, you can add a new logical server to a pre-existing SAS application server. For more information, see “Adding SAS Products” in SAS Intelligence Platform: Installation and Configuration Guide.

Follow these guidelines when running the SAS Deployment Wizard to add a logical server to an existing SAS application server:

- The machine on which you want to add the new logical server should have a network connection to your site’s SAS Software Depot. If it does not, then you must find a way to get the depot to the machine on which you want to create the new logical server.

  For more information, see “Overview: SAS Software Depots” in SAS Intelligence Platform: Installation and Configuration Guide.

- Use your deployment plan that contains the server component that you are adding.

  Note: There are standard deployment plans that contain a SAS application server machine. For more information, see “About Deployment Plans” in SAS Intelligence Platform: System Administration Guide.

- Choose Configure SAS Software and uncheck Install SAS Software, unless you know that the server you are adding was never installed before.

- Specify the server context to match the name of your current SAS Application Server (for example, SASApp).

The original workspace server can service users of other applications and users of SAS Web Report Studio whose access to data does not need to be so closely controlled.
Adding a New Server in an Existing Logical Server

Overview of Adding a New Server in an Existing Logical Server

Defining a new server in an existing logical server, consists of:

1. Installing the new server software on the new machine with the SAS Deployment Wizard.
2. If you are installing a server that requires an object spawner and there isn’t already a spawner on the new machine, then when you install the server, you will also install and configure the object spawner.
3. Copying the necessary configuration directories from the existing logical server machine to the new machine.
4. Using the SAS Management Console to define the new servers in the metadata repository.

Add a New Server in an Existing Logical Server

You might decide that you need add another server in your logical server. The most common scenario is that you want to establish a server cluster to achieve load balancing. If you are adding one of the workspace servers or a stored process server then you will also need to add an object spawner to manage it, unless there is already a spawner on the machine. Follow these steps to add a new server and—if necessary—an object spawner to an existing logical server:

1. The machine on which you want to add the new server should have a network connection to your site’s SAS Software Depot. If it does not, then you must find a way to get the depot to the machine on which you want to create the new server.

   For more information, see “Overview: SAS Software Depots” in SAS Intelligence Platform: Installation and Configuration Guide.

2. Make sure that you have first installed the new server on the new machine by referring to “Adding SAS Products” in SAS Intelligence Platform: Installation and Configuration Guide. When installing the new server, follow these guidelines:
   a. If you are installing one of the workspace servers or a stored process server, then you will also need an object spawner to be on the new machine. Do one of the following:
   b. If you:
      □ Need an object spawner:
         then when installing the new server with the SAS Deployment Wizard, make sure that you choose both Install SAS Software and Configure SAS Software.
Don't need an object spawner:
then when installing the new server with the SAS Deployment
Wizard, make sure that you choose **Install SAS Software** and **deselect Configure SAS Software**.

When you see the wizard's Specify Configuration Information dialog box, make sure that the configuration directory you enter matches the SAS configuration directory on the machine that contains the pre-existing SAS application server. For example, `C:\SAS\Config`.

When you see the wizard's Select Products to Configure dialog box, check **SAS Object Spawner only**. Server configuration is described in later steps in this topic.
3 Create a configuration path on the new machine that matches the configuration path on the pre-existing machine. For example, if the configuration path on machine 1 is `C:\SAS\Config\Lev1`, then create the same path on machine 2.

4 Copy the configuration directories of the pre-existing SAS application server to the new machine. For example, on Windows, copy the following directory from machine 1 to machine 2:

`C:\SAS\Config\Lev1\SASApp`

5 Copy the configuration directories of any pre-existing logical servers to which you are adding additional servers, to the new machine.

For example, if you are adding another workspace server, copy the following directory from machine 1 to machine 2:

`C:\SAS\Config\Lev1\SASApp\WorkspaceServer`

6 Start SAS Management Console and connect to a metadata repository.

7 In the SAS Management Console navigation tree, select and expand the Server Manager, and locate the SAS application server under which you want to add the new server.

8 Expand the SAS application server and locate the logical server under which you want to add the new server.

   Note: The logical server must be the same type of server as the server that you are adding. If there is no logical server, go to the following topic, “Add a New Logical Server in an Existing SAS Application Server” on page 80. △

9 With the logical server selected, choose Actions ► Add Server from the menu bar.

   The New Server Wizard displays.

10 Enter a name (required) and a description (optional) for the new server. The server name should indicate the machine, server type, and unique port on the new machine for the server. When you are finished, click Next.
The name you provide will be the name of the server that displays in the SAS Management Console Server Manager plug-in.

11 Specify whatever configuration information is required for the type of server that you are adding. The number of wizard pages you see and the information that you must supply, varies depending on the server type. Use the wizard online Help if necessary. For information about object server parameters, see “OBJECTSERVERPARMS System Option” on page 134.

**Note:** To avoid a configuration error and failed client connections, you must enter user credentials when defining a pooled workspace and a stored process server. △

12 When you see a wizard page that states that you have successfully completed a new server definition, review the information supplied and do one of the following:

- click **Finish** to add the new server and close the New Server Wizard.
- click **Back** to go to an earlier wizard page to change an input.

---

**Modify a Server Definition**

Using the SAS Management Console you can modify the properties definition for a logical server or a server component. Examples of server properties are: the command used to start the server, load-balancing settings, and so on. For information about object server parameters, see “OBJECTSERVERPARMS System Option” on page 134.

Follow these steps to modify a server definition:

1. Start SAS Management Console and connect to a metadata repository.
2. In the SAS Management Console navigation tree, expand the Server Manager to find the server object that you want to modify.
3. Select the server object, and then select **File ▶ Properties** from the menu bar.
4. Select the appropriate tabs, and enter the necessary changes.

   For a description of the server definition fields, see the SAS Management Console online Help.

5. When you are finished, click **OK** to return to the SAS Management Console main window.

6. If you changed any authorization permission on a workspace server, a pooled workspace server, or a stored process server, restart the object spawner.

   For more information, see “Operating Your Servers” in *SAS Intelligence Platform: System Administration Guide*. △

---

**Remove Logical Servers**

Using the SAS Deployment Manager you can remove a logical server from a SAS application server.

**Note:** Removing logical servers on which libraries are dependent can prevent SAS applications from accessing data required for jobs, reports, and so on. △

Follow these steps to remove a logical server definition:

**Note:** These steps attempt to summarize how to remove a logical server. For more detailed information, refer to “Removing a SAS Configuration” in *SAS Intelligence Platform: Installation and Configuration Guide*. △
1 On the host machine for the components whose configurations you are removing, navigate to `SAS-installation-directory\SASDeploymentManager\9.2` and launch `config.exe` (on Windows systems) or `config.sh` (on UNIX and z/OS systems).

2 In SAS Deployment Manager, on the Select Configuration Task dialog box, choose **Remove Existing Configuration**.

3 On the next dialog box, choose the configuration directory and level that you want to modify.

4 On the Connection Information dialog box, specify a set of valid credentials for an unrestricted administrative user to connect to the metadata server.

5 On the Select Product Configurations dialog box, choose one or more logical servers that you want to remove from the SAS application server.

6 On the Summary dialog box, a list of the logical servers that you want to remove or unconfigure is listed. Do one of the following:
   - click **Start**—
     This causes the deployment manager to remove the specified logical servers.
   - click **Back**—
     Go back to an earlier dialog box to change a selection.

7 When the deployment manager has completed removing the logical server, click **Finish**.

8 If you removed a logical workspace server, a logical pooled workspace server, or a logical stored process server, restart the object spawner.

   For more information, see “Operating Your Servers” in *SAS Intelligence Platform: System Administration Guide*.
Managing Data and Catalogs for Servers on Multiple Machines

Overview of Managing Data and Catalogs for Servers on Multiple Machines
Update SAS Libraries
Update References to User-Defined Formats
Access Data in Database Management Systems
Adding or Modifying E-Mail Settings for SAS Application Servers
Overview of Adding or Modifying E-Mail Settings for SAS Application Servers
Add or Modify E-Mail Settings for SAS Application Servers
Moving Workspace Servers and Stored Process Servers
Overview of Moving Workspace Servers and Stored Process Servers
Move Workspace Servers and Stored Process Servers
Required Tasks after You Move Workspace Servers and Stored Process Servers
Encoding and Locale Information
Adding Environment Variables to Server Invocations
Changing SAS Options with the Stored Process Server
Overview of Changing SAS Options with the Stored Process Server
Change SAS Options with the Stored Process Server
Workspace Server Configuration Tasks
Tune Workspace Servers for Best Performance
Configure Workspace Servers for a Locale
Add System Options to the Workspace Server Launch Command
Configure Storage for Temporary OLAP Cube Build Files on SAS Workspace Servers
Clean Up Temporary Files After Abnormal OLAP Server Shutdowns

Managing Data and Catalogs for Servers on Multiple Machines

Overview of Managing Data and Catalogs for Servers on Multiple Machines

After placing load-balanced servers on multiple machines, you need to ensure that the new server can access the data, and possibly format catalogs, that the original server was working with. For example, suppose that your original server was using a library of SAS data sets and that the metadata object that represents the library contains the path `C:\SAS\configuration-directory\SASApp\Data`. Your new server will not be able to access this library at its original location. One possible solution to this problem is to move a copy of the data to the new server and place it at the location that is stored in the library metadata object. However, this strategy might introduce
data-synchronization problems. A preferable solution is to make sure that both servers can access a single copy of the data by providing a network path to the library.

---

**Update SAS Libraries**

As mentioned previously, when you scale your system, you need to update any SAS libraries that are being referenced with a local path. To update the definition of a library on a Windows machine that currently contains the path `C:\SAS\configuration-directory\SASApp\Data`, follow these steps:

1. In SAS Management Console, expand the **Data Library Manager** and the **SAS Libraries** folder so that you see the icon that represents your SAS library.
2. Right-click the library and select **Properties** from the pop-up menu that appears. A properties dialog box appears.
3. In the properties dialog box, select the **Options** tab.
4. Deselect the path that is currently selected by highlighting it in the **Selected items** list and clicking the left-arrow button.
5. Create a new path, and select it, by following these steps:
   a. Click the **New** button to bring up the New Path Specification dialog box.
   b. In the **Name** text box, enter the Universal Naming Convention (UNC) path to the library—for example, `\D1234\SAS\Config\Lev1\SASApp\Data`. (Different machines on the LAN can use this same path to access the library.)
   c. Click **OK**.
6. Click **OK** in the properties dialog box.

---

**Update References to User-Defined Formats**

Like SAS data sets, existing user-defined format catalogs might be available only to servers that run on your original SAS server host. It is common for a server to look for such catalogs in the configuration directory on the original server host in the directory `configuration-directory\SASApp\SASEnvironment\SASFormats`. It is also possible to specify the location of the catalog in a configuration file, as explained in “Establishing Connectivity to a Library of SAS Data Sets” in the “Connecting to Common Data Sources” chapter of the **SAS Intelligence Platform: Data Administration Guide**. However, the path recorded in such a file is often a local path.

One solution to this problem is to replicate the catalog on all server hosts, but this can be less than ideal if the catalog is subject to change. A better solution is to specify the location of the catalog in `configuration-directory\SASApp\sasv9.cfg` and to make sure that the path to catalog is a network path. For example, you might change

```
-set fmtlib1 "C:\SAS\configuration-directory\SASApp\Data\orformat"
-fmtsearch (fmtlib1.orionfmt)
```

to:

```
-set fmtlib1 "\\D1234\SAS\configuration-directory\SASApp\Data\orformat"
-fmtsearch (fmtlib1.orionfmt)
```

---

**Access Data in Database Management Systems**

If your new workspace or stored-process server needs to access data in a database management system (DBMS), then you might need to do some administrative work on the new server host before such access is possible. For example, you might need to:
Install a SAS/ACCESS product
install database client software
install a database driver
configure a data source name

The simplest way to explain this is that you need to repeat whatever steps you took on the original SAS server host on the newly added server.

---

**Overview of Adding or Modifying E-Mail Settings for SAS Application Servers**

At installation time, the SAS Deployment Wizard prompts you for an e-mail server. This server is used by the SAS Metadata Server to send e-mail alerts to an administrator if journaling issues arise. The SAS Deployment Wizard also uses this e-mail server as the default for the SAS Application Server to provide e-mail services to various SAS clients. For example, with Data Integration Studio, you can use a Publish to Email transformation to alert users about various data changes. In order for SAS BI Dashboard to send alerts by e-mail to dashboard users and administrators, the port and host name must be configured for the e-mail server.

---

**Add or Modify E-Mail Settings for SAS Application Servers**

To change the application server e-mail server settings, follow these steps:

1. As a user with administrative privileges, log on to the SAS Application Server machine.
2. Using a text editor, open the application server configuration file.
   
   By default the configuration file resides here:
   
   - Windows:
     
     `SAS-configuration-directory\Lev\SASApp\sasv9_usermods.cfg`
   
   - UNIX and z/OS:
     
     `SAS-configuration-directory/Lev\SASApp/sasv9_usermods.cfg`
   
3. Do one of the following:
   
   - add e-mail settings:
     
     add the following e-mail options: `-emailsys`, `-emailhost`, and `-emailport`, and save the file.

     For more information, see the e-mail options in “SAS System Options” in *SAS Language Reference: Dictionary*.
   
   - modify e-mail settings:
     
     Locate the e-mail options (`-emailsys`, `-emailhost`, and `-emailport`), make the necessary changes, and save the file.

     For more information, see the e-mail options in “SAS System Options” in *SAS Language Reference: Dictionary*. 
The e-mail changes will take effect the next time the SAS application requests an e-mail service from the application server.

### Moving Workspace Servers and Stored Process Servers

#### Overview of Moving Workspace Servers and Stored Process Servers

If you have installed a workspace server, pooled workspace server, or a stored process server on a machine separate from other SAS servers, you can use the instructions in the following topics to move the server to a new machine.

**Note:** If you are moving a server to a different machine, then the Update Host Name References feature of the SAS Deployment Manager might be useful. For more information, see “Using the SAS Deployment Manager to Update Host Name References” in the *SAS Intelligence Platform: System Administration Guide*.

In addition to changing the machine name (and port number), if you move a server to a machine with a different operating system or to a machine with an operating system other than Windows, you might need to reconfigure the following:

- **accounts for authentication.** You might need to define accounts on the authentication provider for the new server machine.
- **metadata on the SAS Metadata Server.** The following metadata definitions might require reconfiguration or additional configuration:
  - server definition. On the server definition, you might need to use the Server Manager plug-in to SAS Management Console to change the following parameters:
    - **SAS startup command.** You might need to change the startup command for the new operating system.
    - **authentication domain.** When you move a server, you might need to set up an additional authentication domain.
  - login definitions. For the login definitions that access the server and the login definitions that are used in the load-balancing configuration (for example, the SAS Guest user’s login, if you performed an Advanced or Personal installation), you might need to use the User Manager plug-in to SAS Management Console to do one or more of the following:
    - define a new login definition. When you move a server, you might need to create a new login definition for the new authentication domain.
    - define a new login definition for a different authentication process. When you move a server, you might need to create a new login definition with credentials to access a server in a different operating system within the default authentication domain.
    - change the format of the user ID in the login definition. When you move a server, you might need to change the fully qualified user ID for any login credentials used to access that server.
  - stored process definitions. You might need to use SAS Management Console to specify a new location for your source code repository.
- **spawner startup command.** If you change operating systems when you move machines, you might need to change the spawner startup command.
Move Workspace Servers and Stored Process Servers

To move a workspace, pooled workspace, or stored process server to a different machine, follow these steps:

1. Use SAS Management Console to reconfigure the server definition for the new machine:
   a. In SAS Management Console, expand the Server Manager to locate the server definition for the specified server.
   b. Right-click the icon for the server, and select Properties from the pop-up menu. A properties dialog box displays.
   c. For each new server, follow these steps:
      i. Click the New button. The Add New Machine dialog box displays.
      ii. In the Host name field, change the name to the host name of the new machine for your server, and then click OK. The new host name should display in the list of available servers.
      iii. If the server is no longer to be used on a machine, remove it from the Selected list. (Click the server name, and then click the left-pointing arrow button.)
      iv. If you need to change the server startup command or add any object server parameters, make your changes in the appropriate fields. For more information, see SAS Management Console online Help and “OBJECTSERVERPARMS System Option” on page 134.
      v. Click OK to save the new configuration to the metadata repository.
   d. Click OK to save the new configuration to the metadata repository.

2. Use SAS Management Console to reconfigure the spawner definition for the new machine:
   a. In the SAS Management Console navigation tree, locate and select the spawner definition, then right-click and select Properties from the pop-up menu.
   b. If your spawner name contains the machine name, change the Name field to specify the name of the new machine.
   c. Select the Options tab.
   d. In the Available list, click the name of the new machine for your server, and then click the right-pointing arrow. The new machine name should display in the Selected list.
   e. If the server is no longer to be used on a machine, remove it from the Selected list. (Click the server name, and then click the left-pointing arrow button.)
If you have any other servers associated with the spawner, select the Servers tab. In the Selected servers list box, select the other servers and move them to the Available servers list box. Click OK. You must then define a new spawner for these servers.

Click OK to save the new configuration to the metadata repository.

If you need to change the authentication domain or the spawner operation connection port that the new server uses, continue with the next step. Otherwise, skip to step 3.

Click the icon for the spawner definition, and in the SAS Management Console’s right pane, select the Connections tab.

On the Connections tab, right-click the connection entry for the spawner, and select Properties from the pop-up menu. A connections properties dialog box displays.

Click the Options tab. In the Port field, enter the port that you want the connection to use.

If you changed the server’s authentication domain, select the same new Authentication domain field for your spawner.

Click OK to save the new configuration to the metadata repository.

Edit the policy files for any applications that need to access the new server machine. (For details about editing policy files for the portal Web application and its components, see “Configuring and Deploying Restrictive Policy Files” in the SAS Intelligence Platform: Web Application Administration Guide).

Install SAS 9.2 and SAS Integration Technologies on the new machine.

Copy your metadata configuration file (XML file) and spawner start-up script from your spawner configuration directory to the same directory on the new machine. If necessary, change the spawner start-up script for the new machine.

Ensure that the SAS Spawned Servers user can authenticate against the host authentication provider for the machine.

Ensure that users who need to access the server are defined for the machine’s host authentication provider.

---

**Required Tasks after You Move Workspace Servers and Stored Process Servers**

When you are finished modifying the server and spawner definitions, follow these steps:

- If you have added a new authentication domain for the machine, do both of the following:
  - Use the User Manager plug-in to SAS Management Console to add a login definition for access to the server.
  - Use the User Manager plug-in to SAS Management Console to modify the login definition for the multi-user login (for example, the SAS General Server group login, if you performed an Advanced or Personal installation). Modify the login definition to specify the new authentication, and, if required, the new user ID credentials.

- If you have changed operating systems and need to modify user credentials, use the User Manager plug-in to SAS Management Console to modify user and group login definition for the new user ID credentials of the new machine.

- If you need to move the stored process source code repositories to a different directory, use SAS Management Console to modify the stored process definition and change the Source Code Repository field on the Execution tab of the Stored Process Properties dialog box.
If your stored process definitions reference content on the old stored process or workspace server machine, you must add the content to the directory that you defined in the stored process definition.

Restart the object spawner.

For more information, see “Operating Your Servers” in SAS Intelligence Platform: System Administration Guide.

### Encoding and Locale Information

If your SAS server metadata contains characters other than those typically found in the English language, then you must be careful to start your SAS server with an ENCODING= or LOCALE= system option that accommodates those characters. For example, a SAS server that is started with the default US English locale cannot read metadata that contains Japanese characters. SAS will fail to start and will log a message that indicates a transcoding failure. In general, different SAS jobs or servers can run with different encodings (such as ASCII, EBCDIC, or various Asian DBCS encodings) as long as the encoding that is used by the particular job or server can represent all of the characters for the data that is being processed. When first configuring your server, review the characters that are used in the metadata that describes your server (as indicated by the SERVER= objectserverparm) in order to ensure that SAS runs under an encoding that supports those characters.


### Adding Environment Variables to Server Invocations

You can add operating system environment variables and other shell-level functionality to a stored process server, workspace server, pooled workspace server, and OLAP server, by modifying the corresponding _usermods.sh (.bat) files provided in the server’s configuration directory.

This can be useful for situations such as when you have to set an environment variable in order to access a third-party DBMS.

Because the _usermods files are sourced within each of the server wrapper scripts, the server inherits any logic or environment. SAS preserves _usermods files during software updates and migrations, unlike the server wrapper scripts, which SAS overwrites. For this reason, we discourage editing the wrapper scripts.

The USERMODS_OPTIONS= variable is used in the _usermods file to alter the SAS command line to invoke the server.

For more information, see “About Other SAS Server Configuration Files” in the SAS Intelligence Platform: System Administration Guide.
Overview of Changing SAS Options with the Stored Process Server

By default, the stored process server explicitly sets the following SAS options for each execution of a stored process:

- **NOSOURCE** Do not write SAS source statements to the SAS log
- **SOURCE2** Write secondary source statements from included files to log
- **CENTER** Center SAS procedure output
- **NODATE** Do not print date and time on top of each page of SAS log and procedure output
- **NONUMBER** Do not print page number on each page of SAS output
- **LINESIZE=195** Line size to 195 for SAS log and SAS procedure output
- **FORMCHAR=|----|+|---+=|-/\<>* Drum output formatting characters for print device
- **PAGESIZE=40** 40 lines printed per page of output
- **NOOVP** Do not allow output lines to be overprinted
- **NOMPRINT** Do not display SAS statements generated by macro execution
- **NOMLOGIC** Do not trace macro execution
- **NOSYMBOLGEN** Do not write results of resolving macro variable references to SAS log
- **TITLE;** Clear titles
- **FOOTNOTE;** Clear footnotes

In SAS 9.2, the stored process server can be configured to run SAS code to override or change the value of the default SAS options before the execution of the requested stored process. This is a server-wide setting and will run before each execution.

Change SAS Options with the Stored Process Server

To change SAS options with the stored process server, follow these steps:

1. Write a simple stored process that sets SAS options and place the stored process in a directory where the stored process server can read it.
   
   Here is simple example that uses SAS code to set line size to 150 and page size to 30:

   ```sas
   options ls=150 pagesize=30;
   ```

2. In SAS Management Console, expand the **Server Manager** node, then right-click the icon for the **SASApp - Logical Stored Process Server** node and select **Properties** from the pop-up menu.

3. In the Logical Stored Process Server dialog box, select the **Options** tab, and then click **Set Server Properties**.

4. In the Stored Process Server Properties dialog box, select the **Request** tab.
5 In the **Initialization program** text box, type the path and filename that contains your SAS options code.

For example:

```
C:\myOptions\setoptions.sas
```

6 Click **OK** in the Stored Process Server Properties dialog box, and then click **OK** in the Logical Stored Process Server Properties dialog box.

Now, the stored process server will run your option override code before each requested stored process.

---

### Workspace Server Configuration Tasks

### Tune Workspace Servers for Best Performance

To obtain the best performance from your SAS Web applications, you should consider tuning the workspace server that your SAS Web application is using. The changes you can make include specifying the following:

- an appropriate work folder
- a buffer size for writing files to the work area
a limit on the total amount of memory that SAS uses at any one time.

*Note:* For memory-intensive workloads on z/OS, you might need to adjust the user's USS RACF profile. For more information, see “Specify a Larger Region Size” in the *SAS Companion for z/OS.*

The following table lists some of the SAS system options that you can set. “Add System Options to the Workspace Server Launch Command” on page 97 explains how to add the system options to the command that starts the workspace server.

**Table 11.1 System Options for the Tuning the Workspace Server**

<table>
<thead>
<tr>
<th>System Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>-RSASUSER</td>
<td>Opens the SASUSER library in read-only mode. Declaring this library read only makes the workspace server much faster for SAS Web Report Studio.</td>
</tr>
<tr>
<td>-work <em>work</em>-folder</td>
<td>Specifies the pathname for the directory that contains the Work data library. This directory should reside on a disk that emphasizes fast write performance (not, for example, on a RAID-5 device).</td>
</tr>
<tr>
<td>-ubufsize <em>size-value</em></td>
<td>Specifies a buffer size for writing files to the work area.</td>
</tr>
<tr>
<td>-memsize <em>size-value</em></td>
<td>Specifies a limit on the total amount of memory that SAS uses at any one time.</td>
</tr>
<tr>
<td>-realmemsize <em>size-value</em></td>
<td>Indicates the amount of RAM that is available to a process before it begins to page. Keeping this number low limits the amount of RAM that is consumed by a SAS server in order to reduce paging activity.</td>
</tr>
<tr>
<td>-sortsize <em>size-value</em></td>
<td>Limits the amount of memory that can be used temporarily for sorting. Larger sort sizes reduce the use of the <em>work</em> folder, but increase the possibility of paging.</td>
</tr>
<tr>
<td>-cpucount <em>processors-number</em></td>
<td>Specifies the number of processors that thread-enabled applications should assume will be available for concurrent processing. This setting maximizes the effectiveness of the SAS Web Report Studio sorting algorithm.</td>
</tr>
</tbody>
</table>

Note that the arguments to these options will be specific to the site and the job. Take care in choosing these values, and consult a SAS representative if necessary.

**Configure Workspace Servers for a Locale**

When SAS Web Report Studio is configured to run under certain locales, you must add the `-nosyntaxcheck` option to the start-up command for the workspace server. “Add System Options to the Workspace Server Launch Command” on page 97 explains how to add system options to the start-up command.

*Note:* Alternatively, you can create a new SAS Application Server (parallel to SASApp) and a new workspace server within the new application server context. You can then change the command (using the `-nosyntaxcheck` option) for the new workspace server, without affecting the workspace server under SASApp. You can then assign selected libraries to the new application server, including any libraries that you intend to query for reports. See “Configuring a Client-side Pooling Workspace Server to
Add System Options to the Workspace Server Launch Command

After you have determined the system options that you want to use to start your workspace server, follow the directions in this section to edit the `sas` command that starts the server.

*Note:* For information about workspace server logging options, see “Administering Logging for SAS Servers” in *SAS Intelligence Platform: System Administration Guide*.

*Note:* At the end of this procedure, you will have optimized your workspace server for use with SAS Web Report Studio. If you are using other applications and these applications can benefit from a workspace server that is configured differently, you must create a new logical workspace server (under SASApp) and add a workspace server to it.

To add system options to the workspace server launch command, follow these steps:

1. In SAS Management Console, expand the **Server Manager** node, and then expand the **SASApp – Logical Workspace Server** node. You will see a tree node that represents the physical workspace server.
2. Right-click the icon for the physical workspace server, and select **Properties** from the pop-up menu. A Workspace Server Properties dialog box appears.
3. Click the **Options** tab. You will see the information that is shown in the following display.

![Workspace Server Properties](image)

---

Enforce Row-Level Security” on page 69 for information about creating a new SAS Application Server and workspace server.
Configure Storage for Temporary OLAP Cube Build Files on SAS Workspace Servers

When you build a SAS OLAP cube, the SAS Workspace Server generates temporary utility files. At the end of the build, the server deletes the temporary files. If the build process terminates abnormally, remove the temporary files as described in “Clean Up Temporary Files After Abnormal OLAP Server Shutdowns” on page 98.

Follow these steps to allocate sufficient storage for temporary cube build files:

1. For a SAS Workspace Server that will be used to build cubes, determine the storage capacity that will be required for temporary build files. In general, temporary files can be expected occupy two to three times the disk space that will be used to store the source data of the largest cube that will be built by that server.

2. Divide in half the estimated storage capacity. Locate two suitable disks on the SAS Workspace Server. The disks need to retain, over time, an amount of free space that is equal to half of the estimated storage capacity for temporary build files.

3. In the launch command for the SAS Workspace Server, specify a value for the WORK= system option that consists of a path to one of the two disks. To allocate the other half of the storage requirement, specify a path to the second disk in both of the system options SPDEUTILLOC= and UTILLOC=. To learn how to add system options to the launch commands of SAS Workspace Servers, see “Add System Options to the Workspace Server Launch Command” on page 97.

4. Run test builds to validate and adjust your storage estimate.

5. If your cubes are expected to grow in size over time, periodically reassess and reassign system options to provide sufficient storage capacity.

6. Either ask your cube builders not to assign the WORKPATH= option in the PROC OLAP statement, or to assign that option with a value that includes the two paths you specified for WORK= and SPDEUTILLOC=/UTILLOC=.

7. Be sure to allocate sufficient storage capacity on all SAS Workspace Servers that will be used to build SAS OLAP cubes.

For additional information about the memory and storage capacity of SAS Workspace Server, contact your SAS support representative.

Clean Up Temporary Files After Abnormal OLAP Server Shutdowns

When a SAS Workspace Server completes a cube build, it deletes the temporary files that it created during the build. If a SAS Workspace Server terminates incorrectly, some temporary files might remain. To retain the full amount of temporary storage space, delete the temporary files before your next cube build.

To delete temporary files, obtain the directory paths that are specified in the SAS OLAP Server configuration file for the system options WORK=, SPDEUTILLOC=, and UTILLOC=. 

4 Edit the text in the Command text box, which by default is set to:

```
configuration-directory\SASApp\WorkspaceServer\WorkspaceServer.bat
```

For example, here is a command with options that improve performance for a workspace server:

```
configuration-directory\SASApp\WorkspaceServer\WorkspaceServer.bat -rsasuser
-work work-folder -ubufsize 64K -memsize 192M -realmemsize 128M
-sortsize 800M -cpucount 2
```

5 Click OK in the Workspace Server Properties dialog box.
Object Spawner Configuration Tasks

Define a New Object Spawner
Add a Connection to the Object Spawner
Modify an Object Spawner Definition
Change Object Spawner-Managed Server Ports
Configure Object Spawner Logging
Configure the Object Spawner to Accept Single Sign-on Connections
Refresh the Object Spawner
Update a Windows Object Spawner Service
Using Telnet to Administer the Spawner
   Enable Telnet Access to an Object Spawner
   Connect to an Object Spawner
   Commands for Spawner Operator Interface
Configuring and Starting the Object Spawner on z/OS
   Task 1: Configure TCP/IP
   Task 2: Create the Object Spawner Started Task
      Create the Procedure
      Define the Object Spawner System Security Configuration
      Verify the Metadata Configuration File and SAS Management Console Definitions
      Start the Object Spawner
   Task 3: Create a SAS Start-up Command
      Specify Account Data
Spawner Invocation Options
   General Options
      Syntax Description
      Example
   Metadata Connection and Security Options
      Syntax Description
      Examples
   Service Options
      Syntax Description
      Examples
Define a New Object Spawner

Workspace servers, pooled workspace servers, and stored process servers are initialized by the SAS Object Spawner. An object spawner runs on each machine where you want to run one of the workspace servers or a stored process server, listens for requests, and launches the servers as necessary. If your machine already contains an object spawner, you can modify its definition to include new servers to manage.

If your machine is new to your deployment and you need to add a new object spawner, see “Add a New Server in an Existing Logical Server” on page 81.

Add a Connection to the Object Spawner

To add additional server connections to an object spawner by using the SAS Management Console, follow these steps:

1. Start SAS Management Console and connect to a metadata repository.
2. In the SAS Management Console navigation tree, select and expand the Server Manager, and locate the spawner object that you want to modify.
3. Right-click the icon for the object spawner and select Add Connection from the pop-up menu.
   The New Connection Wizard displays.
4. Select one of the following:
   - **UUID Connection**: specifies that communications between the client and the spawner use the UUID protocol.
     
     *Note:* Entering a UUID node is required on UNIX and z/OS hosts. △
   - **PortBank Connection**: defines a connection that the spawner uses to allow clients to connect to and disconnect from a spawned server-side pooled workspace server.

     *Note:* To connect to a logical pooled workspace server, the spawner must have at least one PortBank connection defined. △
5. Follow the remaining prompts. Click **Next** to proceed or **Back** to change any input.
   For more information, refer to SAS Management Console online Help.
6. When you see a wizard page that states that the following connection will be created, review the information that is supplied and do one of the following:
   - Click **Finish** to create the new connection and close the New Server Wizard.
   - Click **Back** to go to an earlier wizard page to change an input.
7. Restart the object spawner.
   For more information, see “Operating Your Servers” in SAS Intelligence Platform: System Administration Guide.

Modify an Object Spawner Definition

To modify an object spawner definition by using the SAS Management Console, follow these steps:

1. Start SAS Management Console and connect to a metadata repository.
2. In the SAS Management Console navigation tree, expand the Server Manager to find the object spawner that you want to modify.
3 Right-click the icon for the object spawner and select **Properties** from the pop-up menu.

4 Select the appropriate tabs, and enter the necessary changes.

For more information, refer to SAS Management Console online Help.

5 When you are finished, click **OK** to return to the SAS Management Console main window.

6 Restart the object spawner.

For more information, see “Operating Your Servers” in *SAS Intelligence Platform: System Administration Guide*.

---

### Change Object Spawner-Managed Server Ports

For most of the SAS Object Spawner managed ports, the SAS Deployment Wizard designates a unique port number by default. The following table shows these default values.

<table>
<thead>
<tr>
<th>Port</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spawner operator port</td>
<td>8581</td>
</tr>
<tr>
<td>Workspace server port</td>
<td>8591</td>
</tr>
<tr>
<td>Pooled workspace server port</td>
<td>8701</td>
</tr>
<tr>
<td>Stored process server bridge port</td>
<td>8601</td>
</tr>
</tbody>
</table>

With the exception of the operator port, these various spawner processes can all use the same port. Using the SAS Management Console, you can change these default port designations and reduce the number of ports that need to be defined in SAS metadata and opened up through your firewall.

**Note:** You cannot use the same port number for the spawner port bank and the stored process server MultiBridge ports. Port bank and MultiBridge ports all must use unique ports.

To change object spawner-managed server ports, follow these steps:

1 In SAS Management Console, expand the Server Manager to locate the server definition, or the object spawner definition.

2 Click the icon for the server or for the spawner, and in the SAS Management Console’s right pane, select the **Connections** tab.

3 On the **Connections** tab, right-click the icon for the connection, and select **Properties** from the pop-up menu. A connection properties dialog box appears.

4 In the connection properties dialog box, click the **Options** tab.

5 In the **Port** field, enter the port that you want the connection to use and then click **OK**.

6 Restart the spawner for the port changes to take effect.

For more information, see “Operating Your Servers” in *SAS Intelligence Platform: System Administration Guide*.

---

### Configure Object Spawner Logging

For users with administer permissions on the spawner, you can view the SAS Object Spawner log in the SAS Management Console by first opening a connection to the object.
Configure the Object Spawner to Accept Single Sign-on Connections

On Windows machines on which the SAS Object Spawner runs, you can configure the spawner to accept Integrated Windows Authentication (IWA) connections from SAS clients.

To configure the object spawner to accept single sign-on connections, follow these steps:

1. In the SAS Management Console, expand the Server Manager node and then click on the Object Spawner node.
2. In the right pane of the SAS Management Console, click the Connections tab.
3. Right-click Connection: Spawner, and then select Properties from the pop-up menu. A spawner properties dialog box displays.

You can also view spawned server activity in real time by using the Spawned Server Activity tab also in the SAS Management Console. For more information, see “Use the Spawned Server Activity Tab in Server Manager” in SAS Intelligence Platform: System Administration Guide.

By default, the object spawner logs activity at the information level. You can temporarily adjust this logging level for a spawner session through the SAS Management Console, or more permanently by editing the spawner logging configuration file.

CAUTION:

Excessive logging can degrade performance. You should not use the TRACE and DEBUG logging levels unless you are directed to do so by SAS Technical Support.

To temporarily adjust logging for the spawner session:

- Select the App.ObjectSpawner logger in the Loggers tab, and edit the logger properties. For more information, see “Use the Loggers Tab in Server Manager and (If Necessary) Change Logging Levels for Individual Loggers” in SAS Intelligence Platform: System Administration Guide.

To adjust logging for more than one spawner session:

- Edit the spawner logging configuration file and add the following information:

  `<logger name="App">`  
  `<level value="level"/>`  
  `</logger>`

  where level is a value such as trace. For more information, see “Use the Loggers Tab in Server Manager and (If Necessary) Change Logging Levels for Individual Loggers” in SAS Intelligence Platform: System Administration Guide.

  Restart the object spawner.

  For more information, see “Operating Your Servers” in SAS Intelligence Platform: System Administration Guide.

  By default, the spawner logging configuration file resides here:

- Windows:
  
  `configuration-directory\ObjectSpawner\logconfig.xml`

- UNIX:

  `configuration-directory/ObjectSpawner/logconfig.xml`

spawner and then clicking the Log tab. For more information, see “Using SAS Management Console to Monitor SAS Servers” in SAS Intelligence Platform: System Administration Guide.

You can also view spawned server activity in real time by using the Spawned Server Activity tab also in the SAS Management Console. For more information, see “Use the Spawned Server Activity Tab in Server Manager” in SAS Intelligence Platform: System Administration Guide.

By default, the object spawner logs activity at the information level. You can temporarily adjust this logging level for a spawner session through the SAS Management Console, or more permanently by editing the spawner logging configuration file.

CAUTION:

Excessive logging can degrade performance. You should not use the TRACE and DEBUG logging levels unless you are directed to do so by SAS Technical Support.

- To temporarily adjust logging for the spawner session:

  Select the App.ObjectSpawner logger in the Loggers tab, and edit the logger properties. For more information, see “Use the Loggers Tab in Server Manager and (If Necessary) Change Logging Levels for Individual Loggers” in SAS Intelligence Platform: System Administration Guide.

- To adjust logging for more than one spawner session:

  Edit the spawner logging configuration file and add the following information:

  `<logger name="App">`  
  `<level value="level"/>`  
  `</logger>`

  where level is a value such as trace. For more information, see “Use the Loggers Tab in Server Manager and (If Necessary) Change Logging Levels for Individual Loggers” in SAS Intelligence Platform: System Administration Guide.

  Restart the object spawner.

  For more information, see “Operating Your Servers” in SAS Intelligence Platform: System Administration Guide.

  By default, the spawner logging configuration file resides here:

  - Windows:
    
    `configuration-directory\ObjectSpawner\logconfig.xml`

  - UNIX:

    `configuration-directory/ObjectSpawner/logconfig.xml`
4 Select the **Options** tab. You will see the information that is shown in the following display.

![Options tab](image)

5 In the **Authentication type** drop-down list, choose **Integrated Windows Authentication**, and then click **OK**.

6 Restart the object spawner.
   
   For more information, see “Operating Your Servers” in *SAS Intelligence Platform: System Administration Guide*.

---

**Refresh the Object Spawner**

When you refresh the object spawner, you reinitialize the spawner and force it to reread its configuration in the metadata. As part of this refresh, the spawner shuts down any servers that it currently has started. If changes are made to the server or spawner configurations, the spawner can be refreshed in order to pick up and apply these new changes.

To refresh an object spawner, follow these steps:

1 For users with administer permissions on the spawner, in the SAS Management Console, expand the **Server Manager** node and then right-click on the **Object Spawner** node.

2 From the pop-up menu choose **Connect**.

3 Right-click on the **Object Spawner** node again, and from the pop-up menu choose **Refresh Spawner**.
In the confirmation dialog box, click **Yes**.

---

**Update a Windows Object Spawner Service**

To update an existing Windows service for the spawner (for example, to change the path to your metadata configuration file), you must remove the service and create a new one.

To update a Windows object spawner service, follow these steps:

1. Stop the spawner service by using the Stop SAS Object Spawner shortcut in the Windows Start menu.
2. Remove the spawner service by invoking `ObjectSpawner.bat -remove`. This file is located in the `SASApp\ObjectSpawner` subdirectory of your SAS Configuration Directory. For example, `C:\SAS\MyDeployment\Lev1\SASApp\ObjectSpawner`.
3. Open the `ObjectSpawner.bat` file in an editor, and then add your options to the install and start commands.
4. Save the file.
5. Reinstall the spawner service by using the command `ObjectSpawner.bat -install`.

---

**Using Telnet to Administer the Spawner**

The object spawner can be controlled and monitored using a Telnet client connected to the operator port or service.

**Enable Telnet Access to an Object Spawner**

For security reasons, Telnet access to the object spawner is disabled by default. However, using the SAS Management Console, you can enable Telnet access.

To enable Telnet access to an object spawner, follow these steps:

1. In SAS Management Console, select and expand the Server Manager to locate the object spawner for which you want to enable Telnet access.
2. Right-click the object spawner for which you want to enable Telnet access, and choose **Properties**.
3. In the Properties dialog box, choose the **Initialization** tab, and then uncheck **Disable telnet access**.
4. In the **Operator login** drop-down list, choose a login to verify users that connect to the spawner's operator port via the Telnet interface.

   **Note:** For more information about using the interface to choose an operator login, refer to SAS Management Console online Help.

5. Once you have chosen a login, click **OK** to save your changes and to close the Properties dialog box.
6. Restart the object spawner.

   For more information, see “Operating Your Servers” in **SAS Intelligence Platform: System Administration Guide**.

---

**Connect to an Object Spawner**

To connect to an executing object spawner, Telnet to the operator interface port or service that is specified in the spawner definition.
Managing the Object Spawner

The following example, run on UNIX, assumes that 8581 was specified as the port for the operator:

```bash
myHost> telnet serverhost 8581
Trying...
Connected to serverhost.
Escape character is '^]'.
```

After the Telnet conversation is active, enter the operator password that is specified. If the operator password was not specified, use `sasobjspawn` as the password.

*Note:* You will not be prompted for the password. For example:

```bash
sasobjspawn
Operator conversation established
```

You can now interact with the executing spawner by issuing any of the “Commands for Spawner Operator Interface” on page 105.

### Commands for Spawner Operator Interface

The following is a list of commands that are available via the spawner’s operator interface:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bye</td>
<td>Terminates the spawner execution.</td>
</tr>
</tbody>
</table>

*Note:* You cannot shut down an object spawner while there are current or pending load-balancing tasks.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>help</td>
<td>Lists available operator commands.</td>
</tr>
<tr>
<td>quit</td>
<td>Exits operator conversation.</td>
</tr>
<tr>
<td>refresh</td>
<td>Reinitializes the spawner. The spawner rereads its configuration out of the metadata. As part of this refresh, the spawner shuts down any servers that it currently has started. If changes are made to the server or spawner configurations, the spawner can be refreshed in order to pick up and apply these new changes.</td>
</tr>
</tbody>
</table>

### Configuring and Starting the Object Spawner on z/OS

On a z/OS server, the object spawner starts a SAS server session in response to a request from a client. The client uses TCP/IP to communicate first with the spawner, and then with the object server. The object spawner runs as a started task. Therefore, before the object spawner can handle client requests, you must start the spawner by using a started task procedure.

If you used the SAS Deployment Wizard to deploy the Intelligence Platform, then you already have an initial z/OS spawner configuration.

If you did not use the SAS Deployment Wizard, then the following setup tasks are required:
1 Configure TCP/IP.
2 Create the object spawner started task.
3 Create a SAS start-up command.

*Note:* This topic is intended to serve as an outline of the process, rather than a step-by-step guide, for setting up a spawner on a z/OS platform.

---

## Task 1: Configure TCP/IP

The overall configuration of TCP/IP is outside the scope of this discussion. Assuming that a functioning TCP/IP link is in place between the client and the z/OS server, verify that the TCP/IP SERVICES configuration is available to both the object spawner and its object servers. For more information, see the [Configuration Guide for SAS 9.2 Foundation for z/OS](#).

If your TCP/IP site requirements include customization of `/etc/services` (or equivalent) for applications that listen on well-known ports, it will be necessary to add object spawner definitions to the `/etc/services` file. To define these in the TCP/IP services file, add the following two lines:

```
  sasobjjoper  8582/tcp
  sasobjjspawn  8581/tcp
```

---

## Task 2: Create the Object Spawner Started Task

The object spawner runs as a started task (STC). Its purpose is to listen for requests from clients and pass them to the start-up command that is associated with the service and port in which there is activity. The start-up command will start a server session. You must create a procedure in a system PROCLIB library (SYS1.PROCLIB, for example).

### Create the Procedure

Because z/OS Job Control Language has a parameter line length restriction of 100 characters, you can use DDNames to identify filenames in object spawner parameters. When a file pathname is eight characters or less, the file pathname is first checked to see whether it matches a DDName. If so, the DDName is used. If DDNames are not used for the configuration file and a log file, you need to specify a configuration file and a log file in the UNIX file system.

If you need to specify more than 100 characters for command-line parameters, put the additional parameters in a z/OS data set or UNIX file. Reference the data set or file by using the `=</DDN:PARMS` parameter.

The following procedure explicitly specifies the pathname for the configuration file and uses a DDName to reference the log file in the command line parameters for the object spawner.

```c
//OBJJSPAWN PROC PROG=OBJJSPAWN,
// OPTIONS='-XMLCONFIGFILE /usr/lpp/SAS/objspawn.xml',
// OPT2='-LOGCONFIGLOC /usr/lpp/SAS/logconfig.xml'
//OBJJSPAWN EXEC PGM=&PROG,REGION=512M,
// PARM='&OPTIONS &OPT2 =</DDN:PARMS'
//STEPLIB DD DISP=SHR,DSN=SYS2.SAS.LIBRARY
//PARMS DD DISP=SHR,DSN=SYS2.OBJJSPAWN.PARMS
//TKMVSENV DD DISP=SHR,DSN=SYS2.OBJXPAWN.TKMVSENV
```
Managing the Object Spawner

Task 3: Create a SAS Start-up Command

The -XMLCONFIGFILE parameter identifies the SAS Metadata Server system configuration file that the spawner is to use.

The -LOGCONFIGLOC parameter identifies the file for configuring the logging of useful information for diagnosing connection problems. It is a good idea to include logging until you are satisfied that everything is working correctly.

Define the Object Spawner System Security Configuration

The z/OS system considers the object spawner a daemon process. Therefore, if the BPX.DAEMON profile of the RACF Facility class is active and RACF program control is enabled, then the SAS load library that is specified in the STC procedure must be program controlled. However, the user ID under which the object spawner runs does not require RACF READ access to the BPX.DAEMON profile.

If the following messages appear in the z/OS system log when a client attempts to connect, then a necessary library is not program controlled.

ICH420I PROGRAM program-name [FROM LIBRARY dsname] CAUSED THE
ENVIRONMENT TO BECOME UNCONTROLLED.
BPXP014I ENVIRONMENT MUST BE CONTROLLED FOR DAEMON (BPX.DAEMON) PROCESSING

Verify the Metadata Configuration File and SAS Management Console Definitions

You must also define your server and spawner by using SAS Management Console. When you define the server, enter the following command in the Command field of the Advanced > Options > Launch Commands tab:

/usr/lpp/SAS/SAS_9.2/startsas.sh

Start the Object Spawner

After you have created the STC procedure, you can start the object spawner by issuing the following command:

START OBJSPAWN

For a list of all available spawner invocation options, see “Spawner Invocation Options” on page 109. If there are no configuration errors, the object spawner will assume a listening state by entering a detected wait state (DW).

Task 3: Create a SAS Start-up Command

The start-up command is meant to build a parameter string that is capable of launching SAS. Here is a sample shell script (startsas.sh):

#!/bin/sh
#
# Initialize SAS startup command...
#
cmd="/bin/tso -t %SASTREXX \
-sasrxsysconfig '&prefix.SASRXCFG(ENW0NO)'
#
# Quote arguments with embedded blanks
#
Quoteme() {
  if [ $# -gt 1 ]; then
    quoteme="${*}"
  else
    quoteme=$1
  fi
}
for arg in "@" ; do
  Quoteme $arg
  tmp="$quoteme"
  cmd="$cmd $tmp"
done
#
# pass the metadata authentication strings to SAS
#
if [ -n "$METAUSER" ] ; then
  cmd="$cmd -metauser ""$METAUSER"
fi
if [ -n "$METAPASS" ] ; then
  cmd="$cmd -metapass ""$METAPASS"
fi
#
# Set additional environment variables...
# SYSPROC specifies the data set containing the SAS REXX
#
export SYSPROC=&prefix.SASRX
export STEPLIB=
export TSOOUT=
#
# Start SAS
#
exec $cmd

The sample invokes the /bin/tso UNIX command to execute the REXX exec
SASTREXX. Replace the REXX exec data set name &prefix.SASRX in the SYSPROC
environment variable with the data set name that is appropriate for your site. The
SASTREXX exec should be invoked with the following parameter, which you can specify
in metadata on the command line to launch the server:

NOSASUSER

NOSASUSER allows more than one concurrent SAS session per user. NOSASUSER
suppresses allocation of a SASUSER data set.

Specify Account Data

The IOM spawner on z/OS uses the UNIX System Services spawn function to initiate
a process to run an IOM server. This process runs in a USS initiator (BPXAS). By
default, the process runs with the default Work Load Manager (WLM) service class that
was assigned to OMVS work during installation. The default service class might have
been defined with a goal of providing USS shell commands with good response times.
This default service class assumes that the requests are relatively short. Because work associated with IOM requests might require more time, it might be desirable to assign IOM servers to a different service class.

You can use MVS accounting data to assign the work to a specific Work Load Manager service class. To set the accounting data, use the _BPX_ACCT_DATA environment variable in the startsas.sh script that starts that SAS IOM server session. The server session then runs with the accounting data. For example:

```bash
export _BPX_ACCT_DATA=MYNAME1
```

To assign a Work Load Manager service class based on the accounting data, use the WLM AI classification rule. For example (in the WLM ISPF dialog box):

```
Qualifier      Class
Type Name      Start Service Report
  DEFAULTS: OMVSSHRT ________
  1 AI MYNAME1 OMVSLONG ________
```

For more information about using accounting information with USS processes, defining WLM service classes with appropriate characteristics, and specifying classification rules to use these classes, see your IBM documentation.

Because you might define different IOM servers, in order to separate different work loads, you can also specify that these servers run in different service classes. To specify different service classes, create a separate server definition for each class of work in the SAS Management Console configuration, and assign client requests to the listen port that is associated with each server.

### Spawner Invocation Options

The object spawner controls the execution of the workspace server and the stored process server through an IOM bridge connection. Spawner invocation options consist of options that are specific to the spawner and several SAS system options that you can use to run and configure the object spawner from the command line. On Windows and UNIX, when you install and configure SAS servers with the SAS Deployment Wizard, a spawner batch or script file is created by default in the object spawner configuration directory (\ObjectSpawner.bat or objectspawner.sh).

On z/OS, the spawner is run as a started task. If you want to create a SAS startup command, see the section, “Configuring and Starting the Object Spawner on z/OS” on page 105.

**Note:** On z/OS and UNIX, to set the object spawner temp directory, update the TKOPT_ENV_UTILLOC environment variable with the new path. For more information, see the SAS Companion for z/OS or your UNIX documentation.

The object spawner executable resides by default in:

- **Windows:**
  ```
  install-dir\SASFoundation\9.2\objspawn.exe
  ```

- **UNIX:**
  ```
  install-dir/SASFoundation/9.2/utilities/bin/objspawn
  ```

The spawner must be refreshed through the SAS Management Console in order to reflect configuration updates. The SAS Management Console provides an interface to refresh the spawner with configuration changes. For more information, see “Using SAS Management Console to Operate SAS Servers” in the SAS Intelligence Platform: System Administration Guide. If your spawner is configured as a Windows service, then
you must redefine the service to change the invocation options. For more information, see “Update a Windows Object Spawner Service” on page 104.

Spawner invocation options can be logically grouped into these categories:
- general options
- metadata connection options
- service options

### General Options

Use the following general options for identifying which object spawner to invoke and for setting spawner options such as security and logging:
- `-dnsmatch`
- `-dnsname`
- `-hostknownby`
- `-sasspawnercn`
- `-allowxcmd`
- `-authproviderdomain`
- `-conversationport`
- `-logconfigloc`
- `-generic`
- `-sspi`
- `-secpackage`
- `-secpackageclist`

### Syntax Description

- `-dnsmatch DNSalias`
  - specifies a DNS alias that will be accepted by the object spawner as a match for the local machine name.

  In addition, the spawner replaces the dnsMatch value with the local machine name in its list of servers. This option is necessary if your network configuration resolves a single DNS alias to multiple machines that run SAS object spawners. For example, you configure SAS servers and spawners on two different machines: `n1.my.org` and `n2.my.org`. The DNS alias `srv.my.org` resolves to both of these machines, so clients can send a request to the alias and one of the two spawners will receive it. To support this configuration, specify `-dnsmatch srv.my.org` in the spawner startup command on each machine.

- `-dnsname | -dns name`
  - specifies which IP stack is used for communication between the spawner and the servers that the spawner launches. This option can be abbreviated as `-dns`.

- `-hostknownby DNSalias`
  - specifies a DNS alias that will be accepted by the object spawner as a match for the local machine name.

- `-sasspawnercn | -ssc name`
  - specifies the name (used in the SAS Management Console configuration) of the spawner object to use for this spawner invocation configuration. If you do not specify `-sasspawnercn`, the object spawner uses the first spawner definition (on the metadata server) with the same machine name as the current host.
 Managing the Object Spawner

**General Options**

---

**Note:** If none of the spawner definitions contain a host name of the current host, you must specify the -sasspawnercn option to designate which spawner definition to use. If you specify a spawner name that contains embedded blank spaces, then you must enclose the name in quotation marks (" "). This option can be abbreviated as -ssc.

**-allowxcmd**

enables host commands and PIPE commands for all servers that are started by the spawner. You can use the SAS Management Console to enable host and PIPE commands on a server-by-server basis (Server Properties ▶ Options ▶ Advanced Options ▶ Launch Properties). By default, the spawner starts all servers with the -NOXCMD SAS system option. When you specify -allowxcmd, the spawner no longer specifies -NOXCMD when launching server sessions.

---

**CAUTION:**

When you specify -allowxcmd, clients can use host commands to perform potentially harmful operations such as file deletion.

---

**-authproviderdomain | -authpd hostuser:domain**

associates a domain with the host authentication provider, because the spawner starts either a SAS Workspace Server or SAS Stored Process Server. Workspace and stored process servers authenticate only against the host. For example:

```
-authp hostuser:mydomain
```

**-conversationport | -cp port**

specifies which port is used for communication between the spawner and the servers that the spawner launches. This option can be abbreviated as -cp.

**-logconfigloc filename**

sets the log options for the spawner in a log configuration file. For example:

```
-logconfigloc "C:\SAS\Config\Level\ObjectSpawner\logconfig.xml"
```

The file is an XML file that uses specific options. For more information, see “Using the SAS Logging Facility in the SAS Intelligence Platform” in the SAS Logging: Configuration and Programming Reference.

Unless a path is specified, the spawner looks for the log config file in the current directory.

**-generic**

causes the spawner to use generic placeholders in data that it writes to its log. For example, user names are output as `<user identity>`, host names as `<IP address>`, connection and process IDs as `--1` or `<child process>`, configuration paths as `<configuration file path>`, and so on.

**-sspi**

identifies support for the Security Support Provider Interface for single sign-on connections to the object spawner.

For more information, see “SSPI System Option” on page 143.

**-secpackage "package-name" | "negotiate"**

specifies the security package that the spawner should use to authenticate incoming client connections. (Use with -sspi.)

The "package-name" value specifies the security package that the spawner should use to authenticate incoming client connections. Enclose the security package name within double quotation marks (" ").

The default value is "negotiate". This value enables the spawner to present a set of valid security packages (through `SECPACKAGELIST`), which the server uses to...
find a match with an incoming client connection. If the client specifies a security
package in the list, then the server attempts to authenticate the client the
matched security package. Enclose `negotiate` within double quotation marks (").

For more information, see “SECPACKAGE System Option” on page 140.

`-secpackagelist "package-name-1,[package-name-2], [...]"
` identifies the security package that is used by the server to authenticate incoming
client connections. (Use with `-sspi`.) The `package-name` value defaults to
"Kerberos,NTLM".

Enclose the security package name within double quotation marks ("). Delimit
an additional package name with a comma (,).

For more information, see “SECPACKAGELIST System Option” on page 141.

**Example**

This example illustrates a typical spawner invocation:

```
C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe
-dnsMatch d18374.na.sas.com -sasspawnercn "SAS [Config-Lev1] Object Spawner"
-xmlconfigfile xmlconfig.xml -sspi -logconfigloc logconfig.xml
```

**Metadata Connection and Security Options**

Use the following metadata connection options for the object spawner to connect to
the metadata server in order to find workspace server and stored process server
definitions:

- `-xmlconfigfile`
- `-metaserver`
- `-metaport`
- `-metauser`
- `-metapass`
- `-metaprofile`
- `-metaconnect`
- `-metarepository`
- `-metaspn`
- `-metaencryptalg`
- `-metaencryptlevel`

For metadata server connection options, you can either specify individual metadata
options or point to a file that contains connection options by using `-xmlconfigfile`. For
more information about the metadata configuration options, see “Overview of System
Options for Metadata” in the *SAS Language Interfaces to Metadata*.

**Syntax Description**

`-xmlconfigfile | -xcf filename`

specifies a fully qualified path to a metadata configuration file that contains a SAS
Metadata Server definition to connect to for the complete configuration. On
Windows, enclose paths with embedded blank spaces in double quotation marks.
On z/OS, specify filenames similar to UNIX file paths due to the requirement for
z/OS UNIX System Services.

This option can be abbreviated as `-xcf`.

`-metaserver host name`
identifies the metadata server where configuration information is saved and can be
queried.

-metaport port
   designates the metadata server port.

-metauser user ID
   identifies metadata server user ID.

-metapass userPassword
   identifies metadata server password.

-metaprofile filename
   specifies the location of the file that contains metadata profiles.

-metaconnect name
   identifies the named connection from the -metaprofile file to use as the default
   metadata server connection.

-metarepository repositoryName
   identifies the name of the metadata repository to query.

-metaspn servicePrincipalName
   identifies the metadata server service principal name to use when communicating
   with a metadata server.

-metaencryptalg none | rc2 | rc4 | des | aes | tripledes | sas
   specifies the type of encryption to use when communicating with a metadata
   server. (sas is the short form for sasproprietary.)

-metaencryptlevel credentials | everything
   specifies the encryption level to use when communicating with a metadata server.

Examples

EXAMPLE 1: In this example, the object spawner connects to a metadata server by
using command line options:

   C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe
   -metaserver "metaserver.unx.alphacorp.com"
   -metaport 8561 -metauser "sastrust@saspw" -metapass "sasuser1"

EXAMPLE 2: In this example, the object spawner points to a connection file
(metadataConfig.xml) that contains metadata server connection information:

   C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe -xcf metadataConfig.xml

Service Options

Use the following service options to create, modify, and delete object spawner service
definitions on Windows only:

- -install
- -name
- -servdir
- -servuser
- -servpass
- -installdependencies
- -deinstall
For more information, see “Update a Windows Object Spawner Service” on page 104.

**Syntax Description**

- **install | -i** `<name name> <servdir directory> <servuser user ID> <servpass password>`
  
instructs the spawner to install as a Windows service. This option can be abbreviated as -i. When asked to install as a service, the spawner records all options that are specified at installation time in the registry under the following key:

  "SYSTEM\CurrentControlSet\Services\service-name\Parameters"

  You can also specify options in the startup parameters when you manually start the spawner service from the Microsoft Windows Services snap-in (services.msc).

- **-name name**
  
specifies a Windows service name to use when installing the spawner as a service. Use with -install. The default value is **SAS Object Spawner Daemon III**.
  
  If you specify a service name that contains embedded blank spaces, then you must enclose the name in quotation marks (" ").
  
  **Note:** If you install more than one spawner as a service on the same machine, then you must use the -name option to give each spawner service a unique name.

- **-servdir directory**
  
specifies the directory in which to run the Windows service. Use with -install. By default, the directory is: `install-dir\Config\Lev1\ObjectSpawner`.

- **-servuser | -su user ID**
  
specifies a user name that the Windows service will run under, when you also specify the -install option. Use with -install. This option can be abbreviated as -su.

- **-servpass | -sp password**
  
specifies a password for the user name that is specified in the -servUser option. Use with -install. This option can be abbreviated as -sp.

- **-installdependencies | -idep service-1;service-2;...**
  
specifies the Windows services that must be started before the spawner service starts. The service value is the name of the dependent service that is displayed in the Microsoft Windows Services snap-in (services.msc).
  
  This option can be abbreviated as -idep.

- **-deinstall | -di –name name**
  
instructs the spawner to uninstall as a Windows service. This option can be abbreviated as -di.
  
  **Note:** The name value is the spawner service name that is displayed in the Microsoft Windows Services snap-in (services.msc).

**Examples**

**EXAMPLE 1:** In this example, the spawner is installed as a Windows service with “SAS [Config-Lev1] Object Spawner” displaying in the Microsoft Windows Services snap-in (services.msc).

```
C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe
-i -name "SAS [Config-Lev1] Object Spawner"
```

The spawner is installed under the Windows system user and runs in the default directory (`install-dir\ObjectSpawner`).
EXAMPLE 2: In this example, the spawner service is dependent on the metadata server starting first:

```
C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe
-idep "SAS [Config-Lev1] Metadata Server"
```

EXAMPLE 3: In this example, the spawner service is uninstalled:

```
C:\Program Files\SAS\SASFoundation\9.2\objspawn.exe
-di -name "SAS [Config-Lev1] Metadata Server"
```
Administrative Overview for SAS OLAP Servers

The SAS OLAP implementation consists of the following components:

SAS OLAP Server

references cube data held in memory to generate result data sets that are delivered to OLAP clients in response to queries from cube viewers. One server supports one
or more concurrent client connections. SAS OLAP Servers can be grouped into load-balancing clusters to provide scalable support for one or more cubes.

SAS OLAP Cube Studio

- generates cube metadata and creates SAS code that is executed to build cubes.
- Other tools define aggregations, generate calculated members, export and import cubes between metadata repositories, and generate new OLAP schemas.

SAS Language Elements

- PROC OLAP creates and updates cubes. PROC OLAP_OPERATE provides programmatic administration of SAS OLAP Servers, as described in the SAS OLAP Server: User's Guide.

OLAP Schema

- groups cubes that are exclusively accessed by one or more SAS OLAP Servers.
- Each cube is listed in one and only one OLAP schema. Each SAS OLAP Server is required to use one OLAP schema. Multiple servers can use the same schema.

SAS Workspace Server

- executes SAS code to build or update cubes in host memory. For information about the administration of SAS Workspace Servers, see Chapter 11, “Managing Workspace Servers and Stored Process Servers,” on page 87.

SAS Metadata Server

- stores metadata that defines cubes, cube data, cube data access permissions, and load-balancing data.

Cube Viewer

- generates queries in the MDX language and displays result data sets as they are received from SAS OLAP Servers. The primary cube viewers are SAS Web OLAP Viewer, SAS Web Report Studio, and SAS Enterprise Guide. Because queries are submitted in the OLE DB for OLAP application programming interface, you can also view cubes with third-party viewers such as Microsoft Excel.
- For more information about the MDX query language, see the SAS OLAP Server: MDX Guide.

SAS Management Console

- displays SAS OLAP Servers and OLAP schemas and contains the OLAP server administrative plug-ins Server Manager and SAS OLAP Server Monitor.

Server Manager

- displays OLAP servers and logical OLAP servers, provides server controls, and manages advanced server options. This application is provided in the Environment Management folder in the Plug-ins tree in SAS Management Console.

SAS OLAP Server Monitor

- displays all OLAP servers and schemas, provides session controls, and manages advanced server options. This application is provided in the Monitoring folder in the Plug-ins tree in SAS Management Console.

Administrators support SAS OLAP Servers by configuring hosts, installing and configuring SAS OLAP Servers and SAS Workspace Servers, starting, stopping, and restarting servers, monitoring servers, managing server logs, tuning servers, and configuring libraries and permissions for users. These tasks are accomplished using the SAS Deployment Wizard and SAS Management Console.

User tasks for SAS OLAP Server include building cubes, viewing cubes, and tuning cubes. These tasks are accomplished with SAS OLAP Cube Studio. User tasks are documented in the SAS OLAP Server User's Guide and in the Help for SAS OLAP Cube Studio.
Migrating OLAP Cubes from SAS 9.1.3 to SAS 9.2

Cubes that were created in SAS 9.1.3 need to be rebuilt to run in SAS 9.2, as described in the migration chapter of the *SAS OLAP Server: User's Guide*.

You do not need to delete SAS 9.1.3 cubes in order to make the migrated cubes viable in SAS 9.2. If you need to delete physical cubes from SAS 9.1.3, use SAS 9.1.3 PROC OLAP.

Installing and Configuring SAS OLAP Servers

Considerations for SAS OLAP Servers

Consider the following with regard to the installation and configuration of SAS OLAP Servers:

- Cubes are built and updated on SAS Workspace Servers. Cubes are queried on SAS OLAP Servers.
- Install one SAS OLAP Server per host.
- Workspace servers and OLAP servers need to access the same physical locations.
- Workspace servers and OLAP servers do not need to be installed on the same host.
- Workspace servers require sufficient storage capacity for temporary files that are generated during cube builds, as described in “Configure Storage for Temporary OLAP Cube Build Files on SAS Workspace Servers” on page 98.

Initial Deployment

You initially install SAS OLAP Servers with the rest of the SAS Intelligence Platform using your SAS software depot, your deployment plan, and the SAS Deployment Wizard, as described in the *SAS Intelligence Platform: Installation and Configuration Guide*. After your initial installation, you:

- Configure source data libraries, as described in *SAS Intelligence Platform: Data Administration Guide*
- Configure access control, as described in *SAS Intelligence Platform: Security Administration Guide*. You have the capability of limiting access within cubes by preventing the display of specified dimensions, hierarchies, levels, and members.
- Configure cube viewers, as described in *SAS Intelligence Platform: Desktop Application Administration Guide*

Add a SAS OLAP Server

After your initial deployment, demand for additional cubes might require you to add another SAS OLAP Server. Contact a SAS support representative to receive assistance with your hardware configuration plan.

To install a new SAS OLAP Server, you install a new SAS Application Server on a new host using the SAS Deployment Wizard. Use the wizard in Configuration mode to install metadata, software, and configuration files in a single pass. After installation,
you either add cubes to the new OLAP schema file or you assign the new server to the cubes that are listed in an existing OLAP schema. To work with OLAP schemas in SAS Management Console, select the Folders tab, open the Shared Data folder, right-click the OLAP schema file, and select Properties.

---

**Add a Load-Balancing Cluster of SAS OLAP Servers**

Load-balancing clusters of OLAP servers improve query response times by dividing concurrent client sessions across multiple hosts. You can add or remove servers from the cluster in response to changes in the average number of concurrent sessions. To add a load-balancing OLAP cluster, see Chapter 7, “Understanding Server Load Balancing,” on page 33.

---

**Connecting to SAS OLAP Servers**

In SAS Management Console you can connect to OLAP servers and validate connections. Connecting to a server indicates that the server is responsive. Validating a server confirms that the connection is valid and the server has made contact with its OLAP schema and with the cubes that are listed in that schema.

To connect to a SAS OLAP Server or to validate a connection, right-click the server in the Server Manager, or right-click the logical OLAP server in the SAS OLAP Server Monitor, and select Connect or Validate.

---

**Starting SAS OLAP Servers**

SAS OLAP Servers are background processes that remain active until you need to stop or pause them. You stop or pause and resume SAS OLAP Servers to build or rebuild cubes, update cubes, tune cubes, change OLAP schemas, or change server properties. To maximize availability, OLAP servers are generally configured to start when their hosts are initialized. After you change server properties, you restart the host to restart the server. For the other server tasks, you can pause-and-resume the server without shutting it down.

---

**Stopping, Pausing, and Resuming SAS OLAP Servers**

In SAS Management Console, you can stop or quiesce OLAP servers to rebuild cubes, change OLAP schemas, or change server properties. When you stop an OLAP server, any active queries are immediately terminated. When you quiesce an OLAP server, the server accepts no new queries and terminates after the completion of the last active query. After you stop an OLAP server, you generally restart the host to restart the server.

*Note:* Stopping or pausing a SAS OLAP Server does not necessarily prevent access to a particular cube, because other servers might share the same OLAP schema. To update a cube without taking it off-line, you should disable the cube rather than stopping or pausing the server.△

To stop, quiesce, pause, or resume a SAS OLAP server, right-click the server instance in the Server Manager and select the server from the pop-up menu, or right-click the logical OLAP server in the SAS OLAP Server Monitor.
Disabling and Enabling Cubes

Disable cubes when you want to prevent all access to the cube, without stopping any OLAP servers. You disable cubes as part of the cube update process, before clients can access a new version of a cube. When a cube is disabled, no new sessions can be started on that cube, on any OLAP server. Disabling a cube does not close existing sessions. Existing sessions either terminate on their own, or are closed using the SAS OLAP Server Monitor.

Note that you do not need to disable a cube to update a cube in-place. When you update a cube in-place, you add data without closing sessions. While this method of update does not interrupt client access, the process does not enable testing beforehand, and it does not provide a previous version of the cube that you can put back into service.

To disable or enable a cube, follow these steps:

2. Expand the Monitoring folder and expand the SAS OLAP Server Monitor.
3. Expand the OLAP Schema folder.
4. Right-click the cube and select Disable or Enable.

Building Cubes: Overview for Administrators

Users build cubes with SAS OLAP Cube Studio or PROC OLAP. This section describes the cube build process from an administrative perspective. For more information about cube builds, refer to the SAS OLAP Server: User’s Guide.

When you build a cube you specify the cube data and cube structure, and the SAS OLAP Server software creates the cube. The cube is assigned to an OLAP schema, and one or more SAS OLAP Servers that use that schema support client queries on the cube.

Due to the pre-summarization of data, and based on the amount and structure of the data, cube builds can be time-consuming and resource-intensive. For this reason, it is advantageous to build cubes using a non-production OLAP schema. When rebuilding existing cubes, follow these steps to minimize the time that the cube is out of service:

1. Change the OLAP schema of the existing cube from the production schema to a non-production schema.
2. Rebuild the cube using the non-production schema.
3. After the rebuild, change the OLAP schema of the new cube to the production schema.

Updating Cubes: Overview for Administrators

Users update cubes with SAS OLAP Cube Studio or PROC OLAP. This section describes the update process from an administrative perspective. For more information about cube updates, refer to the SAS OLAP Server: User’s Guide.

Starting in SAS 9.2, users can perform an in-place cube update to add data to cubes without rebuilding the entire cube, and without restarting the SAS OLAP Server. Users can also perform an incremental cube update that includes a server restart.

Cube updates add new aggregation tables that combine with existing aggregation tables in previous versions of the cube. The updated version of the cube looks through to the previous versions to obtain all cube data.
As you accumulate cube updates and aggregation tables, it is possible that OLAP server performance might decline. To improve performance, users can coalesce the cube. The coalesce process combines all of the separate aggregation tables from previous updates into a single, more efficient set of aggregations.

**Update a Cube In Place**

When you update a cube in place, you add data and new members directly to an active cube, without disabling, stopping, or rebuilding the cube.

During and after the completion of the in-place update, existing sessions will continue to run on the old cube. When the last session ends on the old cube, the old cube is closed. After the old cube is closed, new sessions apply to the new cube. While existing sessions are connected to the old cube, new sessions are also applied to the old cube. If you do not want to wait for all open sessions to close, you can enforce a switch to the new cube. To switch to the new cube, disable the cube, close all open sessions that query that cube, and enable the cube.

The in-place cube update runs like an incremental cube update. At the end of the in-place update, the cube metadata is updated to point to the new generation folder and the old generation folder is deleted. If the old generation cannot be deleted, because an existing session has locked the files, then the next cube update will attempt to delete the old generation folder.

**Update a Cube Incrementally**

When you run an incremental cube update, you use PROC OLAP to add data and new members to a new version of the cube. After the update, the new cube is immediately available for queries under its new cube name. The previous version of the cube remains active until you disable the old cube and enable the new version.

Incremental updates are beneficial because they:

- enable testing outside of the production environment
- can be archived to maintain a history changes
- provide for rollback or review

Each version of the cube remains completely viable. You can enable any version and receive a fully functional cube that contains all of the data that was previously available in that version.

Each version of the cube is represented by a generation folder. The folder contains an aggregation table. The aggregation table contains the new members and new data that was added to the cube in that version.

The totality of data in the new version of the cube is represented by all of the generation folders and the original aggregation table from which the generations were built.

When you generate a new version of a cube, the new version is immediately available for queries under its new name. To replace the old version with the new version, using the same cube name, follow these steps:

1. Disable the cube with PROC OLAPPERATE, SAS OLAP Cube Studio, or the SAS OLAP Server Monitor.
2. Close all sessions on the old version of the cube.
3. Rename the old version of the cube.
4. Rename the new version of the cube to name of the old cube.
5. Enable the cube.
As versions accumulate, you can coalesce cubes to combine all versions into a single, more efficient aggregation table, as described in the next section.

After you create a new version of a cube, you can assign the old cube, under its new name, to a different OLAP schema for archival purposes.

You can delete old versions as you would with any other cube. Deleting a version removes its metadata. Physical data that is used by later versions is not deleted. To delete all generation folders back to the last coalesced cube, coalesce the new version of the cube.

---

**Coalescing Cubes**

Coalescing a cube combines all of the generation folders from previous versions of the cube into a single generation folder in the latest version of the cube. The old generation folders are deleted. The generation folders that are combined and deleted are those that were produced after the last time you coalesced the cube.

To coalesce a cube, follow these steps:

1. Disable the cube with SAS OLAP Cube Studio or with PROC OLAPOPERATE, or follow these steps:
   a. Open SAS Management Console.
   b. Expand the SAS OLAP Server Monitor.
   c. Expand the OLAP schema that contains the cube.
   d. Right-click the cube and select Disable.

   For more information about OLAPOPERATE and SAS OLAP Cube Studio, see the *SAS OLAP Server: User's Guide*.

2. Close all open sessions on the cube by running PROC OLAPOPERATE programs for each SAS OLAP Server that supports queries on that cube, or by displaying and closing sessions in SAS OLAP Server Monitor.

3. Coalesce the cube using the COALESCE option in PROC OLAP.

4. When the coalesce operation is complete, enable the cube.

---

**Deleting Cubes**

Cube deletion takes place in PROC OLAP and SAS OLAP Cube Studio. If you delete cubes, that have not been updated, then the deletion operation removes cube metadata and physical files. For cubes that have undergone either in place or incremental update, the deletion of old versions and generation folders occurs programmatically. Manual file deletion is not required.

For cubes that have undergone in-place updates, the next in-place update will remove all old generation folders.

For cubes that have received incremental updates, deletion of metadata and physical files takes place as part of the coalesce process.

---

**Authorizing Access to SAS OLAP Servers**

To operate SAS OLAP Servers, you need Administer permission. Unrestricted access is not required, and no specific role or capability is required.
For access to all aspects of SAS Management Console other than server operation, OLAP administrators need to be members of the role Management Console: Advanced. This role is required to display the SAS OLAP Server Monitor under the Monitoring node in the Plug-ins tab.

Users of SAS OLAP Cube Studio need readMetadata and writeMetadata permissions. Users of cube viewers need Read and readMetadata permissions, but writeMetadata might not be necessary.

Default roles are available for association with users of SAS cube viewers. If you, as the OLAP administrator, are a member of the role SAS Metadata Server: User Administration, you can, as needed, add cube viewer users to the roles Add-In for Microsoft Office: OLAP and Enterprise Guide: OLAP.

To read and update the authorizations for SAS OLAP Servers, follow these steps:
1. Open SAS Management Console.
2. Expand the Server Manager.
3. Right-click the application server, logical server, or server instance and select Properties.
4. In the Properties window, select the Authorization tab.

For more information about security concepts and tasks, see the SAS Intelligence Platform: Security Administration Guide. Of particular interest is the material that deals with the protection of server definitions in metadata.

### Authorizing Access to OLAP Cubes and Cube Data

In SAS Management Console, the Authorization tabs of cubes and OLAP schemas display the permissions that apply to those objects. With appropriate permission, you (the OLAP administrator) can grant or deny read or write permission to users, roles, and groups.

You can also control access to cube data, so that a single cube provides different data for different users. You can prevent access to specified dimensions, hierarchies, and levels, and you can define permission conditions to filter cube data within dimensions.

To set permission conditions on a cube, use the MDX Expression Builder in SAS Management console, or open the cube’s Authorization tab in SAS OLAP Cube Studio. For details and procedures, see the “OLAP Member-Level Permissions” chapter in the SAS Intelligence Platform: Security Administration Guide.

### Change Permissions and Disable Cubes Using SAS OLAP Cube Studio

In SAS OLAP Cube Studio, you need Administer permission on both the cube and the client’s SAS OLAP Server in order to change cube permissions and enable and disable cubes.

In SAS OLAP Cube Studio, to find the SAS OLAP Server to which the client is connected, select Tools ▶️ Options and refer to the Server field.

To view and change user permissions on the SAS OLAP Server, display the Properties window in SAS Management Console and select the Authorization tab.

### Monitoring SAS OLAP Servers

In SAS Management Console, information about the status of SAS OLAP Servers is provided in the Server Manager and in the SAS OLAP Server Monitor. In either case,
you select the server instance (not the logical server) to display status information in the right pane.

When you select an OLAP server in the Server Manager, it displays information about connections, clients, sessions, options and values, available loggers, and the text of the currently enabled log.

The SAS OLAP Server Monitor initially displays session information. You can select sessions to display query information. You can also manage sessions and queries.

Managing OLAP Sessions and Queries

Use the SAS OLAP Server Monitor in SAS Management Console to display information or close active client (cube viewer) sessions and the queries that are being processed in those sessions.

To display sessions, connect to the OLAP server. Current sessions appear in the right pane. For definitions of the displayed fields, select Help ➤ Help on SAS OLAP Server Monitor. In the Help contents, select About Sessions.

To display queries, first display a session, and then double-click the session to see lists of data queries and metadata queries. Data queries return to the client a result set that consists of requested cube data. Metadata queries return to the client-requested metadata, such as a cube description, rather than cube data.

To close sessions or queries, right-click and select Close.

Logging SAS OLAP Servers

By default, SAS OLAP Servers create a new rolling log file on a daily basis. The rolling log is also displayed in the Log tab of the OLAP Server, in the Server Manager of SAS Management Console.

An ARM log file is created at server start or restart. The ARM log is normally disabled. Enable the ARM log only when testing or tuning cubes, when both the cube and the OLAP server are outside of the production environment, as described in “Enabling ARM Logs in SAS OLAP Servers,” in the SAS Intelligence Platform: System Administration Guide.

Tuning SAS OLAP Servers with Advanced Server Options

To display the advanced server options for a SAS OLAP Server, follow these steps:

1. Within SAS Management Console, expand the nodes under the Server Manager until you can see your SAS OLAP Server. The server components represent the actual machines that the SAS OLAP Servers are running on.
2. Right-click the server and select Properties.
3. In the Properties window, select the Options tab.
4. On the Options tab, select Advanced Options.

In the Advanced Options window, tune your servers on the Performance, Cache, and Query Thread Pool tabs. Use the other tabs (Debug Query, Debug Server, and Journals) only under the direction of SAS technical support, outside of the production environment, to generate detailed log information. The logging process severely limits server performance.
Tune the Cube Cache

The cube cache stores an in-memory copy of the cube’s metadata. The metadata describes the calculated members and named sets that are used to parse the MDX query syntax. The metadata does not include any disk-resident aggregations.

As the server processes a query, the server first checks the cube cache to determine whether the cube metadata is in memory. If the cube metadata is in memory, the server uses the cached metadata. If the cube metadata is not in memory, the server loads the metadata from the SAS Metadata Server.

Cubes are added to the cache as they are queried. Cubes remain in the cache until the OLAP server stops, or until the cache reaches its maximum number of cubes. After the limit it reached, new queries on new cubes cause the new cube’s metadata to replace the metadata of the oldest cube in cache (first in, first out).

The cube cache is implemented as least recently used. As the cache becomes full, cubes are removed based on usage.

The default limit on the number of cubes in the cache is 20. To change this value, use the field Maximum number of cubes in cache in the Cache tab of the Advanced Options window. Restart your OLAP server to activate the new value.

Tune the Subquery Caches

The Cache tab in the Advanced Options window allows you to set the maximum size of the subquery caches. You can also enable and disable the caching of empty intermediate result sets. By default, the maximum size of each subquery cache is 5 megabytes, and the caching of empty intermediate result sets is disabled.

SAS OLAP Servers maintain a unique subquery cache for each query for the duration of the processing of that query. When a server is processing concurrent queries, server memory contains multiple subquery caches.

During query processing, the subquery caches grow in size. If the subquery caches reach a specified maximum size, the contents of the caches are paged (swapped) into temporary disk storage.

Memory is not pre-allocated for subquery caches. Paging might therefore occur before the subquery caches reach their maximum size.

Paging for the subquery caches is indicated by disk writes by the SAS OLAP Server. This is the only case where the server writes to disk, except for the logging and debugging operations that take place outside of the production environment. If you see disk input and output from the server you can do one of the following:

- change the subquery cache settings
- change the value of the MEMSIZE= system option for the server
- add physical memory to the host.

Smaller maximum sizes of the subquery caches might limit performance improvements due to memory-intensive paging to and from temporary disk storage, particularly if the caches include empty intermediate result sets.

Larger maximum sizes of the subquery caches, when combined with a large number of concurrent queries, might occupy an inefficient percentage of available server memory.

In many cases, the default maximum cache size (5 megabytes) is a good choice. It is recommended that the maximum subquery cache size not exceed 50 megabytes.

To set the maximum size of the subquery caches, use the field Memory size for subquery cache.

To cache empty subquery result sets, select the check box to show a check mark in the field Cache the empty subquery result sets. Generally, most of the set processing in OLAP queries involves very sparse matrices. For this reason, empty
subquery result sets are not cached by default. If you have plenty of available memory, or if your cube or your queries are relatively dense, then caching empty subquery result sets might improve performance.

---

**Tune the Query Thread Pool**

The query thread pool is used to efficiently assign threads to query requests that are received by a SAS OLAP Server. As threads are assigned to queries, additional threads are allocated, up to the specified maximum number of threads. If the number of query requests and active queries exceeds the maximum number of threads, requests are queued and assigned to threads as threads are reclaimed.

You can set the following parameters of the query thread pool on the **Query Thread Pool** tab of the Advanced Options window:

- **minimum number of threads in the pool.** The recommended value is 1.
- **maximum number of threads in the pool.** The recommended value is twice the number of available CPUs on the host or lower.
- **threshold number of query requests that are required before the requests are assigned to threads.**
- **time-out for thread reclamation.**
- **thread stack size.**

As with other server option changes, you need to restart your OLAP server to activate your new values.

---

**Set Values for Flattened Row in the Server Tab of the Advanced Options Window**

The **Server** tab of the Advanced Options window for SAS OLAP Servers contains two options for flattened results sets: Maximum number of flattened row and Maximum memory size for flattened rowset. Increase the size of these options if queries fail with a “flattened rowset size limit reached” error.

Most applications get their query results as multidimensional result sets. However, there are two exceptions, drill-through queries and SQL passthru queries:

<table>
<thead>
<tr>
<th>Drill-through queries</th>
<th>Drill-through queries are not really multidimensional queries; they are two-dimensional queries against a relational table. As such, they can be requested as flattened result sets only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL passthru queries</td>
<td>When using SQL to query a cube, the server always returns the data as flattened result set. This is because SQL understands rows and columns only.</td>
</tr>
</tbody>
</table>

---

**Set Values in the Performance Tab of the Advanced Options Window**

The **Performance** tab has four options that enable you to configure access to MOLAP aggregations in multidimensional databases. Three other options set limits on queries.

- **Memory available for group by operations** sets a memory allocation for MOLAP group-by operations, which are used to pre-summarize data on-demand, during queries. If a cube is pre-summarizing during queries, increasing this memory allocation might improve performance.
If a group-by operation exceeds its memory allocation, the SAS OLAP Server pages memory to the disk path that is specified in the option **Path to temporary working files**.

Note that the group-by memory is not pre-allocated, so the actual memory allocation might be limited by existing allocations.

**Number of threads to spawn**
specifies the number of threads that can be created to access MOLAP aggregations during queries. The default value 0 is preferable on multiprocessor hosts. When the value is 0, the number of threads is programmatically set to a value from 1 to 8, based on the number of processors (CPUs) on the host. Note that this value does not limit the number of threads that are used to process queries. Query threads are set on the **Query Thread Pool** tab.

**Path to temporary working files**
specifies the disk directory that received memory swaps during MOLAP group-by operations.

**Maximum segment ratio**
controls the subsetting of indexes when processing MOLAP WHERE expressions. The ratio compares the number of segments that apply to the expression to the number of segments that do not apply to the expression. When the ratio exceeds the specified maximum, a subset index is not created before the expression is applied to the segments.

**Maximum number of tuples in a set**
sets the maximum size of the result sets that are sent to clients in response to queries. The default value is 1 million tuples.

**MDX query timeout**
automatically closes stale queries. No default value is provided.

**Optimize queries that use the NONEMPTY and CROSSJOIN function**
compares performance with or without optimization. Deselect this option to compare performance without optimization.

---

**Refreshing Cube Metadata for Calculated Members and Named Sets**

You can synchronize the calculated members and named sets in metadata with the data that is stored in the cube cache of a SAS OLAP Server by selecting **Actions** > **Refresh Cubes** in SAS Management Console. Another method is to select cubes in the SAS OLAP Server Monitor, right-click, and select **Refresh Cubes**. You can also select **Refresh Cube** in SAS OLAP Cube Studio.

To refresh cubes you must be connected to the SAS OLAP Servers and have the Administer permission.

**Refresh Cubes** does not add or delete aggregations, change display names, or change the value of the SECURITY_SUBSET option (which enables and disables member-level permissions). To make these changes, you do not need to rebuild the cube, but you do need to close all active sessions. Use **Stop** or **Pause**, or **Quiesce** before you use SAS OLAP Cube Studio or PROC OLAP to make these changes.

For information about updating all of the data in a cube, without rebuilding the cube, see the **SAS OLAP Server: User's Guide**.

Note that selecting **Refresh** in the Server Manager or SAS OLAP Server Monitor refreshes server connections and the **Folders** tab in SAS Management Console. **Refresh** does not synchronize calculated members or named sets.
Administering OLAP Schemas

OLAP schemas logically connect OLAP cubes to SAS OLAP Servers. Each cube appears in one schema. Each SAS OLAP Server is assigned to an OLAP schema. More than one server can be assigned to each schema.

To display schemas in SAS Management Console, select the Plug-ins tab, expand Monitoring, and expand the SAS OLAP Server Monitor. The schemas are displayed beneath the OLAP servers that are assigned to the schemas. Expand the schema folder to display the cubes that comprise the schema.

Schemas are also available in the Inventory tab, in the Shared Data folder.

To create OLAP schemas or assign servers to schemas, use the OLAP Schema tab in the Properties window of the SAS Application Server, as described in “Create or Assign an OLAP Schema” in the SAS Intelligence Platform: Data Administration Guide.

You can use SAS OLAP Cube Studio to create, assign, and delete schemas. You can also move a cube from one schema to another, as described in the SAS OLAP Server: User’s Guide.
Overview of System Options for SAS Application Server Components

There are several SAS system options available for you to use with application server components. The topics that follow discuss each available option in detail:

- OBJECTSERVER
- OBJECTSERVERPARMS
- SECPACKAGE
- SECPACKAGELIST
- SSPI

OBJECTSERVER System Option

Specifies whether SAS is to run as an Integrated Object Model (IOM) server.

Valid in: configuration file, SAS invocation  
Category: Environment control: Initialization and operation  
Default: NOOBJECTSERVER  
PROC OPTIONS GROUP= EXECMODES  
Applies to these servers: workspace, stored process, OLAP, metadata  
See: OBJECTSERVERPARMS System Option

Syntax

-objectserver

Syntax Description
-**objectserver**
  when specified, SAS runs as an IOM server.

**Details**

An IOM server is a noninteractive SAS session that is run with the OBJECTSERVER system option. The spawner sets OBJECTSERVER for the SAS IOM servers that it invokes. In order to make it easy to specify the command, the server can be started by using a simple command with an option to connect back to the metadata server to obtain additional IOM-specific options.

You can specify the server startup command in several locations:
- system command line
- script
- metadata (server definition in SAS Management Console)

The general form of the server startup command is:

```
SAS-exec -objectserver other-system-options -objectserverparms "object-server-parameters"
```

- **SAS-exec** is the absolute path to the SAS executable. For example:
  - Windows: `C:\Program Files\SAS\SASFoundation\9.2\sas`
  - UNIX: `/usr/local/bin/SAS/SASFoundation/9.2/sas`

- **-objectserver**
  launches this SAS session as an IOM server.

  *Note:* In configuration files on z/OS, do *not* precede system options with a hyphen. Also, an equal sign must precede the first parameter that follows the OBJECTSERVERPARMS keyword. For example:

  ```
  objectserver objectserverparms="cel=credentials protocol=bridge port=8561"
  ```

- **other-system-options**
  are optional, additional system options. System options that are typically used for servers include options such as: LOGCONFIGLOC, NOTERMINAL, and NOLOGO. For complete information about system options, see the SAS Language Reference: Dictionary.

- **-objectserverparms "object-server-parameters"**
  are IOM-server-specific options that are passed to the server by the OBJECTSERVERPARMS system option. For more information, see “OBJECTSERVERPARMS System Option” on page 134.

  *Note:* For SAS Workspace Servers that run on UNIX, it is sometimes necessary to call the SAS start-up command by using a wrapper script. For more information, see Chapter 11, “Managing Workspace Servers and Stored Process Servers,” on page 87.

The server startup command is obtained as follows:
- When the server is started by a spawner, the startup command is stored in SAS metadata.

  In the SAS metadata, there is one metadata field for the SAS startup command and system options, and another field for the object server parameters. The object
spawner combines these two fields, along with connection information and some spawner internal object server parameters, to create the complete SAS command. The object spawner then passes this command to the operating environment.

The object spawner then passes this command to the operating environment. However, SAS Workspace Servers, and any OLAP server can connect back to the SAS Metadata Server in order to obtain additional object server parameters and connection information (such as protocol engine and port number). (Some object server parameters cannot be obtained from the metadata. For more information, see “OBJECTSERVERPARMS System Option” on page 134.)

When object server parameters are specified in the metadata, if there are any object server parameters that are also specified in the command, then the object server parameters in the command take precedence over those that are stored in the metadata.

Regardless of how the server is started, workspace servers, stored process servers, and OLAP servers, by default, also connect back to the metadata server in order to obtain configuration information, such as pre-assigned libraries, that is associated with the SAS Application Server.

The following table summarizes the ways that the SAS command, system options, and object server parameters can be specified for each type of IOM server.

<table>
<thead>
<tr>
<th>Server</th>
<th>Spawner launched?</th>
<th>Use of SERVER parameter</th>
<th>Obtainable from metadata?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Command</td>
<td>Object server parameters</td>
</tr>
<tr>
<td>Workspace server</td>
<td>Required</td>
<td></td>
<td>Yes (Spawner retrieves)</td>
</tr>
<tr>
<td>Stored process server</td>
<td>Required (Load-balanced)</td>
<td>Spawner supplied</td>
<td>Yes (Spawner retrieves)</td>
</tr>
<tr>
<td>OLAP server</td>
<td>Not allowed</td>
<td>Required</td>
<td>No</td>
</tr>
<tr>
<td>Metadata server</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>No</td>
</tr>
</tbody>
</table>

¹ Object server parameters that are stored in metadata supplement the command-line object server parameters if the SERVER parameter is used.

**Note:** When you start the server with a script, some object server parameters, such as DNSMATCH, cannot be obtained from the metadata. Do not enter these object server parameters in your metadata. For details, see “OBJECTSERVERPARMS System Option” on page 134.
Example

This example shows how OBJECTSERVER can be used in a configuration file used to start the metadata server:

```plaintext
-objectserver
-objectserverparms "cel=credentials protocol=bridge port=8561 classfactory=0217E202-B560-11DB-AD91-001083FF6836 trustsaspeer=C:\SAS\FoundationServers\Lev1\SASMain\MetadataServer\trustedPeers.xml"
```

**Note:** In configuration files on z/OS, do not precede system options with a hyphen. Also, an equal sign must precede the first parameter that follows the OBJECTSERVERPARMS keyword. For example:

```plaintext
objectserver objectserverparms="cel=credentials protocol=bridge port=8561"
```

See Also

System Options:

“OBJECTSERVERPARMS System Option” on page 134
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Valid In</th>
</tr>
</thead>
<tbody>
<tr>
<td>PORT(^1)</td>
<td>Metadata, Command Line</td>
</tr>
<tr>
<td>PROTOCOL(^2)</td>
<td>Metadata, Command Line</td>
</tr>
<tr>
<td>SERVER(^1)</td>
<td>Command Line (only)</td>
</tr>
<tr>
<td>SERVICE(^1)</td>
<td>Metadata, Command Line</td>
</tr>
<tr>
<td>TIMEOUTSECONDS(^2)</td>
<td>Metadata, Command Line</td>
</tr>
<tr>
<td>TRUSTSASPEER</td>
<td>Metadata, Command Line</td>
</tr>
</tbody>
</table>

1. Do not store this parameter in metadata for workspace servers and stored process servers. The object spawner automatically adds this parameter when it starts these servers.
2. Use TIMEOUTSECONDS with OLAP servers or stored process servers only. TIMEOUTSECONDS does not apply to workspace servers or to metadata servers.

**Details**

All object server parameters are applicable on the command line that starts the server:

- In configuration files on z/OS, do not precede system options with a hyphen. Also, an equal sign must precede the first parameter that follows the OBJECTSERVERPARMS keyword. For example:
  ```
  objectserver objectserverparms="cel=credentials protocol=bridge port=8561"
  ```

- For servers that are started by the object spawner, the object server parameters come from your server definition in the SAS Metadata Repository. (The server definition is located under the Server Manager plug-in of SAS Management Console. In the server definition, select the **Options** tab to locate the **Object Server Parameters** field).

- For servers that are not spawned (such as those that are run from command scripts or those that are run as services or daemons) you use the `sas -objectserver -objectserverparms "parameters"` invocation to specify the object server parameters on the command line.

To simplify the command that is needed to invoke an IOM server, the server start-up sequence by default connects back to the metadata server in order to fetch additional information, including object server parameters. You can fetch object server parameters from metadata as follows:

- When you start the server with a script, some object server parameters cannot be obtained from the metadata. (In the preceding table, only those parameters that are designated as “Metadata” in the “Valid In” column can be stored in the metadata.)

- When you start the server with a spawner, all object server parameters can be obtained from the metadata.

- Certain object server parameters are automatically added by the object spawner when it starts workspace and stored process servers. Therefore, the following parameters should not be stored in metadata for workspace and stored process servers: CLASSFACTORY, CLIENTENCRYPTIONLEVEL, PORT, PROTOCOL, SERVER, and SERVICE.

**Note:** Object server parameters that are specified on the command line always override object server parameters obtained from a SAS metadata repository.
**CLASSFACTORY**

By default, an IOM server hosts the Workspace class. If you want to specify an alternate class to expose as the top-level class, use CLASSFACTORY to identify the class to IOM.

When using the SERVER object server parameter, the classfactory does not need to be specified because it is obtained from the logical server definition in the SAS Metadata Repository.

This option is primarily used to start the SAS Metadata Server.

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

```bash
--objectserverparms "classfactory | clsid = class-identifier"
```

**Valid in:** Metadata, Command Line
**Alias:** clsid
**Values Supported:** 36-character class identifier

*class-identifier*

specifies the 36-character class ID number that specifies the type of server to instantiate. (For example, 0217E202-B560-11DB-AD91-001083FF6836 specifies a SAS Metadata Server). An IOM server exposes one top-level class through its class identifier.

**CLIENTENCRYPTIONLEVEL**

The CLIENTENCRYPTIONLEVEL parameter specifies the degree of encryption for the IOM server to use when making outbound calls. This option is used only by the bridge protocol engine.

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

```bash
--objectserverparms "clientencryptionlevel | cel | credentials | everything"
```

**Valid in:** Command Line (only)
**Alias:** cel
**Values Supported:** none, credentials, everything

*NONE*

use no encryption.

*CREDSENTIALS*

(default) encrypt only a user’s credentials when establishing a client session.

*EVERYTHING*

encrypt all data (including a user’s credentials) sent during a client session.

**DNSMATCH**

The object spawner replaces all instances of the DNSMATCH value with the local machine name in its list of servers. This option is necessary if your network configuration resolves a single DNS alias to multiple machines that run SAS servers.

For example, you configure SAS OLAP servers on two different machines: n1.my.org and n2.my.org. The DNS alias srv.my.org resolves to both of these machines, so clients can send a request to the alias and a server on one of the two machines will receive it. To support this configuration, specify **DNSMATCH=srv.my.org** in the server start-up command on each machine.

*Note:* For workspace servers and stored process servers, this parameter is provided automatically when you specify the **-dnsMatch** object spawner option.

△
-objectserverparms "dnsmatch | dns"
  
  **Valid in:** Command Line (only)
  **Alias:** dns
  **Values Supported:** Not applicable

  DNSMATCH | DNS
  specifies a DNS alias that will be accepted by the server as a match for the local machine name.

**NOMETAAUTOINIT**

The NOMETAAUTOINIT parameter specifies that the IOM server should not connect back to the SAS Metadata Server during startup in order to obtain additional configuration information such as object server parameters and pre-assigned libraries. In SAS 9.2, IOM servers connect to the metadata server by default (METAAUTOINIT is on). The NOMETAAUTOINIT parameter is applicable only if you have specified your logical server with the SERVER object server parameter. For further details, see “Add System Options to the Workspace Server Launch Command” on page 97.

-objectserverparms "nometautoinit | metaautoinit"
  
  **Valid in:** Metadata, Command Line
  **Alias:** Not applicable
  **Values Supported:** Not applicable

**PORT**

The PORT parameter specifies the TCP/IP port on which the IOM bridge protocol engine listens for client connections.

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

-objectserverparms "port = port-number"
  
  **Valid in:** Metadata, Command Line
  **Alias:** Not applicable
  **Values Supported:** TCP/IP numeric value

  *port-number*
  is a valid TCP/IP port number.

**PROTOCOL**

The PROTOCOL parameter specifies the protocol engines to launch in server mode. Server mode indicates that the protocol engines will listen for client connections. If you specify (com, bridge) then a multi-user server can simultaneously support clients that use different protocols.

*Note:* COM is not supported on all servers. 

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

-objectserverparms "protocol = bridge | com | (com, bridge)"
BRIDGE is a protocol engine that you can launch in server mode.

COM is a protocol engine that you can launch in server mode.

SERVER

The SERVER parameter can be used to retrieve many of the OBJECTSERVERPARMS options (including PORT, PROTOCOL, and CLASSFACTORY) from a SAS Metadata Repository.

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

–objectserverparms "server = 'logical-server-name' | 'omsobj:LogicalServer/object-ID'"

Valid in: Command Line (only)

Alias: Not applicable

Values Supported: ’Logical server name, omsobj:LogicalServer/object-ID’

’logical-server-name’
the logical server name for the IOM run-time and server application to use to locate configuration information in a SAS Metadata Repository. Enclose in single quotation marks, as shown in this example: SERVER='sasapp - Logical OLAP Server'.

’omsobj:LogicalServer/object-ID’
the object definition ID that is generated for the logical server for the IOM run-time and server application to use to locate configuration information in a SAS Metadata Repository. Enclose in single quotation marks.

To determine the generated object ID, in SAS Management Console, select the logical server definition, and then select File → Properties from the menu bar. Use the Uniform Resource Identifier (URI) formatted value that is shown in the ID field as the argument for the object ID, as shown in this example: SERVER=’omsobj:LogicalServer/01234567.01234567’.

SERVICE

The SERVICE parameter specifies the TCP service name for the port that the IOM Bridge protocol engine will use to listen for connections from clients.

Do not specify this option with spawned servers; it will be supplied automatically by the spawner.

–objectserverparms "service = service-name"

Valid in: Metadata, Command Line

Alias: Not applicable

Values Supported: TCP service name

service-name
a valid TCP service name (for example, from /etc/services on a UNIX system).

TIMEOUTSECONDS

The TIMEOUTSECONDS parameter specifies the time interval that an OLAP server or a stored process server waits before it stops a client process and cleans up the server run-time environment context.
Note: The TIMEOUTSECONDS parameter does not apply to the workspace servers or to the sas metadata server.

-**OBJECTSERVERPARMS** "timeoutseconds = seconds"

  **Valid in:** Metadata, Command Line
  **Alias:** Not applicable
  **Values Supported:** numeric value that represents seconds

  seconds

  the interval in seconds that an OLAP server or a stored process server waits before stopping a client process. seconds is a number that is equal to or greater than five.

**TRUSTSASPEER**

The TRUSTSASPEER parameter enables SAS peer sessions from IOM servers to connect as trusted peer sessions. If you specify a blank or empty file, then you disable trusted peer support.

Note: This parameter is valid only for the command that starts the SAS Metadata Server.

For more information, see “Trusted Peer Connections” in the SAS Intelligence Platform: Security Administration Guide.

-**OBJECTSERVERPARMS** "trustaspeer | tsaspeer = pathname"

  **Valid in:** Metadata, Command Line
  **Alias:** tsaspeer
  **Values Supported:** XML file

  pathname

  is a pathname to a file containing XML that describes the allowable trusted peer connections, the users who can connect, and the machines from where the connections can be established.

  Enclose the pathname in single quotation marks if there is a space in the path.

  For example:

  'C:\SAS\9.2\FoundationServers\Lev1\SASMain\MetadataServer\trustedPeers.xml'

**Example**

This example shows how the OBJECTSERVERPARMS system option can be used in a configuration file that is used to start the metadata server:

-objectserver
-objectserverparsms "cel=credentials protocol=bridge port=8561 classfactory=0217E202-B560-11DB-AD91-001083FF6836 trustaspeer=C:\SAS\FoundationServers\Lev1\SASMain\MetadataServer\trustedPeers.xml"

Note: In configuration files on z/OS, do not precede system options with a hyphen. Also, an equal sign must precede the first parameter that follows the OBJECTSERVERPARMS keyword. For example:

-objectserver objectserverparsms="cel=credentials protocol=bridge port=8561"

See Also
**SECPACKAGE System Option**

Identifies the security package that the IOM server uses to authenticate incoming client connections.

**Valid in:** configuration file, SAS invocation, metadata

**Category:** Environment control: Initialization and operation

  System Administration: Security

**PROC OPTIONS GROUP=** EXECMODES

  SECURITY

**Default:** negotiate

**Restriction:** Windows operating environment

**Applies to these servers:** workspace, stored process, OLAP, metadata, table, CONNECT

**See:** SECPACKAGELIST System Option

  SSPI System Option

---

**Syntax**

-secpackage "package-name" | "negotiate"

**Syntax Description**

"package-name"

specifies the security package that the IOM server should use to authenticate incoming client connections.

  Enclose the security package name within double quotation marks (".

"negotiate"

(default) enables the server to present a set of valid security packages (through the SECPACKAGELIST system option) that the server uses to find a match with an incoming client connection. If the client specifies a security package in the list, then the server attempts to authenticate the client using the matched security package.

  Enclose negotiate within double quotation marks (".

**Details**

The SECPACKAGE system option identifies the security package that the IOM server uses to authenticate incoming client connections.

Security packages are provided by vendors. Therefore, the package names are not validated against a list of names. Names need to be entered (casing and exact spelling) per instructions from the vendor.

When you specify -SECPACKAGE "negotiate", the IOM server uses the SECPACKAGELIST option to determine which package to use. SECPACKAGELIST specifies the names of the security packages that can be used by the server to
authenticate incoming client connections. SECPACKAGE and SECPACKAGELIST are required to support single sign-on (SSO) to IOM servers. The client should initialize with a matching package name. Specifying an unknown package name (such as "disable") will effectively disable SSO.

In order to use SECPACKAGE, you must also specify **SSPI**.

### Examples

**EXAMPLE 1:**

In the following example, the IOM server specifies either Kerberos or NTLM security for authenticating incoming client requests:

```
-sspi
-secpackage "negotiate"
-secpackagelist "Kerberos,NTLM"
```

**EXAMPLE 2:**

In the following example, the IOM server specifies Kerberos security only for authenticating incoming client requests:

```
-sspi
-secpackagelist "kerberos"
```

In the preceding example, SECPACKAGE does not have to be specified because it defaults to **negotiate**. The only protocol in the list to negotiate is Kerberos. Therefore, all clients that connect to the server must use Kerberos or fail the connection. It is important that the protocols of both the client and server match. The client is also forced to use Kerberos if the server displays only Kerberos in the package list.

**EXAMPLE 3:**

In the following example, the IOM server specifies NTLM security only for authenticating incoming client requests:

```
-sspi
-secpackagelist "ntlm"
```

In the preceding example, SECPACKAGE does not have to be specified because it defaults to **negotiate**. The only protocol in the list to negotiate is NTLM. Therefore, all clients that connect to the server must use NTLM or fail the connection. It is important that the protocols of both the client and server match. The client is also forced to use NTLM if the server displays only NTLM in the package list.

### See Also

System Options:

- “SECPACKAGELIST System Option” on page 141
- “SSPI System Option” on page 143

---

**SECPACKAGELIST System Option**

Specifies the security authentication packages used by the server.
Valid in: configuration file, SAS invocation, metadata
Category: System Administration: Security
           Environment control: Initialization and operation
PROC OPTIONS GROUP= EXECMODES
           SECURITY
Default: "Kerberos,NTLM"
Restriction: Windows operating environment
Applies to these servers: workspace, stored process, OLAP, metadata, table, CONNECT
See: SECPACKAGE System Option
     SSPI System Option

Syntax
-secpackagelist "package-name-1,[package-name-2],...]"

Syntax Description

"package-name"
Identifies the security package that is used by the server in order to authenticate incoming client connections. The default is "Kerberos,NTLM". Enclose the security package name within double quotation marks ("). Delimit an additional package name with a comma (,).

Details
The SECPACKAGELIST system option, in conjunction with SECPACKAGE, identifies to the IOM server one or more security packages that can be used to authenticate incoming client connections. The default value of SECPACKAGELIST is Kerberos and NTLM.

To use the SECPACKAGELIST system option, SECPACKAGE must be set to negotiate. The IOM server requires these two security package options to support single sign-on (SSO) to IOM servers. The connecting client should initialize with a security package name that matches what you have specified on the server. The negotiate value allows the client and server to negotiate a site-specific package to use.

Examples

EXAMPLE 1:

In the following example, the IOM server specifies either Kerberos or NTLM security for authenticating incoming client requests:

-sspi
-secpackage "negotiate"
-secpackagelist "Kerberos,NTLM"

EXAMPLE 2:

In the following example, the IOM server specifies Kerberos security only for authenticating incoming client requests:
-sspi
-secpackage "kerberos"

In the preceding example, SECPACKAGE does not have to be specified because it defaults to `negotiate`. The only protocol in the list to negotiate is Kerberos. Therefore, all clients that connect to the server must use Kerberos or fail the connection. It is important that the protocols of both the client and server match. The client is also forced to use Kerberos if the server displays only Kerberos in the package list.

**EXAMPLE 3:**

In the following example, the IOM server specifies NTLM security only for authenticating incoming client requests:

-sspi
-secpackage "ntlm"

In the preceding example, SECPACKAGE does not have to be specified because it defaults to `negotiate`. The only protocol in the list to negotiate is NTLM. Therefore, all clients that connect to the server must use NTLM or fail the connection. It is important that the protocols of both the client and server match. The client is also forced to use NTLM if the server displays only NTLM in the package list.

**See Also**

System Options:
“SECPACKAGE System Option” on page 140
“SSPI System Option” on page 143

---

**SSPI System Option**

Identifies support for the Security Support Provider Interface for SSO connections to IOM servers.

*Valid in:* configuration file, SAS invocation, metadata

*Category:* System Administration: Security

PROC OPTIONS GROUP= SECURITY

*Default:* NOSSPI

*Restriction:* Windows operating environment

*Applies to these servers:* workspace, stored process, OLAP, metadata, table, CONNECT

*See:* SECPACKAGE System Option

SECPACKAGELIST System Option

---

**Syntax**

-sspi | -noSSPI

**Syntax Description**
-SSPI
  Support the Security Support Provider Interface (SSPI).

-NOSSPI
  (Default) Do not support SSPI.

Details

Use this option to identify support for the Security Support Provider Interface for single
sign-on (SSO) connections to IOM servers.

Example

In the following example, the IOM server specifies Security Support Provider
Interface for SSO connections. By default, the IOM server uses either Kerberos or
NTLM security for authenticating incoming client requests:

-sspi

See Also

System Options:
  “SECPACKAGE System Option” on page 140
  “SECPACKAGELIST System Option” on page 141
Appendixes

Appendix 1. . . . . . Error Messages 147

Appendix 2. . . . . . Recommended Reading 161
Object Spawner Error Messages

Here are error messages that might be reported by the object spawner and explanations to correct their cause. Some of these messages you will find only in the object spawner log. For more information about changing the spawner logging level, see “Configure Object Spawner Logging” on page 101. If you are unable to resolve the error, contact SAS Technical Support.

- **The configuration source value conflicts with the previously specified configuration source value.**
  
  **Explanation:**
  Multiple configuration files have been specified for the object spawner.
  
  **Resolution:**
  Check your configuration and ensure that only a single configuration option is used for your object spawner.

- **Unable to retrieve the name definition or definitions.**
  
  **Explanation:**
  The object or objects specified could not be found.
  
  **Resolution:**
  Check your configuration and command line and try again.

- **The server named name is not unique to the listen port. Therefore only the first occurrence of this server will be used.**
  
  **Explanation:**
  Two or more servers have been defined to use the same listen port. The object spawner is unable to distinguish between these two servers that are defined on the same port. Therefore, only the first server defined on this port will be used by the object spawner.
  
  **Resolution:**
  Check your configuration and change the port for the server listed in this message.

- **Objspawn was unable to initiate the listen on port.**
  
  **Explanation:**
The object spawner could not listen on the specified port. In most cases this means that the port is already in use.

Resolution:
Check to see that no other application is currently using the specified port. Alternatively, update the port that the object spawner is trying to use to a port that is not currently being used.

- **Port is reserved for objspawn administration and cannot be used as a server listen port.**
  
  Explanation:
  The object spawner cannot use the same port for administration, also known as the operator port, and as a server listen port.
  
  Resolution:
  Check your configuration and ensure that the operator port for the object spawner and the ports for all servers are different.

- **Port is reserved for objspawn to launched server communication. Therefore this server definition will not be included.**
  
  Explanation:
  The specified port is being used by the object spawner for internal communication and cannot be used as a server listen port.
  
  Resolution:
  Change the specified port for this server to a different port.

- **Port is reserved for UUID Generator requests. Therefore this server definition will not be included.**
  
  Explanation:
  The specified port is being used by the object spawner to fulfill UUID generator requests. It cannot be used as a server listen port.
  
  Resolution:
  Update the port for the server or the UUID generator so that these services are defined on different ports.

- **No configuration was specified.**
  
  Explanation:
  No configuration information can be found for the object spawner.
  
  Resolution:
  Check the command line and make sure that some configuration option was specified for the object spawner.

- **The SAS Metadata Server configuration file failed to process.**
  
  Explanation:
  There is a problem in the object spawner’s configuration file.
  
  Resolution:
  Check the configuration file to make sure it is correct. Contact Tech Support for assistance.

- **The metadata returned from the SAS Metadata Server was empty and failed to process. This could be due to there being no spawner definition in the metadata for this machine. Or, if the spawner name was specified, the name specified did not match any spawner definitions in the metadata. A spawner definition for this machine did not exist in the processed configuration. Objspawn cannot continue without a spawner definition. The name spawner definition did not exist in the processed configuration. Objspawn cannot continue without a spawner definition.**
Explanation:
No object spawner definition can be found in the metadata.

Resolution:
Ensure that an object spawner definition exists in the metadata. If command 
`-sasspawnercn` or `-sscoption` is used on the command line, ensure that an
object spawner definition of that name exists in the metadata.

☐ An unknown option name was specified

Explanation:
The specified option is unknown to the object spawner.

Resolution:
Check your command line or configuration for this option and remove it.
Contact Tech Support for assistance.

☐ The attribute name was specified more than once. The previously specified value
will be used.

Explanation:
The attribute or option was found multiple times in the configuration source.
The first instance will be used.

Resolution:
Check your configuration for this attribute and only specify it once.

☐ The value (value) specified for the attribute name is invalid. The value must be
corrected for Objspawn to initialize properly.

Explanation:
The attribute has an invalid value.

Resolution:
Correct the attribute’s value and restart the object spawner.

☐ Objspawn encountered errors during results processing.

Explanation:
Errors occurred during the object spawner’s initialization.

Resolution:
Check the object spawner’s log for information about what caused the
problem. Correct the problem and restart the object spawner.

☐ Objspawn cannot proceed with the specified Telnet administrator password. The
password must be corrected for Objspawn to initialize properly. Objspawn does not
allow the administrator password to be all asterisks. The password must be
corrected for Objspawn to initialize properly. Objspawn does not allow the
administrator password to be all asterisks. If the password is not recorded as all
asterisks in the SAS Metadata Server, then the identity Objspawn used to connect
to the SAS Metadata Server does not have permission to view the password value.

Explanation:
The object spawner found an operator or administrator password in its
configuration that it cannot use.

Resolution:
Check the password that has been specified for the object spawner Telnet
access. If this object spawner is defined in metadata, this password belongs
to the user that is specified on the Initialization tab of the object spawner
definition. Contact Tech Support for assistance.

☐ The credentials specified for the name (ID) server definition failed to authenticate.
Therefore this server definition will not be included. A failure occurred during the
retrieval of the authenticated credentials for the name (ID) server definition.
**Explanation:**
The specified credentials for the specified server cannot be authenticated. In order to avoid further errors and a possible account lockout, the object spawner will not use this definition.

**Resolution:**
Check the credentials that are specified for this server, and make sure that they are correct. Ensure that the user name is a valid user name for the system that you are using and that the password is valid for that user. After correcting the problem, restart your object spawner.

**Error:**
The name (ID) server definition is not defined for this machine and will be ignored.

**Explanation:**
The server definition specified is not defined for the machine that the object spawner is currently running on. This server will not be used by the object spawner.

**Resolution:**
If the specified server is needed on the machine that this object spawner is running on, make sure that the server definition has this machine’s name as part of its definition.

**Error:**
Objspawn was unable to locate a server definition. Objspawn is exiting.

**Explanation:**
No valid server definition can be found by the object spawner. This might mean that some servers have configuration issues, or that the object spawner does not have any servers configured to be used.

**Resolution:**
Check the object spawner log and look for errors or warnings pertaining to servers that might be defined. Correct these issues and restart your object spawner. If no errors or warnings are found, check to make sure that your object spawner has servers associated with it.

**Error:**
The cluster name (ID) is configured to use server side pooling. However, no port bank exists in this spawner to use with server side pooling.

**Explanation:**
The specified cluster contains a Pooled Workspace Server. For a Pooled Workspace Server to work correctly, the object spawners that are associated with the Pooled Workspace Server must contain a set of ports known as a port bank.

**Resolution:**
Check your object spawner definition and go to the Operator connection. From the **Options** tab you will be able to add ports to the object spawner’s port bank. Save your changes and restart your object spawner.

**Error:**
Objspawn is unable to contact the metadata server.

**Explanation:**
The object spawner cannot connect to the specified metadata server in the configuration file or on the command line.

**Resolution:**
Make sure that the configuration file or the command line points to the correct metadata server. Also verify that the metadata server is running.

**Error:**
The cluster definition name (ID) is invalid. Therefore this cluster definition will not be included.

**Explanation:**
Errors were found during the processing of the specified cluster.

Resolution:
Check the object spawner log for other errors related to the specified cluster. Correct these errors and restart your object spawner.

☐ The configuration for this spawner is invalid. Please check the configuration and try again.

Explanation:
Errors were found during the processing of the object spawner’s configuration.

Resolution:
Check the object spawner log for other errors related to the spawner’s configuration processing. Correct these errors and restart your object spawner.

☐ The machine name cannot be found. This machine will be ignored.

Explanation:
The specified machine name cannot be found. The machine might not exist, or the machine name might not be entered correctly.

Resolution:
Check the name of the machine to ensure that it is correct.

☐ Objspawn does not allow Telnet administrator access when the administrator password is the ASCII character specified. The Telnet administrator access will be disabled. Objspawn does not allow Telnet administrator access when the administrator password begins with the ASCII string “SASI”. The Telnet administrator access will be disabled.

Explanation:
The specified password for Telnet administrative access cannot be used. The Telnet administrative interface will be disabled.

Resolution:
Change the administrative password of the object spawner, and restart the object spawner to enable Telnet access.

☐ The name (ID) server definition did not specify a command to use. Therefore this server definition will not be included.

Explanation:
No command was specified for the object spawner to use for this server. The server will not be used by the object spawner.

Resolution:
Specify a command for the object spawner.

☐ The name (ID) server definition did not contain a port or TCP/IP service name. The default port for this server class identifier will be used.

Explanation:
The specified server does not have a port or service defined. The default port for this type of server will be used.

Resolution:
Each type of server has its own default port. If a specific port is needed for this server, then specify one in the configuration.

☐ The name TCP/IP service name specified in the name server definition resolves to a port that differs from port specified in the name server attribute definition. Therefore this server definition will not be included.

Explanation:
There is a conflict between the port that is defined for the server and the service that is defined for the server.

Resolution:
Correct the conflict by either specifying only port or service, or by ensuring that the service resolves to the same port as defined by the port attribute.

□ The name TCP/IP service name specified in the name server definition is invalid. Therefore this server definition will not be included.

Explanation:
The specified service name cannot be resolved.

Resolution:
Correct or remove the service name specification and restart your object spawner.

□ The launched server definition was not found for the server with activity. The server may have completed its processing and exited. The requested server was not found. The server may have completed its processing and exited.

Explanation:
The object spawner has attempted to access a server that has already shut down.

Resolution:
None. This error might occur during the object spawner’s server management. It is handled internally by the object spawner.

□ Objspawn was unable to perform the requested action due to an active configuration refresh.

Explanation:
A request was made to the object spawner while it was attempting to refresh its configuration. Once the refresh is complete, requests will be allowed to be performed.

Resolution:
Once the refresh has completed, resubmit the request that received this error.

□ Objspawn was unable to remove its existing configuration. The status received was status. Objspawn is terminating.

Explanation:
The object spawner was attempting to refresh itself when an error occurred. The object spawner will shut down.

Resolution:
Check the object spawner log to determine the error that caused the object spawner to shut down. It is very likely that any error that prevented the refresh from succeeding will also prevent the object spawner from restarting.

□ Objspawn has lost connectivity with the server (child ID) launched on behalf of user ID.

Explanation:
A server that the object spawner has started has shut down unexpectedly.

Resolution:
This might happen sometimes due to administrative requests that are made against the servers that the object spawner has started. If these errors persist, then contact Tech Support for assistance.

□ The launch of server name for user ID failed. The server failed to start. Failed to start the server.
Error Messages

Object Spawner Error Messages

Explanation:
The specified server failed to start. Other messages in the log might point to the cause of this failure. The typical reason for these failures is a permissions issue that is related to the server command line.

Resolution:
Depending on what operating system you are using, you might be able to find extended error information. On Windows systems, consult the Windows Event log. On z/OS systems, check the system log. On UNIX or Linux systems, messages might be written to the console, or they might exist in the `objspawn_console.log`. Correct the errors that are reported, and restart your object spawner if necessary.

- The peer for launched server child ID is no longer defined. The launched server will exit.

  Explanation:
The peer (client) that requested the server is no longer present, and might have disconnected unexpectedly. The server that was started for this client will exit.

  Resolution:
No resolution. If the message persists, there might be a problem with the client application. Contact Tech Support for assistance.

- The server definition associated with the launched server no longer exists. This may be due to an objspawn configuration refresh.

  Explanation:
The object spawner is in the process of refreshing itself when it receives a request or activity for a server that it is in the process of refreshing.

  Resolution:
Once the refresh has completed, the message should no longer be seen.

- The operator password specified by name is invalid.

  Explanation:
An invalid password was specified to the Telnet administrative interface.

  Resolution:
Use the password as defined in metadata.

- Objspawn was unable to verify the password due to an active configuration refresh.

  Explanation:
The object spawner was in the process of refreshing its configuration when a client attempted a connection to the Telnet administrative interface.

  Resolution:
Once the refresh has completed, the Telnet interface will be available again.

- Objspawn was unable to generate UUIDs due to an active configuration refresh.

  Explanation:
The object spawner was in the process of refreshing its configuration when a client attempted to request a UUID.

  Resolution:
Once the refresh has completed, UUID generation will be available again.

- Client name does not have permission to use server name (ID).

  Explanation:
The client that has connected does not have permission to use the specified server.
Resolution:
Check with your system administrator. A client must have the proper permissions on the server in order to use the server.

- **Objspawn is unable to find server named name.** Objspawn was unable to find the specified server name.

  Explanation:
  A client requested a server by name from the object spawner. The requested server is not a server that the object spawner is currently configured to use.

  Resolution:
  Make sure that the client application is connecting to the correct machine and is using the correct server. Also make sure that the object spawner configuration has the correct servers associated with it.

- **The server requested is not configured correctly. The client request cannot be completed.**

  Explanation:
  There was a problem with the server that the client requested, and it cannot be used by the object spawner. Check the object spawner log for errors or warnings that indicate the issue with the server.

  Resolution:
  Correct the server configuration and restart the object spawner. Otherwise, select a different server to use.

- **There is a problem with the Negotiate Package List. Please verify the property is set correctly.** There is a problem with the Security Package. Please verify the property is set correctly. There is a problem with the Service Principal Name. Please verify that the property is set correctly.

  Explanation:
  There is a problem with one of the Integrated Windows Authentication properties. These properties have certain values. Check the applicable documentation for information about these properties.

  Resolution:
  Correct the problems with these security properties, and restart your object spawner.

- **Credentials could not be generated for user ID because spawner is not connecting to the metadata server as a trusted user.** This may prevent the launched server from contacting the metadata server.

  Explanation:
  Servers that are launched by the object spawner attempt to connect to the metadata server in order to get further configuration information, including pre-assigned libraries and security information. In order to facilitate this, the object spawner generates credentials for the server to use to connect to the metadata server. If the object spawner is not connected to the metadata server as a trusted user, then it cannot generate credentials for other users.

  Resolution:
  Check the object spawner’s configuration file or command line. Ensure that the user that is specified there is a trusted user. Check the security documentation for more information.

- **No host credentials exist to start this server.** Either the client needs to send in host credentials, or credentials need to be specified for the server. No host credentials exist to start server name (ID). Either the client needs to send in host credentials, or credentials need to be specified for the server.
**Explanation:**
The specified server has been configured in metadata to allow SAS Token Authentication. These servers must have credentials specified for them in metadata in order for the object spawner to use to launch them.

**Resolution:**
Ensure that credentials are set for the server on the Options tab. After setting the credentials, restart your object spawner.

- **The spawner cannot accept a new client because it is currently in a paused state.**
  **The spawner cannot accept a new client because it is currently in a deferred shutdown state.**

  **Explanation:**
The object spawner is current in the specified state and cannot currently accept new clients.

  **Resolution:**
  If the object spawner is in a deferred shutdown state, the object spawner will soon shut down. At that time it will no longer accept clients, and must be restarted. A paused object spawner can be continued at any time. Once it is continued or resumed, it will accept clients again.

- **A port could not be obtained to allow the client to be connected to this server.**

  **Explanation:**
  This applies to Pooled Workspace Servers. When a client is redirected to a workspace server from a pool, the workspace server opens a port briefly for the client to use in order to connect to the server. This message indicates that at the time that a client request to the pool was made, no ports were available to have the server listen on.

  **Resolution:**
  Add more ports to the object spawner port bank.

- **Objspawn encountered a failure while processing a Telnet request. The peer connection will be closed.**

  **Explanation:**
  An error occurred during the processing of an administrative interface request. The interface will be closed.

  **Resolution:**
  Attempt to reconnect to the administrative interface. If the message continues, restart the object spawner, or contact Tech Support.

- **Objspawn encountered a failure while processing a UUID generator request. The peer connection will be closed.**

  **Explanation:**
  An error occurred during the generation of a UUID for the client.

  **Resolution:**
  Check the object spawner log for warnings or messages that can indicate the problem. Restart the object spawner if necessary. If the problem continues, contact Tech Support.

- **Line line_number in the configuration file is not in LDIF format and is being skipped.**

  **Explanation:**
  The specified line in the configuration file is not in the correct format and cannot be used.
Resolution:
Correct the specified line.

- The connection to the LDAP server failed.

  Explanation:
The specified server in the LDAP configuration could not be accessed. The object spawner cannot obtain its configuration.

  Resolution:
  Check the specified LDAP server and ensure that it is running.

- The attribute_name attribute found on line line_number failed to process.

  Explanation:
The specified attribute name is incorrect.

  Resolution:
  Correct the attribute and restart your object spawner.

- Two consecutive blank lines in an LDIF configuration file identify the logical end of the configuration. The remainder of the LDIF configuration file will be ignored.

  Explanation:
The LDIF file contains two consecutive blank lines. This signifies the end of the configuration file.

  Resolution:
  If the rest of the file is needed, then remove one of the blank lines.

- The object class definition name contains more than one distinguished name definition. The object class definition will be ignored.

  Explanation:
The specified definition contains multiple distinguished names. A definition can contain only one distinguished name.

  Resolution:
  Remove one of the distinguished names.

- The object class definition name contains conflicting object class identifier definitions. The object class definition will be ignored.

  Explanation:
The specified object class definition contains multiple or incompatible class identifier definitions.

  Resolution:
  Correct the object class identifier in the specified definition.

- The object class definition that began on line line_number defines an unknown object class and is being ignored.

  Explanation:
  An unknown class identifier was used in the specified definition and must be corrected.

  Resolution:
  Correct the specified definition to have a known class identifier.

- The object class definition that began on line line_number contained one or more attribute resolution failures and is being ignored.

  Explanation:
The specified object class definition contained one or more errors and will be ignored by the object spawner.

  Resolution:
See the object spawner log and correct the errors reported. Restart the object spawner.

- **Objspawn was unable to open the configuration file (name).**

  **Explanation:**
  The configuration file that is specified to the object spawner cannot be located or opened.

  **Resolution:**
  Specify the correct configuration file.

- **The name server definition did not specify a protocol. Therefore this server definition will not be included.**

  **Explanation:**
  The server definition is missing the protocol attribute. The protocol must be set.

  **Resolution:**
  Correct the configuration by setting the protocol attribute and restart your object spawner.

---

**Load Balancing Error Messages**

Here are error messages that might be reported by the object spawner (or the OLAP server when load balanced) and explanations to correct their cause. You will find some of these messages only in the object spawner or OLAP server logs. For more information about changing the spawner logging level, see “Configure Object Spawner Logging” on page 101. For more information about the OLAP server, see Chapter 13, “Administering SAS OLAP Servers,” on page 117. If you are unable to resolve the error, contact SAS Technical Support.

- **Objspawn was unable to launch the server server_name due to the server launch exceeding the specified wait time. The server did not start in the specified amount of time.**

  **Explanation:**
  The specified server took longer than the configured Launch Timeout setting to start completely.

  **Resolution:**
  This message might appear if the system is in heavy use and cannot start a server in an efficient manner. You might need to increase the value that is specified in the Launch Timeout to allow sufficient time for your servers to start. You might want to also investigate the amount of work that this system is currently being sent and determine whether it is overloaded.

- **Port is reserved for server name and cannot be used as a load balanced server instance listen port. Therefore this server definition will not be included.**

  **Explanation:**
  There is a port conflict between a load-balanced server and a server that is not load balanced. These different types of servers cannot use the same port.

  **Resolution:**
  Change one of the ports of the server listed so that they are different. Restart your object spawner.
Load balanced server listen port is in use. This might cause future load balanced server launches to fail.

**Explanation:**
Some other application is already using the port that is specified for the server to use. Future failures might occur because servers of this kind that are launched for load balancing might fail.

**Resolution:**
Select a different port for the server in question.

The credentials specified for the name (ID) cluster definition failed to authenticate. A failure occurred during the retrieval of the authenticated credentials for the name cluster definition.

**Explanation:**
Load balancing is unable to obtain or authenticate the specified credentials for the load-balanced logical server or cluster listed in the message. This will prevent load balancing from sharing the load among the other servers that are defined.

**Resolution:**
Verify that the correct credentials have been defined for the cluster or logical server. Credentials are set in the logical server on the Load Balancing tab of the Logical Server's property page.

The name (ID) cluster does not contain any valid server definitions. Therefore this cluster definition will not be included. No valid cluster could be found for this configuration. Check your configuration and try again. No valid server definitions found for cluster name (ID). No valid server definitions were found in cluster name (ID).

**Explanation:**
One or more errors were found when trying to process the cluster and its server definitions. The object spawner will not monitor this cluster.

**Resolution:**
View the object spawner log to find other errors or warnings that have caused the cluster and servers to fail to process. Correct these issues and restart your object spawner.

The name (ID) server definition is a load balanced server that requires credentials. No credentials were associated with the definition. Therefore this server definition will not be included.

**Explanation:**
Certain load-balancing servers require credentials in order to be launched by load balancing. The server that is specified here requires credentials, but none were found.

**Resolution:**
Specify credentials on the Options tab of the property page of the listed server definition. Restart your object spawner.

There is no available server for this client to use. The Balance algorithm timed out before a server could be found. Unable to find an available server to redirect client.

**Explanation:**
There are no available servers at this time. All servers in the cluster are busy with clients and cannot handle any new clients at this time.

**Resolution:**
The client can try again later when the servers are less busy. The system administrator might want to determine whether the settings need to be adjusted to allow more clients in. Also, more servers might need to be added to handle the client load.

☐ More servers were requested to be started than were actually defined. Overflow requests will be ignored.

Explanation:
The Start Size property for this specified server a number of servers larger than the number allowed by the configuration.

Resolution:
The Start Size property is found in the Advanced Options of the Options tab of the server definition. This message is just a warning that only the number of configured servers will be started, and not more as specified by the Start Size property.

☐ An error occurred while server (server_name) was starting. Now attempting a different server. Unable to start the server name (ID).

Explanation:
The specified server failed to start for load balancing. Load balancing will now attempt to use a different server.

Resolution:
Check the object spawner log to determine whether any messages indicate why the server failed to start. A problem with the server or its command line might need to be corrected. Also, the system might have become too busy or overloaded to handle starting a new server at this time.

☐ Attempt to connect to peer failed. Attempt to connect to peer (name) for cluster name (ID) failed with exception message.

Explanation:
Load balancing was configured to use several machines to balance the client load, but was unable to connect to one of the other peers as defined in the cluster. Load Balancing will not be able to use that peer at this time. A peer can be another object spawner.

Resolution:
This message might be seen during initialization due to the fact the other peers or object spawners have not initialized yet. Once they initialize, load balancing will be able to communicate with them. Ensure that the other peers have initialized.

☐ The Max Clients property for this server is set to 0. No clients will be redirected to this server definition.

Explanation:
The server has been configured to allow a maximum of zero clients. Therefore, no clients will be sent to this server.

Resolution:
If the intent is to not allow clients in to this server, then there is not resolution. However, if this is not the intent, the Max Clients property can be updated in the Advanced Options dialog box on the Options Tab of the server's property page.

☐ The name (ID) cluster definition requires the use of multibridge connections and none were found. Therefore this cluster definition will not be included.

Explanation:
The specified cluster contains servers that require the use of a multibridge connection. None were defined for the servers in this cluster.

Resolution:
Correct this issue by adding multibridge connections to the servers that are members of the specified cluster. Multibridge connections can be added on the Options tab of the server’s Bridge connection property page.

☐ The password obtained from the metadata indicates that it was obtained by a user that has unrestricted access. Please check your configuration.

Explanation:
The connection to the metadata server has been made by an unrestricted user. An unrestricted user cannot connect to the metadata server for load balancing, because this prevents load balancing from getting some necessary information.

Resolution:
Check your configuration file or command line. Ensure that the user is not an unrestricted user.

☐ The host name resolved to an address that matches a host name already found in this definition (name). Therefore, this host name will be skipped.

Explanation:
The specified host name has resolved to an address that the load balancer has already processed. To avoid potential confusion and conflicts, the load balancer will treat these two host names as the same machine.

Resolution:
Check and ensure that the machine names are configured correctly.

☐ The cluster name (ID) does not have a valid user name associated with it. Load balancing does not support anonymous connections. Specify credentials for your cluster and retry.

Explanation:
Load balancing has been configured to use multiple servers on multiple hosts in this particular cluster. To do so, load balancing must connect to the other hosts. However, no credentials were configured to make this connection with.

Resolution:
Specify credentials in the cluster definition. Credentials can be specified on the Load Balancing tab of the cluster’s property page.
Recommended Reading

Here is the recommended reading list for this title:

- SAS Intelligence Platform: Overview
- SAS Intelligence Platform: System Administration Guide
- SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide
- SAS Intelligence Platform: Desktop Application Administration Guide
- SAS Intelligence Platform: Security Administration Guide
- SAS Intelligence Platform: Web Application Administration Guide
- SAS Intelligence Platform: Data Administration Guide
- Grid Computing in SAS
- Scheduling in SAS
- SAS Intelligence Platform: Installation and Configuration Guide

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Publishing Sales Representative at:

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513
Telephone: 1-800-727-3228
Fax: 1-919-531-9439
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore

Customers outside the United States and Canada, please contact your local SAS office for assistance.
access control entry
a set of identities and permissions that are directly associated with a particular resource. Each access control entry is directly associated with only one resource. More than one ACE can be associated with each resource. Short form: ACE.

ACE
See access control entry.

aggregation
a summary of detail data that is stored with or referred to by a cube. Aggregations support rapid and efficient answers to business questions.

API
See application programming interface.

application programming interface
a set of software functions that facilitate communication between applications and other kinds of programs or services. Short form: API.

Application Response Measurement
the name of an application programming interface that was developed by an industry partnership and which is used to monitor the availability and performance of software applications. ARM monitors the application tasks that are important to a particular business. Short form: ARM.

ARM
See Application Response Measurement.

authentication
the process of verifying the identity of a person or process within the guidelines of a specific authorization policy.

authentication domain
a SAS internal category that pairs logins with the servers for which they are valid. For example, an Oracle server and the SAS copies of Oracle credentials might all be classified as belonging to an OracleAuth authentication domain.

client-side pooling
a configuration in which the client application maintains a collection of reusable workspace server processes. See also puddle.

cube
a logical set of data that is organized and structured in a hierarchical, multidimensional arrangement. A cube is a directory structure, not a single file. A cube includes measures, and it can have numerous dimensions and levels of data.

cube loading
the process of building a logical set of data that is organized and structured in a hierarchical, multidimensional arrangement. See also cube.

daemon
a process that starts and waits either for a request to perform work or for an occurrence of a particular event. After the daemon receives the request or detects the occurrence, it performs the appropriate action. If nothing else is in its queue, the daemon then returns to its wait state.

Data Transfer Services
a feature of SAS/CONNECT software that enables data to be transferred between a SAS/CONNECT client and a SAS/CONNECT server, regardless of the operating environment, the computer architectures, and the SAS release that is being used. Short form: DTS.

deployment plan
information about what software should be installed and configured on each machine in a SAS deployment. A deployment plan is an XML file that is used as input to the SAS Deployment Wizard. There are two types of deployment plans: standard and custom. A standard deployment plan describes a common configuration. Standard plans are stored by default in the SAS Software Depot. A custom deployment plan is created by a SAS representative specifically for a site.

dimension
a group of closely related hierarchies. Hierarchies within a dimension typically represent different groupings of information that pertains to a single concept. For example, a Time dimension might consist of two hierarchies: (1) Year, Month, Date, and (2) Year, Week, Day. See also hierarchy.

DNS name
a name that is meaningful to people and that corresponds to the numeric TCP/IP address of a computer on the Internet. For example, www.alphaliteairways.com might be the DNS name for an Alphalite Airways Web server whose TCP/IP address is 192.168.145.6.

drill-through table
a view, data set, or other data file that contains data that is used to define a cube. Drill-through tables can be used by client applications to provide a view from processed data into the underlying data source.

DTS
See Data Transfer Services.

encryption
the act or process of converting data to a form that only the intended recipient can read or use.

grid
a collection of networked computers that are coordinated to provide load balancing of multiple SAS jobs, scheduling of SAS workflows, and accelerated processing of parallel jobs.

grid control server
the machine on a grid that distributes SAS programs or jobs to the grid nodes. The grid control server can also execute programs or jobs that are sent to the grid.
**grid monitoring server**
a metadata object that stores the information necessary for the Grid Manager plug-in in SAS Management Console to connect with the Platform Suite for SAS or other grid middleware to allow monitoring and management of the grid.

**grid node**
a machine that is capable of receiving and executing work that is distributed to a grid.

**hierarchy**
an arrangement of members of a dimension into levels that are based on parent-child relationships. Members of a hierarchy are arranged from more general to more specific. For example, in a Time dimension, a hierarchy might consist of the members Year, Quarter, Month, and Day. In a Geography dimension, a hierarchy might consist of the members Country, State or Province, and City. More than one hierarchy can be defined for a dimension. Each hierarchy provides a navigational path that enables users to drill down to increasing levels of detail. See also member and level.

**Integrated Object Model**
the set of distributed object interfaces that make SAS software features available to client applications when SAS is executed as an object server. Short form: IOM.

**Integrated Object Model server**
a SAS object server that is launched in order to fulfill client requests for IOM services. Short form: IOM server.

**IOM**
See Integrated Object Model.

**IOM bridge**
a software component of SAS Integration Technologies that enables Java clients and Windows clients to access an IOM server.

**IOM server**
See Integrated Object Model server.

**level**
an element of a dimension hierarchy. Levels describe the dimension from the highest (most summarized) level to the lowest (most detailed) level. For example, possible levels for a Geography dimension are Country, Region, State or Province, and City.

**load balancing**
for IOM bridge connections, a program that runs in the object spawner and that uses an algorithm to distribute work across object server processes on the same or separate machines in a cluster.

**logical grid server**
a metadata object that stores the command that is used by a grid-enabled SAS program to start a SAS session on a grid.

**logical server**
in the SAS Metadata Server, the second-level object in the metadata for SAS servers. A logical server specifies one or more of a particular type of server component, such as one or more SAS Workspace Servers.

**MDX language**
See multidimensional expressions language.

**measure**
a special dimension that contains summarized numeric data values that are analyzed. Total Sales and Average Revenue are examples of measures. For example, you might drill down within the Clothing hierarchy of the Product dimension to see the value of the Total Sales measure for the Shirts member.
member
a name that represents a particular data element within a dimension. For example, September 1996 might be a member of the Time dimension. A member can be either unique or non-unique. For example, 1997 and 1998 represent unique members in the Year level of a Time dimension. January represents non-unique members in the Month level, because there can be more than one January in the Time dimension if the Time dimension contains data for more than one year.

metadata object
a set of attributes that describe a table, a server, a user, or another resource on a network. The specific attributes that a metadata object includes vary depending on which metadata model is being used.

MultiBridge connection
a specialized bridge connection that is used for stored process servers. Each MultiBridge connection represents a separate server process and runs on a specific port.

multidimensional expressions language
a standardized, high-level language that is used to query multidimensional data sources. The MDX language is the multidimensional equivalent of SQL (Structured Query Language). Short form: MDX language.

NWAY aggregation
the aggregation that has the minimum set of dimension levels that is required for answering any business question. The NWAY aggregation is the aggregation that has the finest granularity.

object spawner
a program that instantiates object servers that are using an IOM bridge connection. The object spawner listens for incoming client requests for IOM services. When the spawner receives a request from a new client, it launches an instance of an IOM server to fulfill the request. Depending on which incoming TCP/IP port the request was made on, the spawner either invokes the administrator interface or processes a request for a UUID (Universal Unique Identifier).

OLAP
See online analytical processing.

OLAP schema
a group of cubes. A cube is assigned to an OLAP schema when it is created, and an OLAP schema is assigned to a SAS OLAP Server when the server is defined in the metadata. A SAS OLAP Server can access only the cubes that are in its assigned OLAP schema.

online analytical processing
a software technology that enables users to dynamically analyze data that is stored in multidimensional database (MDDB) tables. Short form: OLAP.

pool
a group of server connections that can be shared and reused by multiple client applications. A client-side pool consists of one or more puddles. See also puddle, client-side pooling, and server-side pooling.

puddle
a group of servers that are started and run using the same login credentials. Each puddle can also allow a group of clients to access the servers. See also client-side pooling.

Remote Library Services
a feature of SAS/SHARE and SAS/CONNECT software that enables you to read, write, and update remote data as if it were stored on the client. RLS can be used to access SAS data sets on computers that have different architectures. RLS also provides read-only access to some types of SAS catalog entries on computers that have different architectures. Short form: RLS.

RLS
See Remote Library Services.

SAS Application Server
in the SAS Intelligence Platform, a logical entity that represents the SAS server tier. This logical entity contains specific servers (for example, a SAS Workspace Server and a SAS Stored Process Server) that execute SAS code. A SAS Application Server has relationships with other metadata objects. For example, a SAS library can be assigned to a SAS Application Server. When a client application needs to access that library, the client submits code to the SAS Application Server to which the library is assigned.

SAS ARM interface
an interface that can be used to monitor the performance of SAS applications. In the SAS ARM interface, the ARM API is implemented as an ARM agent. In addition, SAS supplies ARM macros, which generate calls to the ARM API function calls, and ARM system options, which enable you to manage the ARM environment and to log internal SAS processing transactions. See also ARM (Application Response Measurement).

SAS batch server
in general, a SAS application server that is running in batch mode. In the SAS Open Metadata Architecture, the metadata for a SAS batch server specifies the network address of a SAS Workspace Server, as well as a SAS start command that will run jobs in batch mode on the SAS Workspace Server.

SAS Deployment Wizard
a cross-platform utility that installs and initially configures many SAS products. Using a SAS installation data file and, when appropriate, a deployment plan for its initial input, the wizard is designed to prompt the customer for all the remaining input at the start of the session so that the customer does not have to monitor an entire deployment.

SAS Foundation Services
a set of core infrastructure services that programmers can use in developing distributed applications that are integrated with the SAS platform. These services provide basic underlying functions that are common to many applications. These functions include making client connections to SAS application servers, dynamic service discovery, user authentication, profile management, session context management, metadata and content repository access, activity logging, event management, information publishing, and stored process execution. See also service.

SAS Management Console
a Java application that provides a single user interface for performing SAS administrative tasks.

SAS Metadata Repository
a repository that is used by the SAS Metadata Server to store and retrieve metadata. See also SAS Metadata Server.

SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to one or more SAS Metadata Repositories. The SAS Metadata Server uses the
Integrated Object Model (IOM), which is provided with SAS Integration Technologies, to communicate with clients and with other servers.

**SAS OLAP Cube Studio**
- a Java interface for defining and building OLAP cubes in SAS System 9 or later. Its main feature is the Cube Designer wizard, which guides you through the process of registering and creating cubes.

**SAS OLAP Server**
- a SAS server that provides access to multidimensional data. The data is queried using the multidimensional expressions (MDX) language.

**SAS Open Metadata Architecture**
- a general-purpose metadata management facility that provides metadata services to SAS applications. The SAS Open Metadata Architecture enables applications to exchange metadata, which makes it easier for these applications to work together.

**SAS Pooled Workspace Server**
- a SAS Workspace Server that is configured to use server-side pooling. In this configuration, the SAS object spawner maintains a collection of workspace server processes that are available for clients.

**SAS Stored Process Server**
- a SAS IOM server that is launched in order to fulfill client requests for SAS Stored Processes. See also IOM server.

**SAS token authentication**
- a process in which the metadata server generates and verifies SAS identity tokens to provide single sign-on to other SAS servers. Each token is a single-use, proprietary software representation of an identity.

**SAS Workspace Server**
- a SAS IOM server that is launched in order to fulfill client requests for IOM workspaces. See also IOM server and workspace.

**SAS/CONNECT server**
- a server that provides SAS/CONNECT services to a client. When SAS Data Integration Studio generates code for a job, it uses SAS/CONNECT software to submit code to remote computers. SAS Data Integration Studio can also use SAS/CONNECT software for interactive access to remote libraries.

**SAS/CONNECT spawner**
- a program that runs on a remote computer and that listens for SAS/CONNECT client requests for connection to the remote computer. When the spawner program receives a request, it invokes a SAS session on the remote computer.

**Scalable Performance Data Engine**
- a SAS engine that is able to deliver data to applications rapidly because it organizes the data into a streamlined file format. The SPD Engine divides a problem (such as a WHERE clause) into smaller problems that can be processed in parallel. Short form: SPD Engine.

**schema**
- a map or model of the overall data structure of a database. An OLAP schema specifies which group of cubes an OLAP server can access.

**server component**
- in SAS Management Console, a metadata object that specifies information about how to connect to a particular kind of SAS server on a particular computer.

**server context**
a SAS IOM server concept that describes how SAS Application Servers manage client requests. A SAS Application Server has an awareness (or context) of how it is being used and makes decisions based on that awareness. For example, when a SAS Data Integration Studio client submits code to its SAS Application Server, the server determines what type of code is submitted and directs it to the correct physical server for processing (in this case, a SAS Workspace Server).

**server-side pooling**
a configuration in which a SAS object spawner maintains a collection of reusable workspace server processes that are available for clients. The usage of servers in this pool is governed by the authorization rules that are set on the servers in the SAS metadata.

**service**
one or more application components that an authorized user or application can call at any time to provide results that conform to a published specification. For example, network services transmit data or provide conversion of data in a network, database services provide for the storage and retrieval of data in a database, and Web services interact with each other on the World Wide Web. See also SAS Foundation Services.

**single sign-on**
an authentication model that enables users to access a variety of computing resources without being repeatedly prompted for their user IDs and passwords. For example, single sign-on can enable a user to access SAS servers that run on different platforms without interactively providing the user's ID and password for each platform. Single sign-on can also enable someone who is using one application to launch other applications based on the authentication that was performed when the user initially logged on.

**SPD Engine**
See Scalable Performance Data Engine.

**SSO**
See single sign-on.

**star schema**
tables in a database in which a single fact table is connected to multiple dimension tables. This is visually represented in a star pattern. SAS OLAP cubes can be created from a star schema.

**thread**
a single path of execution of a process in a single CPU, or a basic unit of program execution in a thread-enabled operating system. In an SMP environment, which uses multiple CPUs, multiple threads can be spawned and processed simultaneously. Regardless of whether there is one CPU or many, each thread is an independent flow of control that is scheduled by the operating system.

**threaded I/O**
I/O that is performed by multiple threads in order to increase its speed. In order for threaded I/O to improve performance significantly, the application that is performing the I/O must be capable of processing the data rapidly as well. See also thread.

**threading**
a high-performance method of data I/O or data processing in which the I/O or processing is divided into multiple threads that are executed in parallel. In the boss-worker model of threading, the same code for the I/O or calculation process is executed simultaneously in separate threads on multiple CPUs. In the pipeline model, a process is divided into steps, which are then executed simultaneously in separate threads on multiple CPUs.
**wizard**

an interactive utility program that consists of a series of dialog boxes, windows, or pages. Users supply information in each dialog box, window, or page, and the wizard uses that information to perform a task.

**workspace**

in the IOM object hierarchy for a SAS Workspace Server, an object that represents a single session in SAS. See also Integrated Object Model.
Index

A
abnormal OLAP server shutdowns 98
accessibility features 4
application server 3
See also SAS Application Server
server components 5, 6
ARM log files 59
authentication
IOM server 141
security authentication packages 142

B
.bat file 43
batch servers 3, 7, 23
SAS DATA Step Batch Server 23, 24
SAS Generic Batch Server 23
SAS Java Batch Server 23, 25
build files
for OLAP cubes, on SAS Workspace Servers 78

C
catalogs
for servers on multiple machines 57
cleaning up temporary files
after abnormal OLAP server shutdowns 98
client assignment (load balancing)
to OLAP servers 34
to workspace and stored process servers 74
client-side pooling 55
application properties 64
assigning libraries to server 73
choosing 59
concepts 64
configuration overview 60
configuring
61
configuring across multiple machines 67
configuring server properties 75
configuring workspace server for row-level security
connection process 55
converting logical workspace server to
creating restricted workspace server 71
creating Web Report Studio deployment 74
how it works 55
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

D
data access
for servers on multiple machines 57
in database management systems 88
data resources
securing sensitive data resources 74
data transfer services 66
database management systems
data access in 88

e-mail settings
for SAS Application Servers 89
encoding 23
error messages
for load balancing 157
for object spawner 149

F
flattened rows 127
formats
updating references for user-defined formats 88

G
Grid algorithm 55, 50
grid computing
SAS/CONNECT and 18
Grid Monitoring Server 28
grid server 27
group definitions 70
group objects 70

H
Index

I
IOM server 141
security authentication packages 142

J
Java Batch Server 23, 25

K
keyboard shortcuts 8

L
local administrator 50

M
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

O
OLAP server 3
See also SAS Application Server
server components 5, 6

P
parameters 138

Q
queue monitoring 12

R
Restricted Client-side Pool Administrator 70
Restricted Pool Puddle Login group 71
sensitive data resources
verifying, for SAS Web Report Studio 74
coalescing cubes 123
compute services 18
Cost algorithm 45, 46
parameters 138
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

S
.sas file 39
SAS Application Server 3
SAS batch servers 3, 7, 23
SAS DATA Step Batch Server 23, 24
SAS Generic Batch Server 23
SAS Java Batch Server 23, 25
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

catalogs
for servers on multiple machines 57
cleaning up temporary files
after abnormal OLAP server shutdowns 98
client assignment (load balancing)
to OLAP servers 34
to workspace and stored process servers 74
client-side pooling 55
application properties 64
assigning libraries to server 73
choosing 59
concepts 64
configuration overview 60
configuring
61
configuring across multiple machines 67
configuring server properties 75
configuring workspace server for row-level security
connection process 55
converting logical workspace server to
creating restricted workspace server 71
creating Web Report Studio deployment 74
how it works 55
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

D
data access
for servers on multiple machines 57
in database management systems 88
data resources
securing sensitive data resources 74
data transfer services 66
database management systems
data access in 88

e-mail settings
for SAS Application Servers 89
encoding 23
error messages
for load balancing 157
for object spawner 149

F
flattened rows 127
formats
updating references for user-defined formats 88

G
Grid algorithm 55, 50
grid computing
SAS/CONNECT and 18
Grid Monitoring Server 28
grid server 27
group definitions 70
group objects 70

H
keyboard shortcuts 8

L
local administrator 50

M
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

O
OLAP server 3
See also SAS Application Server
server components 5, 6

P
parameters 138

Q
queue monitoring 12

R
Restricted Client-side Pool Administrator 70
Restricted Pool Puddle Login group 71
sensitive data resources
verifying, for SAS Web Report Studio 74
coalescing cubes 123
compute services 18
Cost algorithm 45, 46
parameters 138
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

S
.sas file 39
SAS Application Server 3
SAS batch servers 3, 7, 23
SAS DATA Step Batch Server 23, 24
SAS Generic Batch Server 23
SAS Java Batch Server 23, 25
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

C
catalogs
for servers on multiple machines 57
cleaning up temporary files
after abnormal OLAP server shutdowns 98
client assignment (load balancing)
to OLAP servers 34
to workspace and stored process servers 74
client-side pooling 55
application properties 64
assigning libraries to server 73
choosing 59
concepts 64
configuration overview 60
configuring
61
configuring across multiple machines 67
configuring server properties 75
configuring workspace server for row-level security
connection process 55
converting logical workspace server to
creating restricted workspace server 71
creating Web Report Studio deployment 74
how it works 55
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

D
data access
for servers on multiple machines 57
in database management systems 88
data resources
securing sensitive data resources 74
data transfer services 66
database management systems
data access in 88

e-mail settings
for SAS Application Servers 89
encoding 23
error messages
for load balancing 157
for object spawner 149

F
flattened rows 127
formats
updating references for user-defined formats 88

G
Grid algorithm 55, 50
grid computing
SAS/CONNECT and 18
Grid Monitoring Server 28
grid server 27
group definitions 70
group objects 70

H
keyboard shortcuts 8

L
local administrator 50

M
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

O
OLAP server 3
See also SAS Application Server
server components 5, 6

P
parameters 138

Q
queue monitoring 12

R
Restricted Client-side Pool Administrator 70
Restricted Pool Puddle Login group 71
sensitive data resources
verifying, for SAS Web Report Studio 74
coalescing cubes 123
compute services 18
Cost algorithm 45, 46
parameters 138
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

S
.sas file 39
SAS Application Server 3
SAS batch servers 3, 7, 23
SAS DATA Step Batch Server 23, 24
SAS Generic Batch Server 23
SAS Java Batch Server 23, 25
SAS Stored Process Server example 48
SAS Workspace Server example 47
cube cache
tuning 126
cube viewers 118

T
transaction processing 17

U
unpacked reports 125

V
virtual memory 35

W
WebReport Studio deployment
creating 74
how it works 55
metadata identities 61
metadata identities and logins for puddle access
puddles for logical pooled server 61

Y
Youngs algorithm 45, 46

H
hosts
for load-balancing clusters 39

I
Integrated Object Model (IOM) server 132
security package for authentication 140
Security Support Provider Interface for SSO connections 144
startup parameters 134
Integrated Object Model (IOM) workspace interface 6

L
launch command
adding system options to (workspace server) 97
Least Recently Used algorithm 40
libraries
assigning, for client-side pooling 78
updating, for servers on multiple machines 88
load balancing 12, 34
See also load-balancing algorithms
See also load-balancing clusters
adding or deleting servers 45
client assignment to OLAP servers 35
client assignment to workspace and stored process servers 44
edits for UNIX and z/OS 44
error messages 157
initial setup for stored process servers 53
installing and configuring server software 42
installing server and spawner software 42
log files 42
MultiBridge connections 37
planning, installation, and configuration 36
security for 36
starting or refreshing object spawners or OLAP servers 44
stopping and restarting servers 44
load-balancing algorithms 88 45
choosing 40
Cost 45
Grid 45
Least Recently Used 45
Most Recently Used 45
Response Time 45
load-balancing clusters algorithm for 44
converting logical server to load balancing 41
converting server instance to load balancing 41
editing metadata 41
hosts and port numbers 49
logical server login credentials 40
metadata for 41
metadata for new servers in cluster of OLAP servers 42
planning 20
reading metadata at initialization 54
workspace servers in SAS Management Console 56
locale 23
configuring workspace servers for 96
log files for load balancing 59
logconfig.xml 43
logging
configuring for object spawner 101
SAS OLAP Servers 125
logging level
SAS/CONNECT spawner 21
logical grid server 27
configuration files 29
metadata object 29
logical pooled servers
puddles for client-side 6
logical servers 3
adding servers to 83
adding to SAS Application Server 83
converting logical workspace server to client-side pooling 52
converting to load balancing, login credentials 40
modifying server definitions 84
puddles for client-side logical pooled server 51
removing 84
logical workspace servers
converting to client-side pooling 62
login credentials for logical servers 50

M
metadata
editing for load-balancing clusters 41
for load-balancing clusters 42
for new servers in load-balancing clusters 42
reading load-balancing cluster metadata at initialization 42
refreshing cube metadata for calculated members and name sets 128
metadata configuration file 13
metadata connection 13
metadata connection and security options
object spawner 112
metadata identities for puddle access 51
metadata logins for puddle access 51
metadata objects for SAS/CONNECT 20
hierarchy for defining SAS Application Server 8
logical grid server 59
metadata replication SAS/CONNECT and 19
migration
OLAP cubes, from SAS 9.1.3 to 9.2 119
Most Recently Used 45 50
MultiBridge connections 8

O
object spawners
adding connections to administering with Telnet 100
changing ports 100
configuration tasks 100
configuring and starting on z/OS 105
configuring logging 101
configuring to accept single sign-on connections 102
defining 100
derror messages 147
Index

general invocation options 110
invocation options 109
metadata connection and security options 112
modifying definitions 100
refreshing 103
service options 113
starting or refreshing for load-balancing servers 44
updating a Windows service for 104
OBJECTSERVER system option 132
OBJECTSERVERPARMS system option 134
OLAP cubes
authorizing access to cubes and cube data 124
building 121
changing permissions 124
coalescing 125
configuring storage for build files on SAS Workspace Servers 78
cube viewers 121
deleting 123
disabling and enabling 121
migrating from SAS 9.1.3 to 9.2 119
refreshing metadata for calculated members and name sets 128
tuning the cube cache 126
updating 123
updating in place 125
updating incrementally 122
OLAP schemas 118
OLAP servers 5
cleaning up, after abnormal shutdowns 78
client assignment to, for load balancing 55
starting or refreshing for load-balancing servers 44
OLAPOPERATE procedure 118
OLAPServerSSCU.ini 44

P

performance tuning workspace servers 55
permissions
for OLAP cubes 124
permissions configuration row-level 59
pool administrator 59
pooled workspace servers 5
pooling 55
See also server-side pooling
client-side 53
port bank 54
port numbers for load-balancing clusters 59
ports changing object spawner-managed server ports 101
puddle login 55
puddles 53
defining 75
for client-side logical pooled server 61
metadata identities and logins for access 61

Q

queries managing OLAP queries 125
query thread pool tuning 123

R

remote data access with SAS Data Integration Studio 78
remote library services 17
Replication Wizard 19
Response Time algorithm 45
Restricted Client-side Pool Administrator 71
restricted client-side pooling workspace server 71
Restricted Pool Puddle Login group 71
row-level security
for client-side pooling workspace server 64
permissions configuration 69
rows, flattened 122

S

SAS Application Server
accessing remote data with SAS Data Integration Studio 78
adding 70
adding logical server to 81
adding or modifying e-mail settings 89
as collection of server components 5
defining multiple 77
hierarchy of metadata objects for defining 8
modifying server definitions 84
multiple, with SAS Web Report Studio 79
removing logical servers 44
SASMeta application server and server components 8
server context 2
structure of system options for 131
SAS/CONNECT
accessing remote data compute services configuration files 21
data transfer services 16
grid computing and 18
metadata replication and 19
overview of services 16
remote library services 79
SAS Data Integration Studio and SAS Enterprise Miner 17
SAS/CONNECT server 4
accessing remote data configuration files 2
initial configuration 9
metadata objects 20
SAS/CONNECT spawner
changing logging level 21
SAS Deployment Wizard 74
SAS Enterprise Miner
SAS/CONNECT and 17
SAS Grid Manager 18
SAS Grid Server 1
initial configuration 28
role of 28
SAS Java Batch Server 23
SAS Online Analytical Processing (OLAP) 103
SAS/SHARE 4
SAS/SHARE spawner 25
SAS Spark Server 23
SAS Web Report Studio 79
SAS/WEBConnect 23
SAS/WEBConnect server 23
SAS/WEBConnect sql 23
SAS Management Console
- clustered workspace servers in OLAP implementation 118
- SAS Metadata Server 118
- SAS Object Spawners 13
  - balancing the server workload 4
  - configuration file for metadata connection 13
  - initiating the interface 14
  - tasks 13
- SAS OLAP Cube Studio 118
  - changing permissions and disabling cubes 124
- SAS OLAP Server Monitor 118
- SAS OLAP Servers 7
  - adding 119
  - adding a load-balancing cluster of administrative overview 117
  - authorizing access to 124
  - authorizing access to cubes and cube data building cubes 124
  - coalescing cubes 123
  - connecting to deleting cubes 123
  - disabling and enabling cubes flattened row values 24
  - implementation components 117
  - installing and configuring 119
  - logging 125
  - managing sessions and queries 125
  - migrating OLAP cubes from SAS 9.1.3 to 9.2 119
  - refreshed OLAP schemas 129
  - refreshing cube metadata for calculated members and name sets 128
  - starting 120
  - stopping, pausing, and resuming 120
  - tuning cube cache 126
  - tuning query thread pool 127
  - tuning subquery caches 126
  - tuning with advanced server options 125
  - updating cubes 122
- SAS options
  - changing with stored process server 94
- SAS Pooled Workspace Server 6, 12
- SAS Stored Process Server 3, 11
  - changing SAS options with 94
  - client assignment to, for load balancing 34
  - default 12
  - encoding and locale information 93
  - initial setup for load balancing 37
  - moving 90
  - on multiple machines 87
  - pooling 53
  - stored processes 11
  - subquery caches 11
  - tuning 126
- SAS Web Report Studio
  - creating deployment for client-side pooling 74
  - multiple SAS Application Servers with 79
  - verifying client-side connection pooling 84
- SAS Workspace Server 3, 13
  - cleaning up, after abnormal OLAP server shutdowns 98
  - configuring storage for OLAP cube build files on 98
  - Cost algorithm example 17
  - in OLAP implementation 118
- SASApp - Logical Workspace Server object 8
- SASApp object 5
- SASMain object 5
- SASMeta application server 8
- sasv9_usermods.cfg 43
- scheduling 23
- SECPACKAGE system option 140
- SECPACKAGELIST system option 142
- security for load balancing 58
- row-level, for client-side pooling workspace server 69
- security package for IOM server authentication 74
- security authentication packages 142
- Security Support Provider Interface (SSPI) server components 5
  - server context 5
  - server instance converting to load balancing 11
  - Server Manager 3, 118
  - server pooling
    - See pooling
    - server ports changing object spawner-managed 101
  - server-side pooling 53
  - connection process 54
  - how it works 53
  - service options object spawner sessions managing OLAP sessions 125
  - shortcuts.ini 44
  - single sign-on connections configuring the object spawner for spawner software for load-balancing servers 42
  - SSO connections to IOM servers
    - Security Support Provider Interface for SSPI system option 144
- Stored Process Server 3, 11
  - changing SAS options with client assignment to, for load balancing default 13
  - encoding and locale information 93
  - initial setup for load balancing 37
  - moving 90
  - on multiple machines 57
  - pooling 53
  - stored processes 11
  - subquery caches 11
  - tuning 126
  - system options adding to workspace server launch command for SAS Application Server components 97
- T
  - Telnet
    - administering object spawner temporary files cleaning up, after abnormal OLAP server shutdowns 88
    - tuning cube cache 126
    - query thread pool 127
    - SAS OLAP Servers 125
    - subquery caches 126
    - workspace servers 95
- U
  - UNIX
    - load-balancing servers 44
    - user accounts 70
    - user-defined formats updating references, for servers on multiple machines 88
user definitions 70
user objects 70

W
Windows services
  updating for object spawner 104
workspace servers 3 11
  adding system options to launch command 97
  client assignment to, for load balancing 34
  clustered in SAS Management Console 36
  configuration options for pool 63
  configuration tasks 95
  configuring for a locale 90
  configuring for row-level security 69

converting logical server to client-side pooling 52
creating restricted client-side pool 71
default 12
encoding and locale information 93
moving 90
on multiple machines 57
pooling 53
tuning 95

Z
z/OS
  configuring and starting object spawner 105
  load-balancing servers 44
We welcome your feedback.

- If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).
- If you have comments about the software, please send them to suggest@sas.com.
SAS® Publishing Delivers!

Whether you are new to the work force or an experienced professional, you need to distinguish yourself in this rapidly changing and competitive job market. SAS® Publishing provides you with a wide range of resources to help you set yourself apart. Visit us online at support.sas.com/bookstore.

SAS® Press
Need to learn the basics? Struggling with a programming problem? You’ll find the expert answers that you need in example-rich books from SAS Press. Written by experienced SAS professionals from around the world, SAS Press books deliver real-world insights on a broad range of topics for all skill levels.

SAS® Documentation
To successfully implement applications using SAS software, companies in every industry and on every continent all turn to the one source for accurate, timely, and reliable information: SAS documentation. We currently produce the following types of reference documentation to improve your work experience:

- Online help that is built into the software.
- Tutorials that are integrated into the product.
- Reference documentation delivered in HTML and PDF – free on the Web.
- Hard-copy books.

SAS® Publishing News
Subscribe to SAS Publishing News to receive up-to-date information about all new SAS titles, author podcasts, and new Web site features via e-mail. Complete instructions on how to subscribe, as well as access to past issues, are available at our Web site.